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1

Introduction
1.1. Structure of this document
This document is divided into the following parts:
1. Step by step guides to get you started:

Chapter 2, Quick installation guide on page 11. This guide quickly describes how to install BowTieXP on
your computer.

Chapter 3, Quick getting started guide on page 15. This guide briefly discusses bowtie methodology and
then gives a step-by-step guide on how to create a bowtie diagram using the software. Some important
software concepts are explained.
2. Chapter 4, A deeper look at the bowtie method starting on page 37 gives a theoretical background and tutorial in
bow-tie methodology. The tutorial contains lots of examples on what to do and what not to do.
Note: Actually, due to the length of this chapter, we’ve made it into a separate document. Chapter 4
provides an overview of the contents. Contact us at support@cgerisk.com to see if you are eligible for a
copy.
3. In chapter 5, The different BowTieXP versions on page 39, we give an overview of what features are present in
each version of BowTieXP so you can see the differences between the versions at a glance.
4. A full task-based manual describing every detail about the software. All details and features are described in
chapters which orient about a specific task:

Chapter 6, Introducing BowTieXP on page 47.

Chapter 7, Case file editing on page 57.

Chapter 8, Configuring the diagram on page 78.

Chapter 9, Case file analysis on page 89.

Chapter 10, Linking to documentation on page 101.

Chapter 11, Bowtie chaining on page 103.

Chapter 12, Getting data into BowTieXP on page 107.

Chapter 13, Getting data out of BowTieXP on page 113.

Chapter 14, Working with templates on page 123.

Chapter 17, Advanced functionality: diagram display profiles on page 131.

Chapter 18, Advanced functionality: the scrap book on page 134.

Chapter 19,
Advanced functionality: comparing files on page 145.

Chapter 20, Advanced functionality: type and property descriptions on page 151.

Chapter 21,
Advanced functionality: Soob matrices on page 153.

Chapter 24, AuditXP on page 179.

Chapter 25, Compliance frameworks on page 199.

Chapter 26, SharePoint add-on on page 203.

Chapter 27, Introducing BowTieXL on page 217.

Chapter 28, Calculating with BowTieXL on page 224.

Chapter 29, IncidentXP and BowTieXP together on page 233.
5. Technical installation reference and frequently asked questions:
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Chapter 30, Installation reference on page 240. This reference describes all available options for installing
and activating BowTieXP in all possible settings, as well as all prerequisites and operating system
dependencies.
Chapter 32, Frequently asked questions on page 254. Various frequently asked questions and their
answers are collected here. Most have to do with the technical details such as installation and activation.
Chapter 33, Support on page 263.

Note: If you are a first time user and want to get going quickly, we recommend reading the first part
containing the quick guides.
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2

Quick installation guide
In this chapter we will walk you through the steps to
install BowTieXP.

2.1. Introduction
Installing BowTieXP onto your computer is in most circumstances very simple. If however, you run into trouble and
want to have more detailed information about the installation procedure, about the software prerequisites and
compatibility, this is available in chapter 30, the Installation reference, on page 240.

2.2. Installing BowTieXP
NOTE for people on Windows Vista:
BowTieXP needs the .NET Framework 3.5 SP1 to be installed. Windows 7 and later come with the .NET
Framework version 3.5 SP1 already installed out of the box, or will detect the need and install
automatically. On Windows Vista, you need to do this manually, if it is not yet installed. Please download
and run the installer:
http://www.microsoft.com/en-us/download/details.aspx?id=22
Open an internet browser and navigate to:
http://www.cgerisk.com/downloads/bowtiexp/
Download and run the BowTieXP installer (.msi).

2.3. Activating BowTieXP
When you start BowTieXP for the first time, you are asked for either a trial code or an activation code:

Figure 1 - Activation dialog
If you have a valid trial code, you can enter that in the activation or trial code text box, and BowTieXP will run.
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If you have purchased BowTieXP, you will need to obtain an activation code to perpetually activate BowTieXP.
Please copy the code shown in the current host ID text box and paste it into an email to CGE at
support@cgerisk.com. We will then send you an activation code. After entering this code in the activation or trial
code text box, BowTieXP will run forever.

2.3.1. Activating with an old host-id
Sometimes, due to the use of a laptop docking station, a switch in Windows version or changes in the computer
hardware, it can happen that the host ID changes. If that happens, your activation code will no longer match with
the host ID. If this happens, you will have to activate the software based on the original host-ID (the original host-ID
that was used for creation of the activation code, the one you sent to CGE).
To do so, select the “Lock to this computer with an old host id” option from the “Lock to” dropdown menu in the
Product Activation screen (see Figure 2). The screen will then display the current, as well as the activated host-id
(the one you sent to us initially) (see Figure 3).

Figure 2 - Activate with original host id

Figure 3 – Host id and activation code do not match anymore
We do not need to send you a new code. You just need to tell it the host id which belongs to the activation code.
You can do this by copy/pasting the old host id which was used to generate the activation code into the ‘activated
host id’ field. The host id that was used to generate the activation code is always included in the same email as the
activation code, usually in a bit of text that looks like Figure 4:

Figure 4 - Activation code email message
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The host-id that was used to generate the activation code is the one pointed out by the arrow in Figure 4. When this
host-id is copied into the ‘Activated host id’ field, the software will pick it up and the match it to the activation code.
This should result in an accepted code, returning the status ‘OK’. Now click the OK button, and the software should
be activated once more.
Please note that BowTieXP will check what has changed on your computer. If too many parts have changed, or you
are trying this on a different computer, the code will still not work and you will need to contact us for an updated
code.

Figure 5 – Changed host-id
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3

Quick getting started guide

In this section we will lead you through the steps
needed for creating a simple bowtie diagram.

3.1. A brief description of bowtie methodology
Note: Look in the methodology manual for a more thorough elaboration.
The bowtie methodology is used for risk assessment, risk management and (very important) risk communication.
The method is designed to give a better overview of the situation in which certain risks are present; to help people
understand the relationship between the risks and organizational events.
The strength of the methodology lies in its simplicity; the phrase “less is more” is certainly applicable.
Risk management is all about risk-perception management, since most accidents happen because of actions or
inactions of people. People working in hazardous environments should be aware of the present organizational risks
and should have an accurate understanding of their role in it. This can only be accomplished by sufficient risk
communication adjusted to the abilities of that part of the workforce you want to address, leading to the
establishment of operational ownership.
Many risk assessments are done using quantitative instruments. These may be sufficient for certain types of
equipment but are less valuable for organizational risk assessment. Human beings are less easy to predict than
machinery and the operational combination of all factors present (think of people, equipment, time, weather,
organizational factors, etc.) leads to even more difficulties. Making accurate predictions of the future in an
environment that is as complex as the world itself, is simply impossible. In many organizations the stakes of certain
consequences (resulting from an accident) are too high to leave unmanaged. Therefore, it is wise to be prepared for
‘everything’; think of all possible scenarios and assess how your organization is prepared to deal with them. This is
exactly what the bowtie method and BowTieXP will help you accomplish.
Risk in bowtie methodology is elaborated by the relationship between hazards, top events, threats and
consequences. Barriers are used to display what measures an organization has in place to control the risk.

3.1.1. Hazard
The word “hazard” suggests that it is unwanted, but in fact it is the opposite: it is exactly the thing you want or even
need to make business. It is an activity or state of something with the potential to cause harm but without it there is
no business. For example the oil industry; oil is a dangerous substance (and can cause a lot of harm when treated
without care) but it is the one the thing that keeps the oil industry in business! It needs to be managed because as
long as it is under control, it is of no harm.

3.1.2. Top event
Thus as long as a hazard is controlled it is in its wanted state. For example: oil in a pipe on its way to shore. But
certain events can cause a deviation of or loss of control over the hazard. In bowtie methodology such an event is
called the top event. The top event is not a catastrophe yet, but the dangerous characteristics of the hazard are now
in the open. For example: oil is outside of the pipeline (loss of containment). Not a major disaster, but if not
mitigated correctly it can result in more unwanted events (consequences).
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3.1.3. Threats
Often there are several factors that could cause the top event. In bowtie methodology these are called threats.
These threats need to be sufficient or necessary: every threat itself should have the ability to cause the top event.
For example: corrosion of the pipeline can lead to the loss of containment.

3.1.4. Consequences
When a top event has occurred it can lead to certain consequences. A consequence is a potential event resulting
from the release of the hazard which results directly in loss or damage. Consequences in bowtie methodology are
unwanted events that an organization ‘by all means’ wants to avoid. For example: oil leaking into the environment.

3.1.5. Barriers (also known as controls)
Risk management is about controlling risks. This is done by placing barriers to prevent certain events form
happening. A barrier (or control) can be any measure taken that acts against some undesirable force or intention, in
order to maintain a desired state.
In bowtie methodology there are proactive barriers (on the left side of the top event) that prevent the top event
from happening. For example: regularly corrosion-inspections of the pipelines. There are also reactive barriers (on
the right side of the top event) that prevent the top event resulting into unwanted consequences. For example: leak
detection equipment or concrete floor around oil tank platform.
Note the terms barrier and control are the same construct and depending on industry and company, one or the
other is used. In this manual we will use the term barrier.

3.1.6. Escalation factors/defeating factors/barrier decay mechanisms
In an ideal situation a barrier will stop a threat from causing the top event. However, many barriers are not a 100%
effective. There are certain conditions that can make a barrier fail. In bowtie methodology these are called
escalation factors. An escalation factor is a condition that leads to increased risk by defeating or reducing the
effectiveness of a barrier. For example: earthquake leading to cracks in the concrete floor around a pipeline.
Escalation factors are also known as defeating factors or barrier decay mechanisms – which term is used is
dependent on industry and company. In this document we will use the term escalation factor.

3.1.7. ALARP
If you want to be completely sure that there is no risk present you have to get rid of the hazard. But since the
hazard is part of normal business this is simply not possible. We accept there is a risk and we try to do everything
possible to keep the risk “As Low As Reasonably Practicable” (ALARP). For a risk to be ALARP it should be
demonstrable that the cost involved in reducing the risk further would be grossly disproportionate to the benefit
gained.
What ALARP means is different for every organization; it depends on what risks an organization does or does not
want to take and what an organization wants to spend (in time & money) on barriers/control measures.

3.1.8. Terminology recap
The following terms should now be familiar to you:

The hazard, part of normal business but with the potential to cause harm, can be released by:

A top event, no catastrophe yet but the first event in a chain of unwanted events.

The top event can be caused by threats (sufficient or necessary causes).

The top event has the potential to lead to unwanted consequences.

(Proactive) barriers are measures taken to prevent threats from resulting into the top event.

(Reactive) barriers are measures taken to prevent that the top event leads to unwanted consequences.

An escalation factor is a condition that defeats or reduces the effectiveness of a barrier.
We will be covering the following steps in the next sections:

A quick overview of the software layout,
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Adding/defining a bowtie location,
adding a hazard and top event,
adding threats,
adding consequences,
adding barriers,
And adding escalation factors.

3.2. The BowTieXP screen
When starting BowTieXP for the first time, you will be asked a couple of questions and given some information:

if you agree to the EULA,

The version history / release notes are shown,

If BowTieXP can check for updates and some other preferences,

What language you want to use.
After agreeing to the EULA, you can leave everything at their defaults.
This screen in only shown the first time. Once it is finished, BowTieXP will start normally.
After starting BowTieXP, the following screen will appear:

Figure 6 - Main application screen
This screen consists of several parts that you will need to familiarize yourself with before you will be able to start
building your case. They are explained below. Please note the titles in the various windows in the screenshot –
throughout the documentation we will refer to these windows by those names.
The windows we will need in this chapter are highlighted and discussed below.
NOTE: Your screen layout might be slightly different if you are running a different edition of BowTieXP –
some extra features will be available if you have purchased the advanced version and/or the IncidentXP
and/or the AuditXP add-on. All features which are not in the standard version of BowTieXP will be marked
in the text.
Screenshot with highlight

Description
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Treeview – The treeview window helps you easily navigate
through your bowtie case file. In this window you have access to
your case file, including the lookup tables associated with your
file, the activities, documents, and bowtie locations. It is also a
quick and easy way to jump to different portions of your diagram
by clicking on them in the treeview – the diagram will follow.
Note you can click on the ‘+’ or the ‘-’ icons to expand or hide the
details associated with each item.

Diagram – The diagram window is where the visual portion of
your diagram will take shape.
There are distinct shapes associated with each portion of the
bowtie diagram which represent different aspects of your case.
Think of the diagram window as your drawing board.

Editor – In the editor window you can submit and edit all written
content within your diagram. By double clicking on items on the
treeview or diagram, the editor window will appear which allows
you to edit the various fields of an item.
Note: you can also call up the editor by clicking once on an item to
select it, and then press F2.

If you would like to know more about the treeview, diagram, and editor windows or any of the other windows not
covered in this chapter; please refer to the rest of the manual - starting at chapter 6, Introducing BowTieXP on page
47, and continuing in the next chapters, every component is described in detail.
Some tips if you get lost:
1.

Pressing F2 will bring up the editor window for the selected item.

2.

Pressing Shift + F12 restores all windows to their default location – the layout as seen in the
screenshots is restored. You can also press the star icon on the toolbar.

3.

If you can’t find your diagram, you either have not selected a hazard/top event, or you have selected
a different tab such as the case overview tab in the diagram window instead of the diagram tab.

4.

Pressing the ‘+’ symbol in the treeview shows the hidden branches, pressing the ‘-’ symbol hides
them.

You are now ready to create your first bowtie diagram. A sample bowtie diagram is already created for you – you
can change this to your liking. If you want to create a new one from scratch, follow the instructions below.

3.3. Quickly adding a diagram
As adding a new hazard is an often done job, you can go into the Diagram menu and choose the “Add new BowTie
Diagram” option:
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Figure 7 - Add new Bowtie diagram
This adds a new empty bowtie diagram in one go which you can then adjust to suit your purposes. Double click
items to edit them. Look for the green buttons on the diagram to add new items:

Figure 8 - Green “+” buttons

3.4. Step by step - step 1: Add a bowtie group
Each bowtie diagram belongs to a bowtie group. Using the shortcut in the previous paragraph you might have
noticed a new default bowtie group was created to hold the new default diagram. We’ll now explain how to make
them step by step. It is very easy – just right click items to see what you can do to manipulate them.
Adding a bowtie group is how you begin your bowtie diagram. You are creating the case for one or more groups. A
bowtie group could be a warehouse or an oil-drilling platform, but also an airplane or a car. Each group can contain
multiple bowtie diagrams, one diagram for each Hazard/Top Event combination.
To create a bowtie group, go to the treeview window and do the following:
1.
2.

Right click your mouse on the tree node called bowtie group.
Select New BowTie Group…

Figure 9 - Adding a location
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3.
4.

The editor dialog box appears.
Enter a bowtie group name in the name text box.

Note: Notice the name field has a red exclamation mark next to it. This means it is a mandatory field and
you must fill it in.
5.
6.

Enter a more elaborate description, if desired.
Press OK to add the bowtie group.

This new location will appear in your treeview as shown in

Figure 10.

Figure 10 - Adding a location - treeview changes

3.5. Step 2: Add a hazard and a top event
Now you need to add a hazard and a top event to your new bowtie group.
1.
2.
3.

Take a look at the treeview. You will see the bowtie group you created in step 1.
Right mouse click on the bowtie group node.
Select New Hazard from the menu and the editor dialog will appear.

Figure 11 - Adding a hazard & top event
4.
5.

Enter a hazard name and a top event in the text boxes.
Click on the ok button to save.
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Notice that your hazard and top event now appear in the diagram window. You are now ready to begin working
with your bowtie diagram.

Figure 12 - After adding a hazard & top event

3.6. Step 3: Adding threats
Your treeview window will now look like this:

Figure 13 – The selected hazard in the treeview
And your diagram window will look like this:

Figure 14 - A minimal bowtie diagram
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Now you can start adding threats to your hazard/top event combination. This can be done directly on the diagram
or via the context (right-click) menu.
Move the mouse to the left of the red round top event shape. A little green plus will appear. Clicking this will add a
threat. Notice the position of the mouse pointer:

Figure 15 - Green “+” buttons (threats)
A dialogue box appears where you can name the threat you wish to add to the diagram. Enter a description and
press ok. Your diagram has now expanded.

Figure 16 - The newly added threat
You can also right-click the top event and find the Add -> New Threat menu item.
Continue to add threats until you are satisfied you’ve covered them all.
Note: Use the scroll bars and the zoom in/out buttons on the toolbar to navigate through your diagram.
Turn to paragraph 7.4, The editor and the editor dockable window on page 59 for more information about
the diagram and its toolbar icons.

3.7. Step 4: Adding consequences
If your top event were to occur, you would want to have an understanding of possible outcomes and necessary
reactions to such an event. Consequences in a bowtie diagram allow you to analyze both sides of a top event.
You can add consequences to your diagram similar to how we added threats – click the green button on the right
hand side of the top event:
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Figure 17 - Green “+” buttons (consequences)
The editor will pop up. Enter a description for the consequence. Click ok or hit return. Now your diagram looks like
this:

Figure 18 - The newly added consequence
Note: You can also right mouse click on the top event in the diagram or treeview. Then select Add 
Consequence.
You have now created the bare bones of your bowtie diagram. Next, you need to populate that diagram with
information about the measures that are in place to prevent threats from triggering the top event, and what
measures are in place to mitigate or prevent the consequences from becoming a reality if your top event has
occurred. These measures are known as barriers.

3.8. Step 5: Adding barriers
Now, you will add a barrier to your bowtie diagram.

Figure 19 - Green “+” buttons (barriers)
Click the green plus button next to the threat. The editor will appear. Enter the description of your barrier and click
OK.
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Figure 20 - The newly added barrier
Continue to add barriers to each threat or consequence until you feel your diagram is complete. You can add
barriers to the left or right of existing items.
You can reorder barriers by dragging them around. You can also reorder threats and consequences in the same
manner.
Note: You can also add a barrier by right-mouse-clicking on a threat in the diagram. You can also add
barriers via the treeview. Expand the threat and you will see a node titled “Barriers”. Right click that and
select to add a new barrier.

3.9. Step 6: Adding escalation factors
Escalation factors are conditions that lead to increased risk by defeating or reducing the effectiveness of barriers. To
add an escalation factor to a barrier in your diagram you click the green button on the bottom of a barrier:

Figure 21 - Green “+” buttons (escalation factors)
If you have barriers in place to prevent this escalation factor from defeating this barrier, they can be added similar
to how barriers are added to threats and consequences.

3.10. Bowtie diagram complete
By following steps 1 through 6, you have now completed a simple bowtie diagram. With the diagram laid out, you
can now add more variables to each part of the diagram in order to drill down to more specific tasks such as
categorizing your barriers and attaching activities, document references and a host of other things. Some are
described below.

3.11. Taking it to the next level
There is of course much more to the BowTieXP software then just drawing diagrams. In the next sections we will
give you the background needed for taking your analysis to the next level, and we will do this with examples.
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As you have seen in the previous sections, there are different kinds of information in each case file which are used
in a variety of ways. In this section we will explain the different types of data and how they interlink: some objects
which you create have special ‘abilities’ such as being able to be referenced from other places. We will also talk
about the theory behind some of these.

3.11.1. Normal entities
In the previous sections you have created a sample diagram by adding a location, a hazard, threats, consequences,
barriers and escalation factors. These items are known as normal entities and have no special abilities like the
“special” items we will discuss next. Most normal entities are diagram parts.

3.11.2. Lookup tables
One of the things you might have noticed on the editors is that the normal items have various properties, which
might be plain text, such as descriptions and codes, but also various drop-down lists such as e.g. the effectiveness
rating on a barrier.
The options available for the effectiveness ratings are actually defined in your case file and you can modify them
yourself. Like all data in the case file you can find them in the treeview, in this case under Case File  BowTie
Lookup Tables  Effectiveness.
All the different reference information used throughout your case file is defined under the “lookup tables” node.

Figure 22 - Lookup tables
Adding items here will make them available on the various drop-down boxes in the editor.
Removing items here will remove them of course. If a value is in use, you will be warned and asked if you would like
to select another value to replace it with, as you can see in Figure 23 - Deleting a lookup table value below.

Page 25 of 263

Figure 23 - Deleting a lookup table value
In BowTieXP the following lookup tables exist:
Lookup table type

Description/usage

Action Categories
Activity Categories

Used on actions to categorize the different actions
Used on activities to categorize the different activities

BRF Codes

Used on barriers to indicate the Basic Risk Factor (BRF) the barrier belongs to. For
more information on basic risk factors and Tripod theory, refer to the methodology
manual.

Plot Plans
Organizational Unit Types
Organizational Units
Hazard Categories

Used to add plot plans to Organizational Units
Used to categorize Organizational units
Used on BowTie Groups, Audits and Incident to indicate to which organizational
unit the bowtie diagrams, audit fill outs and/or incident diagrams belongs to.
Used on Hazards to categorize the hazard.

Threat Categories
Threat Types

Used to categorize and color-code threats.
Used on Threats to categorize the threats into different types.

Consequence Categories
Consequence Types

Used to categorize and color-code consequences.
Used on Consequences to categorize the consequences into different types.

Escalation Factor Categories
Escalation Factor Types

Used to categorize and color-code escalation factors.
Used on Escalation Factors to categorize the Escalation Factors into different types.

Priorities

Used on actions to prioritize them.

Frequencies

Used on activities to indicate the frequency of activity execution.

Effectiveness

Used on barriers and management actions to signify the effectiveness of the barrier
in preventing the top event or consequence from occurring.

Criticalities

Used on barriers to signify critical barriers.

Barrier Types
Barrier Categories

Used on barriers to categorize the barriers into different types.
Used to categorize and color-code Barriers.

Systems

Used on barriers to show systems related to the barrier. One common usage is to
create hierarchies of systems to reflect physical equipment and hardware systems.
Systems can have logic about how many underlying systems can be off before the
system itself is considered off.

Competencies

Used on activities to show which competencies are needed to perform the activity.
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Job Titles

Job titles are abstractions for people tasked with a certain responsibility. Another
word for this concept could be post indicator.
They are used on activities to indicate e.g. the person responsible for the activity
and who signed off on the activity. On barriers and hazards they indicate the
accountable person. On hazards they are also used for the sign off information. On
actions they are used to indicate the person who has to execute the intended
action.

User Systems

Used on barriers to show which systems (e.g. power supply system) are needed to
operate a barrier.
Note: User Systems are only available in BowTieXP Advanced.

Parts

Can have an on/off status. They are mainly used to indicate the on/off state of
equipment and they provide a convenient interface to external maintenance
systems. Parts can be linked to Systems and User systems to indicate whether that
system is on or off based on the linked parts.

3.11.3. Linkable entities by example: activities
For some properties it is not enough to be able to select only one value, you need to be able to assign multiple
items from a limited list of items.
Let’s clarify this fairly abstract idea with an example.
In most organizations there’s a management system of activities/tasks which define how your organization is run. A
lot of these management system activities are essential for keeping barriers from working correctly – for example,
an automatic fire suppression system needs regular maintenance, inspection and testing to ensure it will function
correctly when needed.
To leverage the usability of your bowtie diagrams, mapping between your management system and your diagrams
is important: It enables you to analyze which tasks and therefore which persons/posts are managing threats, how
many different activities and therefore also how many people are responsible for this and if any threat is sensitive
to single points of failure in your management system.
For example, a threat, which is controlled by barriers, which is supported by a number of activities, which all rely on
the same person, might be considered more vulnerable than one with barriers and activities that are not all
dependent on one person.
It also allows for better communication on why certain activities are critical, which helps the persons responsible
from understanding why they are to do the mentioned task and therefore ensuring better execution.
To support this analysis, you can define management systems that contain a hierarchy of activities within BowTieXP.
After creating / inputting this hierarchy of activities into BowTieXP, you can assign various activities to your barriers.
See the example below:

Page 27 of 263

Figure 24 - An example activity hierarchy with multiple management systems
After the hierarchy has been defined, we can now link the activities onto barriers. You can do this in a couple of
different ways: Drag and drop and via the Editor.

3.11.3.1. Drag and drop
All link assignments can be made using drag and drop, similar to how you copy files in Windows Explorer.
To assign an activity to a barrier using drag and drop, ensure that the barrier you want to assign to, is visible in the
diagram and the activity you want to assign, is visible in the treeview.
1. Click the activity and keep the mouse button pressed down.
2. Move the mouse over to the diagram whist holding the mouse button. You will see the mouse pointer
indicate when it is valid to let go.
3. Release the mouse button when the mouse pointer is over the barrier where you want to assign the
activity.
The link has now been made. You might have notice the following popup when dropping the activity:

Figure 25 - Diagram display popup
If you click yes, the assigned activities will be shown on the diagram:
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Figure 26 - Activity linked to barrier
If we missed the dialog, we can also manually adjust the display settings. To do so, take the following steps:
1. Click the little eye icon on the barrier:

Figure 27 - Barrier display - eye-icon
This will bring up a dialog which allows you to adjust display options for barriers. Note that all shapes have this little
icon.

Figure 28 - Set barrier display window
Select the S column for activities – this will show the activities of the barrier in Short format. You can also choose L
for Long format.
If you have many settings to change, you can also open up the diagram display options menu:
1. Go to the diagram menu,
2. Choose diagram options,
3. In the tree, open up the barrier settings.
4. Select the ‘S’ column radio button under barrier for activities.
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Please refer to the screenshot which button to click – note the mouse position.
The diagram will change and show all the assigned activities below each barrier. Verify the link you just made.

Figure 29 - Showing activities on the diagram
The second method is the method which allows us also to remove the link: via the treeview.
In the treeview we can open it up further by clicking the plus sign, which will show all the child collections the
activity has. One of those is named Activities. Open it up and you should see the activity there in a gray color.
The gray color is to tell you that it isn’t actually defined there but only a link.
Dragging and dropping is possible from most windows within BowTieXP – you can drag and drop within the
treeview, from the treeview to the diagram, from the listview to the diagram, etc. The listview is especially useful
for assigning links – click the activity container in the treeview and the listview will show all the activities defined.

3.11.3.2. Editor
Double click the barrier to bring up the editor. Select the activities tab:
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Figure 30 - Editor window / activities tab
The left hand side of this screen shows all the items which can be linked to the barrier. The right hand side shows all
the entities already assigned. To move items between the two sides, you can select them and press the relevant
arrow icon between the two halves of the screen. You can also drag and drop items between the two sides.
Note that items which are drawn in gray have already been assigned / moved to the right hand side.
Also note that you can filter the items shown by typing information into the filters. You can also sort on each
column by clicking the headers.
You can also create a new item by clicking the “create new” button. This will allow you to add a new item to the
item currently selected in the left hand pane.
When assigning document links and activities the screen described above is used, due to the hierarchical nature of
these items. For flat data such as e.g. systems, the dialog looks slightly different, and can be seen below:

Figure 31 - The assign links screen showing flat data
One thing to note is that now assigned items aren’t shown in gray on the left hand side, but are removed and only
visible in the right hand side.
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3.11.3.3. Deleting linkable items
Note that when deleting an item which has been used, you will get a popup similar to the popup when deleting a
lookup table item (see Figure 23 - Deleting a lookup table value on page 26): You are allowed to select an optional
replacement value.

3.11.3.4. Overview of linkable items
Linkable entity type

Description/usage

Activity

Described above. Activities are linked to on barriers.

Document Link

Document links are references to external documentation which can be added to
various elements in the case file. Like all linkable entities, they are defined
centrally and then referenced from other elements in the form of links.

Wiki Groups / pages

Operational Risk Factor

Linking to document links is possible from hazards, threats, consequences,
barriers, escalation factors and activities.
Wiki pages are references to internal documentation which can be added to
barriers in the case file. Wiki pages are often imported using the Wiki module in
BowTieServer, but wiki pages can also be used for BowTieXP only.

NOTE: This functionality is advanced only
Operational risk factors are used to specify certain dimensions of operations
which need to be considered separately in Soob matrices from the operation as a
whole, such as critical equipment and e.g. weather conditions.
See chapter 21,
Advanced functionality: Soob matrices on page 153 for further details.

Operation

NOTE: This functionality is advanced only
An operation in BowTieXP is used to describe a specific operation which can take
place in your organization and should be present on the Soob matrix.
See chapter 21,
Advanced functionality: Soob matrices on page 153 for further details.

3.11.4. Show usage references / backlinks
When an activity is referenced on say, a barrier, there’s a virtual arrow pointing from the barrier to the location in
the Treeview where the activity is defined. The figure below demonstrates this. It shows a part of a bow-tie
diagram. Listed below each barrier are the activities assigned to that barrier.
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Figure 32 - Treeview and diagram, explaining links
This arrow is called the link. We can also follow this arrow in the reverse direction, from the activity to all the
barriers where it is used. These are called the backlinks.
A similar concept applies to lookup table values.
For each linkable entity and each lookup table value we can find out where they are used by showing us their
backlinks / usage references.
This is done by right clicking the item of which you want to see where it is referenced, and selecting the option in
the context menu called “Show usage references”. The Listview will show all the places where the item is in use.
See also section 7.9 starting on page 70, the Listview window.

3.12. Actions
Actions are designed for activities that do not recur. They can be used in two ways, as TODO items when developing
a bowtie, or as an improvement plan on an existing bowtie.

3.12.1. Actions as a TODO list
Let’s say you have a barrier in your bowtie, but you’re unsure who is accountable for it. Creating an action lets you
track all the elements in your bowtie that need more investigation.

3.12.2. Actions as improvements
You could also use actions as a more formal improvement plan. After completing the bowtie and seeing how your
organization manages risk currently, there are often scenarios that could be improved by adding new barriers or
improving existing ones. You can use actions to highlight those areas.
Some examples of actions as improvements are: correcting an error in a procedure, adding a new smoke detector or
changing the accountable party for a barrier. These are performed once to improve safety, but do not need to be
repeated regularly.
Actions to create a new barrier are usually displayed on the associated Threat or Consequence, while improvements
on existing barriers are usually put on the barrier itself.

3.12.3. The difference between actions and activities
BowTieXP also allows you to add activities, and there’s often confusion about the difference between actions and
activities. Activities are used to describe regular recurring tasks like maintenance and training. These are part of
your safety management system.
Actions on the other hand, are one-off improvements on a safety management system or barrier. For example, an
activity could be maintenance on an engine, an action for that activity could be to create a new checklist to make
the maintenance less error prone.
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3.12.4. Adding an action
Adding an action is done by selecting any element in the bowtie and either clicking the action icon in the toolbar

Figure 33 - Action button in the toolbar
or right clicking on the element  Add  Action

Figure 34 - Add action by right clicking

3.12.4.1. Action properties
The fields on an action are:
-

Code: the action code is displayed on the diagram.
Name: describes what the action is about.
Description: a detailed description of the action.
Category: categorizes actions (e.g. TODO’s or improvements).
External Reference: this field can be used to fill in a reference to an external action tracking system.
Action party: the job title responsible for completing this action. The Job titles are defined in the Lookup
tables
Target: gives the date before which the action has to be completed.
Priority: gives a priority to an action. The list of priorities is defined in the Lookup tables
Completed: this box is ticked once the action has been completed.
Sign off authorized by: the job title that authorized the completion.
Sign off date: the date on which the action was signed off.
Sign off comment: an optional field to provide comments when signing off an action.
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Figure 35 - Add action window

3.12.5. Visualizing actions
Actions are visualized on the bowtie as post-it shapes. The code is also displayed.

Figure 36 - Display of actions
Go to Diagram  Display options and under Action Shapes, select either None to hide all actions, Overdue to show
all uncompleted actions with the target overdue, Uncompleted to show only uncompleted actions or All to see both
completed and uncompleted actions.
In the Colors tab you can also select Action Colors. Coloring can be done by Priority, or completion status.
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3.12.6. Action reports
Go to Tools  Reports and expand the Actions section to see the following action reports:
Actions in XL: a flat list of Actions, opens in Excel
Actions in BowTie context: Actions in BowTie context, with empty fill in lines, opens in Excel
Actions in BowTie context, condensed version: Actions in BowTie context, opens in Excel. No empty fill in
lines, only listing the objects that actually have Actions descendants
Action of a selection of Hazards: a report with all actions for particular Hazards, opens in Word
All Actions: a list of all actions in alphabetical order based on code, opens in Word
Actions by Action party: a report that prints out all actions sorted by Action party, opens in Word
Actions by Priority and Action party: a report with all actions sorted by Priority, opens in Word
Actions of a specific Action party: a report with all actions for a specific job title, opens in Word
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4

A deeper look at the bowtie method
Due to the length of this chapter, we decided to make it into a separate document. It has taken a while, but the first
public version of our bowtie methodology manual is now available. Please contact support@cgerisk.com to see if
you are eligible to receive a copy.
This document aims to educate the reader on the bowtie method as it is used in the industry at the moment. It is
both a practical reference for everyday users of the method and a theory guide. This means that theoretical
concepts are elaborated with practical tips and examples on how to use the method.
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5

The different BowTieXP versions
In this chapter a quick overview is offered of the extra
functionality available in the various versions of
BowTieXP.

5.1. Introduction
BowTieXP comes in three versions:

BowTieXP Standard Edition

BowTieXP Navigator Edition (read-only & adding actions)

BowTieXP Advanced Edition
The following add-ons are available:

SharePoint add-on

Spreadsheet add-on (BowTieXL)

AuditXP add-on

IncidentXP add-on
The IncidentXP add-on is an incident analysis add-on, which features the DNV BSCAT method, the Tripod Beta
method, the Barrier Failure Analysis (BFA) method as ways of doing barrier based incident analysis. IncidentXP also
includes the non-barrier based Root Cause Analysis (RCA) method. IncidentXP can be used as a stand-alone tool, but
is also available in combination with BowTieXP1, allowing you to link reactive incident analysis to proactive risk
analysis. Besides the three methodologies described above, Root Cause Analysis is also featured by IncidentXP.
However, this methodology is not barrier based and therefore not linkable to bowtie risk analysis.

5.2. Navigator edition
Not everybody who needs to access bowtie information needs to be a full licensed bowtie user. BowTieXP Navigator
allows non-bowtie builders to access all information in a bowtie file (.btf), without being able to change the content.
The Navigator version is often used by the workforce or management. They need the bowtie information, but are
not designated or trained to modify the bowtie diagrams.


Features which are present in the Navigator edition of BowTieXP:
o Change display settings
o All export functionality (generating reports, save diagram, print diagram)
o Add Actions (allows the bowtie reader to give feedback to the diagram)

5.3. Advanced edition
The advanced edition of BowTieXP offers many extras for the power users of BowTieXP. These extras consist of:


Extra features which are not present in the standard edition of BowTieXP:
o File and tree compare
o Customizable type and property descriptions (terminology)

1

Actually, BowTieXP and IncidentXP are both inside the same program. The license key determines what you get to see –
BowTieXP, IncidentXP or both.
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o
o
o
o
o
o

Relationship diagrams, including how bow-ties interrelate
Configurable treeview filtering and tooltips
Barrier visual bundling, to group barriers together based on a similar characteristic
Diagram display profiles (switch quickly between modes)
Soob matrices (also known as MOPO or SimOps)
Live On/Off-line states based on barrier parts



Enhancements to how you edit your data:
o Edit multiple items at the same time
o Automatic group detection – edit all the instances of the same barrier across many diagrams at
once
o The scrap book
o Import data from e.g. Excel files
o Full import of data from other BowTieXP case files
o Copy/paste between multiple files



Improvements in how you gain insight into your case files via extra reports and case file overviews:
o Advanced case file overview perspectives
o Advanced reports
o Ability to search the contents of document links

5.3.1. Soob matrices
The Summary of Operation Boundaries matrix is a record of operations used to determine under which
circumstances extra caution should be taken or work should no longer be allowed to proceed. This is to help the
decision process of whether to proceed with operations when encountering suboptimal conditions.
For
a
full
explanation
about
Soob
matrices,
please
refer
to
chapter
21,
Advanced functionality: Soob matrices on page 153. This chapter describes what Soob matrices are, how they are
used and constructed.

5.3.2. Type and property descriptions
Each case file contains a large table containing the names of all object types and their properties present within
BowTieXP. This allows customers to make slight adjustments to various names and allows them to tailor-fit the
software to their company. For example, you could rename barriers to be labeled as controls.
See chapter 20, Advanced functionality: type and property descriptions on page 151 for full details.

5.3.3. Relationship models / diagrams
The relationship diagram functionality can draw many different diagrams based in the data you have entered into
your case file, visualizing the relationships between the data. For example, barriers can be assigned activities, and
activities have responsible persons. How do the responsible persons relate to the different hazards via the barriers
and activities defined?
With the relationship model functionality this question is answered easily with just a few clicks of the mouse.
More than 20 different diagrams are offered.
Now bow-ties can interrelate, you can also create diagrams showing how one bowtie flows into others:

Figure 37 - Relationship diagram - Bowtie chaining
You can also easily navigate from diagram to diagram using on-screen aids:
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Figure 38 - Bowtie chaining
These are explored in depth in chapter 9.5, Advanced functionality: relationship models on page 93.

5.3.4. Compare files side by side
On many occasions you want to find out what your colleague changed in the latest revision of the case file. Do you
need to see what the differences are between two versions of the same case file in your document management
system? Then compare the files side by side, see the differences visually or generate a report of these changes. You
can do it all with the file compare function in BowTieXP advanced.
See
full
details
in
Advanced functionality: comparing files and parts of files on page 145.

chapter

19,

5.3.5. Treeview filtering and treeview tooltips
The Treeview contains every available option for adding data into BowTieXP, some of which you will never use and
some which you will only use during certain phases of bow-tie building. You can make the Treeview a lot compacter
by temporarily hiding these collections and objects by means of the Treeview filter profiles. See section 7.11,
Treeview filtering on page 71.

5.3.6. Barrier visual bundling (barrier families)
Long lines of barriers can be reduced in size by bundling barriers together if they share a similar characteristic. This
could be based on barrier type, job title, effectiveness, criticality or the barrier family name.

Figure 39 - Barrier Families
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5.3.6.1. Diagram display profiles
As the number of configurable display options has grown very large over the last years, and setting up the wanted
display can take quite some time, the diagram display profiles were introduced.
Each case file can hold a list of diagram display profiles, and you can easily switch between them using a drop down
box above the diagram.
See chapter 17, Advanced functionality: diagram display profiles on page 131 for details.

5.3.7. Enhancements to editing your case files
Apart from the enhancements discussed above, the advanced edition also offers extra functionality for editing your
case files, such as improvements to import functionality, the ability to find and replace and enhancements to
working with multiple case files.

5.3.7.1. Edit multiple items at once
The advanced edition allows you to edit multiple items at once:

Figure 40 - Edit multiple items
This allows you to edit a single property of multiple items at once – i.e. set the effectiveness or the responsible to
the same value while leaving the descriptions untouched.

5.3.7.2. Automatic group detection – edit all the instances of the same barrier across
many diagrams at once
BowTieXP automatically recognizes barriers with the same code and name, and allows you to edit all of them with
the press of a single button. This simplifies keeping barriers in sync over multiple diagrams.

Figure 41 - Edit barrier groups
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5.3.7.3. The scrap book
BowTieXP advanced offers the scrap book. It is a dockable window that allows you to:







Copy entities there to keep them around for a while, and later drag them back into any case file (might be
a different one).
Drop data files (Excel, BowTieXP) and read the info on them into BowTieXP.
Convert items from one type to another.
Items that can't be given a place within the current case file yet can be temporarily stored.
Store frequently used items - e.g. make a short list of frequently assigned activities.

Items on the scrap book such as Bowtie Groups, Hazards and Consequences serve as templates. When you drag an
item from the scrap book onto a bowtie diagram, a copy is made which is placed in the case file.
Because the contents of the scrap book are independent from your case files, you can use it to build a library of
often-used templates.
You can also place reference information on the scrap book, such as activities or document links. When you drag
these items onto a shape in the diagram, you add a link to the corresponding reference item in the case file.

5.3.7.4. Find and replace
The advanced edition of BowTieXP allows you to do single or mass find and replace operations in your case file. See
section 9.4.1, Text find and replace on page 93 for details.

5.3.7.5. Import data from files
BowTieXP advanced offers more and different methods of getting data into BowTieXP, such as importing data from
Excel and tab- and comma-delimited files.
See section 12.3, Importing data from Excel on page 110.

5.3.7.6. Full import from other BowTieXP case files
BowTieXP standard edition is limited to importing only the diagrams, and cannot import other details such as
assigned responsibilities and activities.
The advanced edition allows you to import everything from a case file, including linked information such as activities
on barriers and assigned responsibilities.
See section 12.2.2, Importing entities with BowTieXP advanced on page 108 for details.

5.3.7.7. Copy/paste between multiple files
Similar to importing data from a case file, you can also start another copy of BowTieXP, open the file you would like
to copy data from, and use copy and paste.
See section 12.2.3, Copying entities from one file to another using the clipboard on page 109 for the details.

5.3.8. Enhancements to gain insight into your case files
BowTieXP advanced doesn’t only add enhancements to editing, but also to analyzing and gaining understanding and
knowledge into the data and relations within your case files.
Some extras here are specifically meant for the extra data you can put in using the other advanced options while
others work on all data in your case files.
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5.3.8.1. Advanced case file overview perspectives
Note: for details on the case file overview, see section 9.2, Case overview on page 89.
The case file overview has two extra perspectives:

“Operations”. The operations overview shows all operations which exist and where they are referenced.

“Management System (Activities, Barriers, Hazard categories)”. This overview shows a powerful alternate
view of all defined activities, which allows you to drill down and see to which barriers they are assigned,
drill down into the barriers’ parents all the way up to the hazard. A cumulative overview of the hazard
categories is also shown.

5.3.8.2. Advanced reports
To accommodate the extra information you can input in Advanced, and to gain some more complex insights into
your data, the advanced edition has a number of extra reports:
8 extra reports:

“Activities linked to Barriers as hierarchical list”

“Activities of a specific Operation grouped by Activity. Responsible (Short version)”

“Activities of a specific Operation grouped by Activity. Responsible (Long version)”

“Required Competencies for a specific Operation, grouped by Activity. Responsible”

“Hazard register complete”

“Traditional Hazard register”

“Operations overview”

“Formatted Soob Matrix report”
For details please refer to section 13.2.2, BowTieXP reports on page 113.

5.4. SharePoint add-on
BowTieXP can use Microsoft SharePoint in two different ways – as a document management system and for storage
of data in custom lists.
BowTieXP supports SharePoint document libraries as a place to store documents. The SharePoint document
libraries can be used by BowTieXP to save, load and version BowTieXP case files, taking full advantage of all the
features offered, such as:

User and group security,

Checking out and in of files,

Automatic file versioning,

Storing of metadata with the files,

Customizing workflows.
BowTieXP allows you to check out, check in, determine version numbers, get previous versions and compare
versions.
BowTieXP also supports the offline viewing and editing of SharePoint lists – you can download the entire list into
your case file, view it, edit it, and sync it back to the online version.
See chapter 26, SharePoint add-on on page 203 for details.

5.5. Spreadsheet add-on (BowTieXL)
BowTieXL introduces a Microsoft Excel compatible spreadsheet into BowTieXP, which exposes the majority of the
information in the case file as tabular data in this spreadsheet. This allows you to use that data to do spreadsheet
calculations based on that data, and feed the results back into your bow-tie model.
Apart from being able to do calculations based on the bow-tie model data, you can also use BowTieXL to:

Store reference information in spreadsheets, which are stored in the case file,

Add notes and calculations which serve as underpinning of the analysis in the case file,

Add general reference information into the case file,
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Use the tabular representation of the bow-tie model data to quickly edit data in bulk,
Use Excel formulas to create custom aggregated displays of data on the diagram,
And many more.

See chapter 27, Introducing BowTieXL on page 217 and chapter 28, Calculating with BowTieXL on page 224 for
details.

5.6. IncidentXP as an add-on
IncidentXP is stand-alone tool allowing you to create incident analysis diagrams. It can also function in conjunction
with BowTieXP, allowing you to create both incident diagrams and bowtie diagrams and relate those to each other.
By mapping incidents onto proactive bowtie diagrams, more can be learned from incidents than when they remain
isolated in the reactive domain. This deepening of the understanding works in two directions:
1.

By having the applicable proactive risk assessments on hand during the incident analysis, quicker barrier
identification is possible and hindsight bias might be lessened, and more importantly,

2.

By identifying the proactively defined barriers which have failed, we are measuring real-world
performance and helping identify weak spots in our barriers and management systems as well as
discrepancies between pre-incident effectiveness assessment and actual barrier performance.

There are four different methodologies available in IncidentXP: BSCAT, Tripod Beta, Barrier Failure Analysis (BFA)
and Root Cause Analysis (RCA). This makes IncidentXP a multi method investigation platform within BowTieXP.
Each method adds a completely separate incident diagram, consisting of events and barriers (in the case of BSCAT,
Tripod and BFA). Having a separate incident diagram allows for flexible mapping between the bowtie barriers and
the incident barriers, allowing variation in detail level to exist between the incident investigation and the risk
analysis.
For more details on IncidentXP specifically, please refer to the IncidentXP manual available for download on
http://www.cgerisk.com/downloads/bowtiexp/
For more details about IncidentXP in conjunction with BowTieXP, please see chapter 29, IncidentXP and BowTieXP
together on page 233.

Figure 42 - An IncidentXP timeline

Page 45 of 263

Figure 43 - a BSCAT diagram

Figure 44 - A Tripod Beta diagram

5.7. AuditXP as an add-on
With the AuditXP add-on, users can define verification questions for barriers. The questions can then be grouped
into surveys (questionnaires) which can be sent out to individuals to get feedback on the effectiveness of barriers.
Once the surveys have been filled out, the results can be graphically displayed on the BowTie diagram in the form of
easy red and green bar charts. For more information about AuditXP, please refer to section 24.

Figure 45 - AuditXP add-on
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6

Introducing BowTieXP
This chapter gives a quick overview of how the
software is set up and will show how to get the most
out it.

6.1. Introduction
In this chapter we will discuss some design points about BowTieXP – how the software is designed to work and how
to get the most out of it.
It will cover starting and quitting the application, customizing the user interface, working with files and templates,
importing case files, undoing and redoing modifications and other basic tasks.
This chapter assumes you have basic knowledge of Microsoft Windows operating systems and bowtie methodology
and helps you to more quickly create better case files.
Note: The symbol  denotes menu traversal paths, e.g. Help  Release Notes refers to the menu option
Release Notes in the Help menu.

6.2. Starting and exiting BowTieXP
6.2.1. Starting BowTieXP
You can start BowTieXP either from the start menu, desktop shortcut, or by double-clicking a BowTieXP case file.

6.2.2. Exiting BowTieXP
To exit BowTieXP, choose File  Exit or click the close button in the window title bar. If the open file has unsaved
changes, you will be prompted to save those before continuing.

6.3. Changing the user interface language
BowTieXP has a multi-lingual user interface. In order to change the current language, you first start BowTieXP.
Choose HelpChoose UI Language or press F9:
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Figure 46 - Changing the UI language

Figure 47 - Choosing a UI language
After selecting your language of choice, click ok. BowTieXP will restart for these settings to take effect.
The topmost one (Auto-detect / use Window settings) makes BowTieXP auto detect the language.
At the time of writing the following languages are available:

German

English

Spanish

Spanish (Mexican)

French

Japanese

Korean

Norwegian (Bokmål)

Dutch

Portuguese (Brazilian)

Romanian

Russian

Chinese (Simplified)
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6.4. Working with files
The following section explains how to work with files within BowTieXP.

6.4.1. BowTieXP case files
You can open BowTieXP files via File  Open on the main menu. After loading a file, the treeview, diagram, case
overview and all other windows in BowTieXP will be populated.
Select a hazard in the treeview window in order to make your diagram visible.
Note: The way BowTieXP works with files is very similar to how you open and save files in Microsoft Word.
Similarly, you are able to attach your BowTieXP case files to your e-mail messages, transfer them to an
USB stick, etc.
Creating a new file can be done by selecting File  New… By default this will create a new file based on the built-in
BowTieXP case file template. If you have configured custom templates, you will be asked which template to base
the new file on. For more details see chapter 14, Working with templates on page 123.

Figure 48 - Choosing a new file template

6.4.2. Importing Thesis™ files
You can import Thesis™ files into BowTieXP by clicking on File  Import Thesis from the drop-down menu. After
you have imported a Thesis™ file and saved it as a BowTieXP file, you can open it via the normal method (File 
Open).
Note: BowTieXP has support for importing Thesis™ versions 3 and 4.
If you already had a file open when choosing Import and have made changes, you will be asked whether or not you
want to save your changes before continuing.
Note: Check your imported case file for a correct result of the import and make sure all relevant
information is present. Not all information can be imported.

6.4.3. Saving files
To save the changes you made to a file, choose File  Save or choose the save button

on the tool bar.

To save your changes under a different file name, choose File  Save As.
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To discard changes, choose File  Close and confirm that you will lose your changes.
You can easily see if you have made changes to the current file by looking at the filename in the title bar at the top
of your screen. If there are changes, an asterisk (*) is displayed after the filename.

6.4.4. File recovery
BowTieXP automatically makes a backup copy of the current file every 10 minutes. This occurs to minimize the
damage done by an unexpected shutdown of the software due to power failure, operating system crash or an
unhandled exception in the software.
If you start BowTieXP and it detects there is a backup copy, you will be prompted to save the backup copy to a
different name. Then inspect the file to make sure you have not lost any data.
Note: The auto save is done to a special directory and does not modify the original file you opened. After
auto saving you can still abandon your changes by closing the file.

6.5. The undo and redo system
BowTieXP, like every modern Windows application, has an advanced undo and redo system which tracks all your
changes and allows you to undo any modifications.
The undo and redo system in BowTieXP is unlimited, you can go back as far as you want and move up again to
actions which you have just undone, enabling you to review your latest edits.

6.6. Navigating around the software
The picture below shows the main window of BowTieXP. It contains several sub windows, which display various
aspects of a case file and have different uses.

Figure 49 - The default window layout of BowTieXP
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The table on the next page describes each portion of the main window and its purpose. More detailed information
on each window follows the table, and each will also be addressed in more detail in the following sections.
Window

Purpose

Treeview Window

The treeview window allows you to easily navigate through your diagram and
to drill down to very specific parts. The treeview is most useful for navigating
between bowtie groups in a case file, adding and deleting elements in your
lookup tables, and defining and keeping track of activities.
Note: Every piece of information present in the case file has a place
in the treeview; it is the central directory of the case file.
You can use the export button in the top right-hand corner of the treeview
window to export the contents to an Excel file.

Diagram Window

The diagram window is where you usually build your bowtie diagrams by
adding consequences, threats, barriers and other elements.

Overview Window

The overview window gives you a complete map of your current diagram.
If you have a large bowtie diagram, you can navigate around it quickly using
this window. Just grab onto the green box and drag or expand it over the area
you wish to focus on in the diagram window, or drag a new box in an area you
want to see in the main diagram window.

Listview Window

When you select an item in the treeview, the listview window displays a list of
the item’s children.
The listview is made for working with multiple items at the same time.
You can use the export button in the top right-hand corner of the listview
window to export things to an Excel file.

Editor Window

The editor window displays the details of the currently selected item.
This allows you to easily edit your work by clicking on a part of your diagram in
the diagram window or another item in the treeview and then editing any
information for the selected item in the editor window.
You can edit and view details about your selection in two ways in BowTieXP –
one, by double clicking or pressing F2 to bring up the popup editor, or two, by
docking the dockable editor window somewhere.

Scrapbook Window

NOTE: This functionality is advanced only
The scrapbook window is like a clipboard on steroids – it allows very intuitive
case file editing using drag and drop. See chapter 18, Advanced functionality:
the scrap book on page 134.

Quality Checks Window

The quality checks window allows you to do different checks of your case file
to make sure it is complete and show areas which need more attention.

Find Results Window

The find results window is used to show the results from your search
command.

Case Overview Window

The case overview window offers insight from different perspectives into the
relations between the data in your case file.

Color Legend

The color legend shows an overview of the different colors in use on the
diagram.

Relationship Diagrams

NOTE: This functionality is advanced only
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The relationship diagrams allow you to visualize the different relationships
between data in your case files from different perspectives.
Spreadsheets

NOTE: This functionality is in BowTieXL only
The spreadsheets are the heart of BowTieXL – they are a Microsoft Excel
compatible spreadsheet into BowTieXP, which exposes the majority of the
information in the case file as tabular data in this spreadsheet.
This allows you to use that data to do spreadsheet calculations based on that
data, and feed the results back into your bow-tie model.

6.7. How to configure your main window
BowTieXP has a reconfigurable user interface built around dockable windows. You can:






Float windows on top of the main window and above the other dock windows.
Drag each window to dock it at another position in the main window.
Drag each window to resize it.
Set windows to automatically hide if not used.
Save and load your preferred layouts for various tasks.

The sections on the following pages describe how to create the ideal working space for your particular needs when
creating a bowtie diagram.
To float a window or to change its docking position, click and hold the title bar of the window you wish to move,
and whilst holding down the mouse button, move the mouse, dragging the window out of position.
As shown in the graphic below, a transparent blue box will appear to represent the window once you drag it out of
its original position.

Figure 50 – Re-docking the treeview
Arrow symbols will appear in the center of your screen and around the edges, as shown
above and on the left. These arrows help you to position your window. They define different
locations within BowTieXP where you can dock your floating window.
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Experiment by dragging the mouse pointer and the blue box over the different arrows. BowTieXP will show you the
position of the selected window if you release your hold on it. This feature allows you to see what your new screen
would look like with the window positioned in a new place without committing to the change.
Find a suitable position for your window and release your hold on the title bar. The window will snap into place in
the area you’ve chosen.
If you wish to place a window between two windows, drag the blue box toward the solitary arrow on the selected
edge of the screen.
Remember, BowTieXP will always show you where the window will be located before you commit to the change.

Figure 51 - Re-docking the treeview step by step

Note: If you wish to float your window on your screen, just double-click the title bar. This allows you the
freedom to manipulate its location anywhere it is convenient. To re-dock, simply double-click the title bar
again.
Also, don’t forget you can reset the windows to the default by pressing CTRL + SHIFT + F12.
To configure a docked window to auto-hide you can click on the push-pin icon in the title bar (
). When the pin is
horizontal, the window disappears into a tab on the side of the main window. To make the window reappear, hover
your mouse over it or click it.
Note: Auto-hiding dock windows help you gain a lot of screen real estate.
To close a window, click on the X icon in the title bar.
You can reopen any closed window by clicking View  Windows in the drop-down menu and selecting the window
you want to reopen.
To save time, you can save your favorite layout for later use. This also allows you to have multiple layouts for
different tasks.
How to save a layout: Arrange the windows the way you prefer. From the drop-down menu, select View 
Windows  Save Layout As… Name your layout and click Save.
To restore the default screen layout:
Select View  Windows  Defaults from the drop-down menu.
OR
Use the key combination CTRL + Shift + F12.
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Also, if you lose a window, select View  Windows on the drop-down menu to restore it to the layout.
Note: To simplify this process, use the Layout A – Layout B option. This option allows you to switch quickly
between two different layouts.
To select Layout B, just go to View  Windows  Switch to Layout B, or use the toolbar button.

6.8. Context menus
BowTieXP has context menus for each element in the bowtie software. When you right-click on an element, a menu
appears with related actions. The graphic below is a context menu for a barrier:

Figure 52 - The diagram context menu
If you want to know how you can interact with an item, simply right-click it.

6.9. Toolbars
Some windows have a toolbar at the top, which allows quick access to the most commonly used functions. Hover
your mouse above a button and a tooltip will popup, which describes the function and mentions the keyboard
shortcut, if the button has one.
In the image below, the mouse is hovered over the Save button on the main application toolbar.

Figure 53 – The main application toolbar with tooltip
All toolbars are described in the relevant section about each window. The main application toolbar is described
below.

6.9.1. The main application toolbar
The main toolbar looks like this:
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Figure 54 - The main application toolbar
Note: In the standard toolbar, some less frequently used buttons are hided. See section 6.9.2 Hide /
unhide toolbar buttons on page 55.
From left to right it contains the following buttons:
Icon

Description
Open file
Save file
Undo
Redo
Navigate back in the treeview
Navigate forward in the treeview
Copy
Paste
Show inter-process clipboard import errors (Advanced only)
Switch to layout A
Switch to layout B
Restore default Dock layout
Show diagram
Show reports

6.9.2. Hide / unhide toolbar buttons
Any toolbar can be customized by clicking the small button on the far left (see Figure 55). Some more advanced
functionality is actually hidden from view in these menus.
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Figure 55: Customizing a toolbar
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7

Case file editing
In this chapter, all the windows which pertain to editing
your case file will be discussed.

7.1. Introduction
After we have reviewed how the BowTieXP user interface works, how to create, open, close files and how we can
navigate through the software, we’ll look into how we can build and edit our case files.
In this chapter we will discuss in detail among others the treeview, the editor and the diagram.

7.2. The treeview – anatomy of a case file
The treeview window contains all the information held in your case file.
You can expand and collapse details in this window by clicking on the plus/minus symbols.
There are a number of main parts / top level nodes in the treeview window: Case File, BowTie Lookup Tables,
incident Lookup Tables (only when IncidentXP is activated), Operations and Risks (only in Advanced version), Audits
(only when AuditXP is activated), Document Links, Activities, Incidents (only when IncidentXP is activated) and
BowTie Groups. Each part is explained below.

Figure 56 - The treeview window
Case File – This part of the treeview presents your case file, which contains all other elements of your BowTieXP file.
BowTie Lookup Tables – The lookup tables define all the pick lists in your bowtie diagram - generic information
used across the whole case. You can add or remove values from each of the tables as needed. The lookup tables
allow you to tailor your bowtie diagram so that it fits your organization perfectly.
Incident Lookup Tables - The lookup tables define all the pick lists in your incident diagram - generic information
used across the whole case. You can add or remove values from each of the tables as needed. The lookup tables
allow you to tailor your incident diagram so that it fits your organization perfectly.
Operations and Risks – The operations and risks section houses all the information pertaining to the summary of
operational boundary matrix functionality. This is a part of the Advanced BowTieXP edition. See chapter 21,
Advanced functionality: Soob matrices on page 153 for further details.
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Document Links – Document links are references to external documentation which can be added to various
elements in the case file. If the information is available on-line, it can also be opened directly from within BowTieXP.
Activities – A key feature of BowTieXP is the ability to define activities and sub-activities and link them to the
barriers in your diagram. By right-clicking the activities node, you can add, delete, and change the order of your
activities. You can also insert information about objectives, inputs, outputs, management Actions, performance
indicators, competencies and actions.
Incidents – The incidents node contains the incident diagrams, if IncidentXP is enabled. See chapter 29, IncidentXP
and BowTieXP together on page 233 for further details.
BowTie Groups – This node contains information relating to hazards and bowtie diagrams. Here, you will add all of
your groups, which BowTieXP uses as a starting point for building risk management models.
Keyboard Shortcuts
Right arrow
Left arrow
* (on numeric keypad)
/ (on numeric keypad)

Expand the currently selected node.
Collapse the currently selected node.
Expands the selected node and all children recursively.
Collapses the selected node and all children recursively.

You can export the contents of the treeview to Excel by clicking the little Excel icon in the top right corner.

7.3. Editing the lookup tables (taxonomies etc.)
All taxonomies in the form of dropdown selectors and link collections such as system and user systems are
customizable and configurable in the software. The contents of those dropdown lists can be changed, deleted and
added via the treeview. To do so, find the relevant taxonomy in the BowTie lookup tables (or incidents lookup
tables in case you want to define incident taxonomies). You can browse through the lookup tables by expanding and
collapsing the nodes as described in the previous section.

Figure 57 - Adding a new instance to a taxonomy list
Once you have found the taxonomy node, right click the parent node of that taxonomy (green dot) to open the
context menu in which a new instance within that taxonomy can be created. Newly created instances are added to
the bottom of the list, but can be reordered with the change order option in the right-click menu.
In the example shown in Figure 57, you can see the green parent node “Barrier Types” with the currently existing
children represented by the blue crosses. Right clicking will the parent node as indicated will add a new instance
(blue cross) to that list.
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7.4. The editor and the editor dockable window
When you select an item in a window such as the treeview, you can use the editor to change the name and fields of
the selected item or node.
There are two different editors in BowTieXP – the popup editor and the docked editor. The popup editor is shown:

When you double click an item,

when you select an item and them press F2,

And when you right-click an item and select edit.
The docked editor is not visible by default to save screen space, but you can make it visible by selecting View 
Editor. The docked editor is then always visible and will show the contents/details of the currently selected editor.
Here are screenshots of both editors:

Figure 58 - The popup editor
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Figure 59 - the docked editor
The popup editor is preferred as it only takes up screen space when needed, and also allows you to modify links at
the same time.
To make a change in the editor:
1. Select the item you wish to edit. Press F2.
2. The editor will appear, display all the fields belonging to the selected item or node.
3. Make your changes.
4. Select commit now to save the changes you made. If you want to revert to the original data, select revert.
If you are using the docked editor, your changes will be saved automatically when you change the selection.

7.4.1. User data
You might have noticed the editor has a tab page called user data. The user data editor allows you define and edit
your own custom data on each selected item. For example, we can add numerical frequency fields to barrier
effectiveness.
Custom data is defined per object type. If we define a field called 'Frequency' on any effectiveness value, that field is
immediately available on all effectiveness values.

Figure 60 - User data editor
The "Add Key" button allows us to define an extra field on a type. Once we define a new key name on a type, e.g.
barriers, each barrier will now have this field.
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The delete key removes a field. Note that this will remove whatever is filled in on any object of the same type.
The rename key allows you to change a key name.

7.4.2. Links
Apart from the tabs called “Editor” and “User Data”, there are a number of other tabs as well, depending on your
selection. These tabs are to edit the items linked / assigned such as document links.

Figure 61 - Link assignment tab in the popup editor
The left hand side shows all the items which can be linked to the barrier. The right hand side shows all the entities
already assigned. To move items between the two sides, you can select them and press the relevant arrow icon
between the two halves of the screen. You can also drag and drop items between the two halves.
Items which are drawn in gray have already been assigned / moved to the right hand side.
You can filter the items shown by typing information into the filters. You can also sort on each column by clicking
the headers.
You can also create a new item by clicking the “create new” button. This will allow you to add a new item to the
item currently selected in the left hand pane.

7.5. The diagram
The diagram window is where you create your bowtie diagram. When you select a hazard or one of its sub items in
the treeview window, the diagram associated with that hazard will appear in the diagram window. The item you
clicked in the treeview will be selected in the diagram.
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Figure 62 - The diagram window
When you move the mouse over the various shapes, some icons will appear and disappear:

The green plus button allows you to add new items such as threats, consequences, barriers and escalation factors.

The deck of items icon (left screenshot above) allows you to edit all barriers with the same name – same barrier
group (Advanced only). This icon has an orange color when barriers in the same group have differences in property
values. The link icon on document links (right screenshot above) will open the link in the appropriate program.
The eye icon will allow you to adjust display options relating to the item:

Page 62 of 263

Along the top of the diagram window is a button bar with shortcut options. Certain options on the button bar are
enabled depending on which part of the diagram you have selected. Some infrequently used buttons are hidden by
default. They can be added as described in section 6.9.2.

Figure 63 - The diagram window toolbars
Icon

Description
Zoom In
Zoom Out
Zoom 50%
Zoom 75%
Zoom 100%
Zoom To Fit Page

Use animations while collapse/expand bowtie elements
Enable/disable tooltips on shapes
Visually bundle barriers by a similar characteristic, i.e. barrier families (Advanced only)
Select diagram display profiles (Advanced only)
Configure profiles (Advanced only)
Configure display settings
Refresh/update diagram
Create a new bowtie diagram
Add action
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Copy diagram to clipboard
Save diagram as…

Note: there are several mouse and keyboard shortcuts to help you navigate and work with the Diagram
Window – see the table:
Shortcuts
Scroll wheel

Scroll vertically through the diagram.

SHIFT + scroll wheel

Allows you to scroll horizontally through the diagram.

CTRL + scroll wheel

Changes the zoom level.

Arrow keys

Scroll through the diagram.

CTRL + arrow keys

Scroll through the diagram per page.

Middle button

Brings up a scrolling caret similar to the one in Internet Explorer.

CTRL + clicking an element

Toggles selective visibility on and off.

Drag a rectangle with the right mouse
button

Zooms to that region.

Drag on the diagram with the left
mouse button

Scrolls the display.

7.5.1. Expand and collapse
All shapes on the diagram which have children have a small + or – symbol on the connection point where the links
to the children meet. This is similar to the + and – symbols in the Treeview, allowing you to collapse parts which you
do not want to see at the moment.
A faster way to quickly reduce the diagram in size is to use the expand and collapse level buttons, on the expand
and collapse levels toolbar:

Figure 64 - Expand and collapse levels toolbar
Icon

Description
Level 1: Show only the top event and hazard
Level 2: Show the top event, the hazard, threats and consequences
Level 3: Show the top event, the hazard, threats, consequences and barriers
The same as level 3 but also show the escalation factors
The same as level 4 but show escalation factor barriers too
Show all

When clicking on these buttons, by default only the bowtie diagram that is currently in view will show the desired
expansion state. To apply the desired expansion state to all of the bowties in the casefile you can hold down the
SHIFT key while clicking on a particular expand level button.
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7.5.2. Displaying more information
It is possible to present more details about the shapes on the diagram in a visual manner, leveraging the power of
this representation in various means:
1. By showing extra information in each shape, such as activities, document links, BRF codes.
2. By coloring shapes with the colors and patterns defined on various properties such as effectiveness,
barrier type, BTF code.
3. By showing the risk assessments of top events and consequences visually on the consequence and top
event shapes.
4. Many more.
If you want to adjust the display of a specific item, you can click the eye icon on the shape:

This will bring up a dialog which allows you to adjust the coloring and display of extra information.
All these settings are also available in the diagram display options dialog, along with some extra options. You can
bring this dialog up by selecting Diagram  Diagram Options:

Figure 65 - Diagram extra info options
In this dialog you can customize all aspects of how your diagram is rendered. All options are explained in detail in
chapter 8, Configuring the diagram on page 78.
You
can
also
color
barriers
Advanced functionality: Soob matrices on page 153.

by

Soob

category.

See

section

21,
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7.5.3. Fonts
It is also possible to change the typeface of the different shapes, either by modifying the default font settings for all
shapes, or by changing the fonts on specific shapes.
Use this to make important parts of your diagram stand out.

7.5.4. Filtering the diagram
In order to navigate around the diagram easier, and to tailor the display to your needs, there are a number of
different filters available for you to use.

Figure 66 - Diagram filter selection toolbar
Selection of the filter is done via the filter toolbar. Each filter is discussed below.

7.5.4.1. Selective visibility filter
You can use this feature to simplify your bowtie diagram temporarily. This is useful when for example you are
preparing a report and want to include subsets of diagrams in it.
With selective visibility, you can make single items (e.g. a barrier) or items and their children (e.g. a threat and its
associated barriers and escalation factors) invisible. There are three settings, accessible via the toolbar and the
menu:
Off – When you select this setting, all items become visible, but the selective visibility selection will be saved.
Edit - When you select this setting, the items you marked as invisible will be shown in gray in the bowtie diagram.
On - When you select this setting, all items marked as invisible will be removed from the diagram. A warning will be
displayed in the diagram window.
Reset – Reset your filter settings.
You can make items invisible by choosing the item, right clicking and selecting Selective Visibility  Mark as Hidden.
You can also make items invisible by clicking the item while holding down the ctrl key.

+

Figure 67 - Selective visibility filter toolbar
Icon

Description
Selective visibility off

Edit / show selective visibility

Selective visibility on
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Reset (all visible)
Make a snapshot to the clipboard with selective visibility switched on.

7.5.4.2. Advanced filter – in BowTieXP standard
The advanced filter shows only shapes on the diagram which have a reference of any form to the entities you have
selected. This is best explained by example:
Select the advanced filter as your filter. The entire diagram will disappear except for the top event and hazard.
Now, right click an activity in the Treeview, and choose “Add to Filter”: All the barriers which have links to the
chosen activity will now be displayed. This works not only for activities, but also for document links, job
descriptions, effectiveness values, for everything that can have any relation with a shape on the diagram.
You can also select items which do not have a value set, by adding the so-called 'null value' to the filter. In order to
do so, right click the lookup table instead of an entry, and select "Add to Diagram Filter".

+

Figure 68 - Advanced filter toolbar
Icon

Description

Clear

Clear the list of selected entities

Edit

Edit/show the list of selected entities

7.5.4.3. Advanced filter – In BowTieXP Advanced
The advanced filter, when running BowTieXP Advanced, is expanded with more options. It is a configurable filter,
allowing you to specify multiple criteria to which a shape must conform to remain visible.
For this example, open up the test case file and select the advanced filter from the filter drop down. After selecting
it, this toolbar will appear:

The clear button clears all criteria and the edit button allows us to change criteria. We will examine an example later
on which makes this distinction clearer.
Let’s press the edit button. The criteria edit dialog is popped up. You have to select ‘Add row’:
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The first drop down allows us to choose to filter on diagram shapes or linked elements. The second drop down list
allows us to pick the type of object we are looking for. Choose “critical”. The third drop down chooses on which
(text) part of the object we want to filter. Choose “Name”. The last drop down is how we want to compare this field.
Choose the “like” operator and this will allow us to search for a substring. Next enter the search text – enter “High
Critical”.

Press “x”. The diagram will be filtered to show only the barriers with a “High Critical” value assigned:

As you can see, some shapes are grayed out – this is because they do not actually match the filter, but an item
below it does. In this case we must show the left-hand side barrier as otherwise we could not see the barrier on the
escalation factor below it.

We can adjust the filter strength by clicking the arrows in this toolbar button:
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.

You can add as many criteria as needed. You can also specify how to join them – should items agree with all
criteria? Or is it good enough if an item agrees with a single criterion? This is the AND mode and OR mode radio
button at the top.

7.5.4.4. Incident filter
The incident filter allows you to filter the diagram down to all shapes which have relations with incidents.
Note: This is only available if you have both BowTieXP and IncidentXP. See chapter 29, IncidentXP and
BowTieXP together on page 233 for more information.

7.5.5. Audit filter
The audit filter will display audit information directly on the barriers in the bowtie. See chapter 24, AuditXP add-on
on page 179 for more detail.
Note: This is only available if you have both BowTieXP and AuditXP.

7.5.6. Exporting the diagram
The created diagrams can be exported by two means:
1.

By saving them to disk as a picture

2.

Copying them to the clipboard

and by
and pasting them into the destination application.

7.6. Overview window
In the overview window your entire bowtie diagram is displayed in miniature.

Figure 69 - The diagram overview window
As some diagrams can be very complex and large in scope, the overview window allows you to quickly navigate to a
particular section of your diagram.
Left-clicking and holding in this screen enables you to drag the green box around a part of the bowtie diagram.
When the mouse button is released, your selection is displayed in the diagram window.

7.7. The scrap book
Note: The scrapbook is advanced only functionality
BowTieXP advanced also offers the scrap book. It is a bit like a clipboard on steroids, but much more. It is a dockable
window that allows you to:




Copy entities there to keep them around for a while, and later drag them back into any case file (might be
a different one).
Drop data files (Excel, BowTieXP) and read the info on them into BowTieXP.
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Convert items from one type to another.
Items that can't be given a place within the current case file yet can be temporarily stored.
Store frequently used items - e.g. make a short list of frequently assigned activities.
Build a reference library of elements.

For details please see chapter 18, Advanced functionality: the scrap book on page 134.

7.8. Copy, cut, paste and paste special
BowTieXP of course offers copy and paste clipboard functionality which works as you would expect. BowTieXP
however, offers one extra clipboard feature not commonly seen – the paste special.
Paste special allows you to paste not an entire element, but a subset of their properties. After copying an item onto
the clipboard, you can right-click an item of the same type and select “Paste Special”:

Figure 70 - Paste special
In the example you can see you can selectively paste items over the selected barrier, ranging from text fields (such
as the description) to drop down items (such as effectiveness) to linked items (such as activities or document links).

7.9. Listview window
The listview window sums up underlying nodes of the selection you made in the treeview window.

Figure 71 - The listview
For example, when you click on activities, the listview will display a list of all activities.
The listview is useful for working with multiple items at the same time. For example, you could select multiple
activities all at once and drag and drop them onto a barrier in your diagram.
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There are multiple ways to select multiple items:

Click the first item you want to select. Then hold down the ctrl key and click other items you also want to
select. This allows you to select items one by one.

Click the first item you want to select. Then hold the shift key and click the last item in the group that you
want to select. This will select all items from the first to the last.

7.9.1. Exporting to Excel
In the upper right hand corner of the listview you may have noticed a small Excel icon. Click this and the contents of
the listview will be exported to Microsoft Excel.

7.9.2. Usage references / backlinks
The listview is also used for another important function: the display of backlinks.
When an activity is referenced on say, a barrier, there’s a virtual arrow pointing from the barrier to the location in
the treeview where the activity is defined. This arrow is called the link. We can also follow this arrow in the reverse
direction, from the activity to all the barriers where it is used. These are called the backlinks. The backlinks are all
the places where the item is used.
A similar concept applies to lookup table values. For each item we can find out where they are used by showing us
their backlinks.
This is done by right clicking the item of which you want to see where it is referenced, and selecting the option in
the context menu called “Show usage references”. The listview will show the usage references and indicate that it is
doing so.

7.10. Drag and drop
Through-out the application you can use drag and drop to assign links to objects. Almost every barrier which lists
linkable entities supports grabbing one of those and dragging it towards where you want to link it.
Drag and drop can also be used for creating and assigning document links. See section 3.11.3.1, Drag and drop on
page 28 for more details.

7.11. Treeview filtering
This feature allows you to remove seldom-used or unused elements from the treeview. You can define multiple
filters, allowing you to hide and show elements based on the task you are currently working on.
To create or modify treeview filter profiles, you open up the “Customize Treeview” dialog box under Case  Edit
Treeview Filter Profiles.

Figure 72 - Edit treeview filter profiles menu option
The “Customize Treeview” dialog is shown.
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Figure 73 - Customize treeview dialog
On the left hand side, the available profiles are shown and there are buttons to modify the list.
There’s always one profile present, the built-in profile which shows everything. This one cannot be modified.
After creating a new profile, you can expand the items on the right and deselect the items you do not want to see.
For example, if you don’t regularly use the lookup tables, you can deselect it. It is located under the “Top level item
visibility”.
You can also deselect collections under items, using the nodes under the “Sub-collection visibility” item. If you never
use objectives on your activities you can simply hide them.

Figure 74 - Treeview elements available for hiding
After clicking okay, your changes are saved. After defining a profile, you will now get a new drop down box on the
treeview which allows you to select your filter profile.
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Figure 75 - Treeview filter profile selection
After selecting your modified changes, they are immediately applied.

7.12. Risk matrices
Consequences (and top events) are assessed for their potential for harm in a given category and the chance of their
occurrence using risk matrices. Each case file contains up to eight risk matrices for this purpose, and they are fully
configurable.
Each matrix is used twice on each hazard: once for the inherent risk assessment, once for the residual risk
assessment.
Top events can also be assigned risk assessments.
When adding or editing a consequence or a top event, the risk matrices can be brought up to assess the
consequence by clicking on the appropriate button for each assessment.
Configuring of the risk matrices is done via the Case  Edit Risk Matrices menu option. When you select one of the
risk matrices out of the list, the risk matrix editor dialog box will appear.
Note: You can clear all risk assessments in the case file using the Case  Clear Risk Assessment options.

Figure 76 - Risk matrix editor
How to change the dimensions of the risk matrix: Right-click on the severity tables (vertical axis) or the frequency
labels (horizontal axis) and select the appropriate option.
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How to edit the categories: You can edit, add or delete categories anywhere on the risk matrix by right clicking
them.
Note: The risk matrix category order should be from low impact at the top to high impact on the bottom,
i.e. from green to red. The order is used to compare and sort items by risk score.
How to edit a cell label: right click the item and select the “Edit text” option.
Changing the risk assessment of a matrix position:
1. Select the risk category you wish to use in making changes to the diagram.
2. Then, select the position within the graphic representation that you wish to change.
For example, we want to change A1 from yellow – Incorporate Risk Reduction Measures – to green – No Impact. In
the graphic below, notice that the green risk category has been selected.

Figure 77 - Risk matrix editor with selected category
3.
4.
5.

Now select A1, the position you wish to change.
Once you select it, the category color will change.
Notice how in the graphic on the next page, the color of A1 changed from yellow to green once the new
risk category was selected.
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Figure 78 - Risk matrix editor with changed cell
By default, coordinates will first list the X value (horizontal, frequency) first followed by the Y value (vertical,
impact). In the screenshot above we see the coordinate of the selection is listed as A1. You can customize this by
clicking the XY button behind the “Display assessment code as”, and the order will be reversed.
You can also use custom labels for the coordinates.
Note: if you are not using some matrices, clear their name. This will make them disappear from the UI and
on reports.

7.13. Acceptance Criteria
It is possible to define general acceptance criteria for threat barriers, escalation factor barriers, consequence
barriers and barriers in general. These criteria can be accepted on each element. To give an example: acceptance
criteria for a barrier could say that there should at least be someone accountable for the barrier, and it should have
at least one activity. Threat criteria might say that a particular category of threats requires two different types of
barriers before it is acceptable whereas another category might only require one type.
To define acceptance criteria, edit a Bowtie Group and click the tabs next to Bowtie Group Name. The criteria are
described as free text.

To use the criteria, edit for instance a threat, at the bottom you will see two things. First, a “View Criteria” button,
which will give you a popup with the acceptance criteria text Second, an “Acceptance criteria have been met” tick
box. This will be ticked once the threat adheres to the criteria.
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In the quality checks (see section 7.15, Quality checks window on page 76), there are also several reports that will
list all the elements that do not yet meet the acceptance criteria.

7.14. Text find and replace
See chapter 9.4.1 Text find and replace on page 93.

7.15. Quality checks window
You can find the quality checks hidden on the right side of the diagram in the default layout.

Figure 79 - The quality checks window
The quality checks can display a number of different reports pertaining to the quality and completeness of the
bowtie case you are building.
From the drop-down box at the top of the window, select the report you want from the list. Once you have selected
a report, the window is populated with the results.
To refresh the list of items, click the button with the blue circular arrow.
If you select, for example, “Hazards where accountable has not been set” as shown in Figure 79, a list of all the
hazards where no responsible party has been assigned is displayed.
The quality checks are extremely helpful in identifying holes in your analysis.

7.16. Revision info
Each hazard has a revision info tab that can be used to display revision information on the bowtie diagram. Double
click a hazard, and go to the tab called revision info. As soon as you pick something from the “Revision Information
Box Alignment” dropdown, the revision info will be displayed on the diagram.
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Figure 80 - Revision info
The revision info will also be added to the diagram when exporting it as a picture.

Figure 81 - Revision info text box
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8

Configuring the diagram
In this chapter we explore how to configure the
diagram appearance.

BowTieXP has a diagram which is configurable in many ways – there are loads of options to tailor the display to your
needs. You can apply various colors and show all kinds of extra information. This chapter will explain all the various
settings.
Due to the large amount of settings, you can also configure those into profiles, allowing you to quickly switch
between predefined settings.

8.1. Changing settings for a single type of item
In the diagram, if your mouse is near or above an item, an eye-shaped icon will appear:

Figure 82 - Eye-shaped icon
If you click it, a dialog box will appear which allows you to customize the display of the item:

Figure 83 - Set element display dialog box
It lists all the fields which can be shown on the diagram as extra information boxes. This is done by selecting the
button on the S or L column. S stands for Short format and L stands for Long format.
You can also select which property is to be used to color the item – this is done by selecting the check box in the
color column. For example, if we select to show the acceptance criteria have been met, the threat looks as follows:
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Figure 84 - Acceptance criteria value shown on a threat
You can adjust the display for all items on the diagram. If you need to configure more than one item, you can also
use the large diagram display options dialog, discussed in the next section.

8.2. Changing all the settings
Modification of the current settings is done by clicking the eye-icon in the toolbar icon (
current display settings. Modifying these does not change any of the profiles.

). This brings up the

Figure 85 - Diagram display options – “Show”
This dialog consists of several tabs which allow you the change the appearance of the diagram.

8.2.1. Information to show / the “Show” tab
The first tab is about what texts to display, whether to display actions and risk assessments, and what extra
information to display.
The left hand side of this dialog barriers various settings:
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Figure 86 - Diagram display options - left hand side of "Show" tab







If and where to show the hazard code.
If and where to show the BowTie Group name.
Whether or not to show actions, and if so which ones – only the uncompleted or overdue ones?
If the risk assessments on consequences and hazards should be shown – if so, which ones? Or both?
If activities should be shown as separate boxes in the diagram.
Causation Descriptions refers to IncidentXP.

The right hand side barriers which extra information to show on the diagram shapes:

Figure 87 - Diagram display options - right hand side of "Show" tab
For each bit of information present on an item there are three options:

S for Short format

L for Long format

Off to not display the information
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Here’s an example of short format used on threats:

Figure 88 - Short format example

Here’s an example of long format used on threats:

Figure 89 - Long format example
Note: Properties will always have a box on the shape, but it might be empty if no value has been assigned.
Links (such as activities on barriers) will have one box per item – no extra boxes will appear if no items are
linked.

8.2.2. Colors to use / the “Colors” tab
The next tab is about how to color the shapes.
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Figure 90 - Diagram display options – “Colors”
In the left hand side of this page we can configure which color to give actions, and if we want colors to appear in the
extra info boxes (configured on the previous tab page).
In the right hand side of this page we can select which property to use to color the main shapes.
Here’s an example - select to color barriers by their effectiveness:

Figure 91 - Diagram display options - color barriers by effectiveness
And the shapes will change color:
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Figure 92 - Example of using barrier effectiveness for coloring
We can also show the effectiveness in an extra info box (select this on the first tab called “Show”).
Then we can enable colors on the extra info boxes and get this result:

Figure 93 - Example of showing barrier effectiveness as extra information (colored)
If some colors lead to bad readability, we can also choose to display the color only in the little box on the left hand
side. This can be done in the ‘extra info color location’, under the “colors” tab:

Figure 94 - Example of showing barrier effectiveness as extra information (colored as flag)

8.2.3. Fonts to use – the “Fonts” tab
The next tab allows us to set default fonts.
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Figure 95 - Diagram display options – “Fonts”
Click the button to bring up a font dialog. An example of the current font will be showed in the box.

8.2.4. Sizing and layout – the last tab
The final tab contains various options related to sizing and layout:
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Figure 96 - Diagram display options – “Sizing & Layout”
Dynamic sizing is the default but can sometimes look slightly messy due to the height difference from box to box. In
this case fixed sizing might look better.

Figure 97 - Default dynamic sizing
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Figure 98 - Fixed sizing with outside alignment
The connector line thickness can be adjusted.
If wanted, the threats and consequences can be aligned against the outside of the diagram.
Vertical diagram compaction can be switched off if it is causing problems.
The barrier color legend can be scaled down if needed.
All diagram element sizes and distances are editable under “Diagram Element Dimensions”.

8.3. Adjusting lookup colors
The colors used on the diagram are fully adjustable. They can be set using the editor in the treeview. For example,
to adjust effectiveness colors, we go into the treeview into the lookup tables node, into the effectiveness node,
where we double click the item we want to modify:

Figure 99 – Changing the effectiveness colors
In the editor we click on the “Choose” button to bring up the color picker dialog:
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Figure 100 - Color picker dialog

8.4. Adjusting lookup colors for unassigned values
The color used when no value has been assigned to a property can also be adjusted – Select Case -> Edit null value
colors in the menu. This will bring up the following dialog:

Figure 101 - Null value colors
Clicking an item will bring up the color picker dialog.
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9

Case file analysis
In this chapter we take a look at the different methods
for analyzing your case file.

9.1. Introduction
The end purpose of building a case file is of course to be able to analyze all the data and relations you have created
in order to gain better understanding and insight. This chapter focuses on all the different methods BowTieXP offers
for doing so.
We will discuss the case overview, searching information and relationship diagrams.

9.2. Case overview
You can find the case overview in the main menu: View Windows  Case Overview.
The case file overview presents many views onto the data in the case file from different perspectives (“overview”),
allowing visualization of relationships which might otherwise be less evident, and allowing you also to quickly
finding related data.

Figure 102 - The case overview
All output from each overview can be exported to Excel by means of the “Export to Excel” button.
The output is searchable by means of the “Expand by keywords” textbox along with the next and previous hit
buttons.
Also present are expand/collapse all buttons to reduce or increase the amount of on-screen information, as well as
a button to navigate to the definition of the selected node in the main Treeview.
When information in the case file changes the case file overview will update automatically. If, for some reason, you
want to rebuild the output you can do so with the “reset/reload” button.
Using the drop-down menu on the toolbar labeled Overview Perspectives, you can change the perspective.
The other two case overview toolbars are shown below.
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Figure 103 - The case overview toolbars
Icon

Description
Execute expand by keyword operation by means of the keywords entered into the text box
Go to previous keyword match
Go to next keyword match
Expand all
Collapse all
Go to definition in the treeview

Show relationship model of selected entity
Reset/reload
Export to Excel

9.2.1. Classic perspective
The classic perspective lists all bowtie groups, hazards, threats and consequences present in the current file along
with each consequence’s risk assessments. This overview is similar to a classic hazard register.

9.2.2. Management system perspective
Note: This perspective is available in BowTieXP advanced only.
The management system perspective lists all defined activities, similar to the treeview, but with some extra
deduced information.
For each activity, the associated barriers are listed, and for each barrier you can drill down to see the threat,
consequence, or escalation factor to which it belongs and you can keep drilling down all the way up to the
hazard/top event.
As each hazard has a hazard category, activities are associated with hazard categories via the barriers on which they
are linked. All the hazard categories that an activity is associated with in this manner will have an “x” cross-mark in
the hazard category column.
The responsible persons are also listed.
Activities which do not have any relation with barriers are shown in a gray font.

9.2.3. Systems and user systems perspective
Note: This perspective is available in BowTieXP advanced only.
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The systems and user systems perspective is similar to the management system perspective and lists where each
system is used.

9.2.4. Job titles perspective
This perspective lists all job titles present in the case file, and finds all activities and barriers where they are
referenced.
All barriers where an activity is referenced are also listed so you are able to drill down to all barriers which are
related to a given job title, starting from that job title.
Exporting this perspective yields a power overview of all barrier responsibilities per job title, which reveals
accountability for barriers and activities which support barriers.

9.2.5. Operations perspective
Note: This perspective is available in BowTieXP advanced only.
The operations perspective lists all the operations defined in the file and which hazards, threats and consequences
they are associated with. When a hazard is not directly associated with an operation but via one of its threats or
consequences, it will be printed in a gray font.

9.2.6. Incidents perspective
Note: This perspective is available only if you have IncidentXP and BowTieXP both.
The incidents perspective shows all the incidents in the file and finds and aggregates information pertaining to
those. It is a very powerful tool to analyze incidents individually, but also to analyze multiple incidents together.

9.2.7. Document links perspective
This perspective lists all document links defined in your case file and where they are used.

9.2.8. Barrier register perspective
This perspective finds all barriers defined within your case file and then counts the number of times each one
appears.
Barriers are matched by using the code and description fields. If these fields are identical on two different barriers,
BowTieXP will list them as the same barrier. You can then expand each node to display where these barriers exist in
your case file.

9.2.9. Threats register perspective
The threats register lists and aggregates all threats in the case file, shows the number of times they occur, and
where they are located.

9.2.10. Escalation factors register perspective
The escalation factor register lists and aggregates all escalation factors in the case file, shows the number of times
they occur, and where they are located.

9.2.11. Consequences register perspective
The consequences register lists and aggregates all consequences in the case file, shows the number of times they
occur, and where they are located.
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9.2.12. Actions perspective
This perspective finds all actions present in the case file and displays them in two groups: completed actions and
uncompleted actions.

9.3. Quality checks
The quality checks are also a valuable source of information about your case file. The quality checks window can
display a number of different reports pertaining to the quality and completeness of the bowtie case you are
building.
The quality checks window is extremely helpful in identifying holes in your analysis and finding locations where
more attention is needed.
For more details about the quality checks, please refer to section 7.15, Quality checks window on page 76.

9.4. Search box
In the top right of BowTieXP there is a search box to search for words or elements within the case file. It finds the
exact location of a term or string of text within your case file.
After entering your search term or search string, BowTieXP gives you exact details of where each match was found
in the results window, along with its name and the name of the field in which it was found.
In the results window there is multi-edit (with BowTieXP Advanced) and drag and drop support.
If you click on a result, BowTieXP will:
1. Navigate to the location in the treeview.
2. Navigate to the location in the diagram, if it is an element in a diagram.

Figure 104 - The text find window
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9.4.1. Text find and replace
You can also replace found values, either one at a time or all at once. To do this, click the arrow next to the search
icon (see Figure 105), and click the Text replace button at the bottom. Alternatively, go to Tools > Text Replace.

Figure 105: The Text replace button
Specify what to find, what to replace it with, and click Find. The search results will list all matches, and you can
replace values one at a time or all at once.

Figure 106: The Text replace dialog
Before doing a replace all operation it is prudent to at least do a cursory check of all the found items, although you
can of course always undo the operation.

9.5. Advanced functionality: relationship models
After building a complete case file, and adding all the relations, the relationship models allow you to analyze and
navigate these relations visually, offering greater insight into your data.
Accessing relationship diagrams is done via the context menu in the diagram or the treeview. When right-clicking an
entity for which a relationship diagram can be drawn, you’ll see the menu entry for the relationship diagrams
similar to the one shown below.
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Figure 107 - Relationship diagram menu
After selecting the desired relationship diagram, it will be shown as in the figure below.

Figure 108 - Example relationship diagram
In the relationship diagram you can navigate to another relation by clicking any shape with the left mouse button. A
menu will pop up allowing you to choose the relation to follow. For example, following the option highlighted in the
screenshot above, we will go to the diagram pictured below.
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Figure 109 - Example relationship diagram
Right clicking any shape allows you to go to the item’s definition in the treeview, go to another diagram, or to
remove the clicked item from the diagram for presentation purposes.
Toolbar buttons allow you to save the picture, copy it to the clipboard, and navigate between previously drawn
relationship diagrams.
The tables below list all the available relationship diagrams, grouped by the type on which they are available.
The following relationship diagrams are available when an activity has been selected:
Name

Description

Activity: Hazards.

All the hazards associated to the activity, via barriers, threats,
consequences and escalation Factors.

Activity: Hazards, including child Activities

Same as above, but also including the child activities.

The following relationship diagrams are available when a Hazard has been selected:
Name

Description

Hazard: Operations.

Collects all the operations linked on the hazard and its threats and
consequences and shows them with the hazard.

Hazard: Activities

All the activities associated to the hazard, via barriers, threats,
consequences and escalation factors.

Hazard: BRF Codes.

This gathers all used BRF codes on all barriers beneath a hazard (via
the threats, consequences etc.) and shows them.

Hazard: Job Titles (Hazard Accountable and
Barrier Accountable).

Collects all the job titles used as barrier accountable persons and as
hazard accountable persons and shows them together with the
hazard.

The following relationship diagrams are available when a threat has been selected:
Name

Description

Threat: Operations

All the operations associated with the threat.

The following relationship diagrams are available when a consequence has been selected:
Name

Description
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Consequence: Operations

All the operations associated with the consequence.

The following relationship diagrams are available when a job title has been selected:
Name

Description

Job Titles: Activities.

Finds all the activities where the given job title is used.

Job Titles: Barriers, Activities, Operations
and Hazards.

Collects all the activities, operations and hazards which are related
to the selected job title and draws a diagram.

Job Titles: Barriers.

Finds all the barriers where the given job title is used.

Job Titles: Operations.

Finds all the operations where the given job title is used.

Job Titles: Hazards, Operations.

Finds all the hazards and operations where the given job title is
used.

The following relationship diagrams are available when an operation has been selected:
Name

Description

Operation: Hazards

Shows all the hazards the given operation is related to.

Operation: Hazards, Threats and
Consequences

Shows all the hazards, threats and consequences the given
operation is related to.
See Figure 110 - Operation: hazards, threats and consequences for
an example.

Operation: Job Titles

Shows how the given operation is associated via hazards to job
titles.
See Figure 111 - Operation: job titles for an example.

Operation: Job Titles (Simple)

The same diagram as above but in a different format.
See Figure 112 - Operation: job titles (simple) for an example.

Operation: Soob Matrix
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Shows how the operation relates to a different one in a Soob matrix.

Figure 110 - Operation: hazards, threats and consequences
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Figure 111 - Operation: job titles
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Figure 112 - Operation: job titles (simple)

Figure 113 - Bowtie Chaining
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10

Linking to documentation
A lot of the information in a BowTieXP case file has
close relationship with documents already in existence.
This chapter shows how to refer to it from inside
BowTieXP.

10.1. Introduction
A lot of information present in a BowTieXP case file is about things which have already be documented elsewhere,
and in a lot of places in a case file you will want to refer to that information.
For example, when assigning an effectiveness value to a barrier, you will want to refer to MTBF analysis of that
barrier.
To solve this need, BowTieXP has document links. Document links are pointers to external documentation which
can be linked onto various elements within your case file. In this chapter we will see how we can make efficient use
of them.
Document links are defined in Document link groups as a hierarchy, and then linked onto the relevant items in the
rest of the case file.
To create a document link you can navigate to the document link groups container in the Treeview, right-click it and
select New Document Link Group. Give the group a name, like Operational procedures. Then right-click the group in
the Treeview and select New Document Link. A document link contains a code, a name, a description and a location.
The location defines where the actual document resides. In can be a URL or a file path.
After defining document links, they can be linked onto other elements by the usual methods of dragging and
dropping or using the links assignment screen.
When assigned they can be shown on the diagram, and quickly accesses by means of the “Open” button:

Figure 114 - Barrier showing documents links along with "open" button
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10.2. Using drag and drop from a web browser or a file explorer to
create and assign document links
You can directly drop a url or a file onto a bowtie element. BowTieXP will search through all document links to see if
the file or url is already known. If it is already known, the link is made.
If you drop an unknown file or url onto an item, BowTieXP will pop up the editor and ask you to fill out some details.
When you press ok, the new document link is added to the list of document links and the link is made.

10.3. Using relative paths for document links
If you locate the documents you will be linking to next to the btf file, BowTieXP will create document links with
relative paths. If you copy all the documents along with your btf file, you will be able to open them anywhere.
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11

Bowtie chaining

Sometimes you need to analyze the consequences of
your consequences in your bowtie diagram. Or the
threats of your bowtie threats. This is possible with
Bowtie chaining.

11.1. Chaining threats/consequences with top events
The software allows you to chain two or more bowties together. Chaining is done between threats/consequences
and top events. So a threat or consequence in diagram X will be a top event in diagram Y.
Before you chain the bowtie diagrams you have to create all the bowties that you want to chain.
On a threat or consequence (diagram X), there is an Equivalent Top Event dropdown. This is where you select the
top event that is the same as that threat/consequence (diagram Y):

Figure 115 - Equivalent top event drop down
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11.2. Displaying and navigating chained bowties
In the display options, on the show tab, tick the bottom left two boxes under Equivalent Top Event:

Figure 116 - Diagram display options - Equivalent top event
On the bowtie diagram small top events will appear next to the chained threat or consequence.
Hover over one of the new top event shapes and you’ll see a little green button in the bottom right corner. Click it
to switch to the chained bowtie diagram.

Figure 117 - Chained bowtie "Go to-button”

11.2.1. Bowtie chaining relationship model
Note: Relationship models are only available in BowTieXP advanced.
It is also possible to show the relation between the chained bowtie diagrams in a relationship model. Right click on
the chained top event and chose Draw relationship model  BowTie chaining.
For an extensive explanation about relationship models, see Chapter 5.3.3, Relationship models / diagrams on page
40.
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Figure 118 - Draw relationship model - Bowtie Chaining
You can decide whether to display threats and consequences or only top events by clicking on these two buttons in
the toolbar:

.

Figure 119 - Relationship model - Bowtie chaining (no threats/consequences)
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Figure 120 - Relationship model - Bowtie chaining (including threats/consequences)

11.3. Chaining barriers to other bowtie diagrams
Barriers can also have an equivalent top event. Chaining barriers to top events is especially useful when the barrier
has many escalation factors linked to it. These escalation factors will become threats in the chained bowtie diagram.
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12

Getting data into BowTieXP
In this chapter we examine the various ways to get data
into BowTieXP.

12.1. Introduction
BowTieXP offers various mechanisms to import different kinds of data into your case files. In this chapter we will
examine these.
We will see how to import parts of other BowTieXP case files and how to import information from Microsoft Excel
and tab- and comma-delimited files.

12.2. Importing entities from other BowTieXP case files
It is possible to import diagrams from other BowTieXP case files using the File  Import Entities. After choosing the
file you want to import from, the entity selection screen is brought up.

12.2.1. Importing entities with BowTieXP standard
If you have BowTieXP standard edition, the entity selection screen will look as pictured below:

Figure 121 - Import entities window
By checking the checkboxes to the right of the listed entities they are selected for importing.
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NOTE: You can right click items and choose to select the item and all its children. This is useful if e.g. you
want to import all activities.
Once your selection is complete, you can press OK to start the import. Now the screen will change and the results of
the import operation will be shown:

Figure 122 - Import entities results
Review all the results to ensure the import operation was done as you intended. Note that if the results are not as
wanted, you can undo the entire import operation by pressing undo.
Note: Referenced information is not imported – e.g. activities linked to barriers will not be imported and
e.g. effectiveness of a barrier will also not be imported.

12.2.2. Importing entities with BowTieXP advanced
This is similar to the import as described above, except for three important differences:

Reference information can also be selected for import.

Lookup table values are resolved/will be assigned on the imported data.

Linked entities such as activities will be resolved / the links will also be imported.
Let’s clarify with an example – say I’d want to import a hazard with some threats and barriers, and on those barriers
we have linked activities and assigned effectiveness values.
Using BowTieXP standard, we’d import just the hazard, threats and barriers, nothing more. The barriers would not
have any activities assigned and the effectiveness values would all be set to “No Value Assigned”.
With BowTieXP Advanced, BowTieXP will try to resolve those items using the data already present in your target
file. This is done by looking for entities with the same name in the Treeview – to resolve an effectiveness value
“Good”, BowTieXP will look through all effectiveness values in the target file for one named “Good”. If it is found, it
is used.
For the activities the same process would be done – all the activities in the target file will be searched for one with
the exact same name as it appears in the Treeview. If one is found, that one will be assigned.
The results of this search will be displayed after the import is complete. See below for an example.

Page 108 of 263

Figure 123 - Import errors
As you can see, some barrier types and activities were not found in the target file.

12.2.3. Copying entities from one file to another using the clipboard
In BowTieXP advanced, you can also copy information from one file to another.
Note that resolving linked information such as activities on barriers, or effectiveness values on barriers, is done in
the same manner as in the entity importer described in the previous section. You can see the unresolved references
by clicking on the “Show Clipboard Import Errors” button on the main toolbar, or by means of the menu option Edit
 Show Clipboard Import Errors.
Let’s clarify this with a small example:
1. Start BowTieXP and open the test case file.
2. Start BowTieXP again and create a new file.
3. Notice that there are two BowTieXP windows in your taskbar.

Figure 124 - Two BowTieXP windows in the taskbar
4.
5.

Switch to the test case file and copy an activity to the clipboard.
Switch to the blank case file and note that the clipboard import errors button is enabled. It is the small
clipboard icon with an exclamation mark over it (

).
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Figure 125 - Clipboard import errors button
6.

Click it to display the errors.

Figure 126 - Clipboard import errors
7.

Paste the activity into the activities container in the treeview.

12.3. Importing data from Excel
Chances are that you already have a lot of reference information lying around and you would of course like to
import it into the case file you are working on. Importing between BowTieXP case files is possible with all editions of
BowTieXP, but for importing from e.g. Excel, you need the import external data function offered in BowTieXP
Advanced.
Data can be imported from Microsoft Excel, comma separated values, tab-delimited values and xml files.
To start the import, select File  Import External Data. The import external data dialog box is displayed.

Figure 127 - Import external data dialog
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You first need to select the type of data you want to import. The expected layout of the file is shown in the yellow
text area. For example, if you want to import effectiveness levels, the description would read:
“Records/rows with 2 fields/columns named: ‘Code’, ‘Description’ ”.
Our Excel sheet would have to look like this:

Figure 128 - Sample Excel file for importing
Note that formatting is ignored in the import, so we are able to give the code and description column headers some
color.
After selecting the type of data to import and reviewing if our input data is in the correct format, we can select the
file we want to import by clicking the “…” button to open a file selection dialog box.
After selecting the file, we can optionally choose the worksheet we want to import.
Next we are offered the choice if we want to skip existing records, or add them all.
When ready to import click the “Import data” button. The import will begin and progress will be shown in the black
status area. We need to review this to see if any errors occurred.
When importing hierarchical data, BowTieXP automatically recreates the multi-level structure based on the code
field. When adding e.g. the following activities:
A1, A2, A1.1, A1.2, A1.3 and A2.1
BowTieXP will detect and create, based on the separator characters, the following structure:




A1
o
o
o

A1.1
A1.2
A1.3

o

A2.1

A2

If after import, you detect any errors you want to correct, you can press the undo button to undo the entire import.

12.4. Importing data using the scrap book
The scrap book also offers many options for bringing information into your case file, either from an Excel file or
from other case files.
The scrap book is the ideal solution if you need to import parts of a case file where you will use them to build
diagrams / add in the hierarchical information – you import all the elements and then quickly build diagrams using
drag and drop.
For full details please refer to chapter 18, Advanced functionality: the scrap book on page 134.
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13

Getting data out of BowTieXP
In this chapter we take a look at the myriad of methods
to generate information for creating reports.

13.1. Introduction
Putting information into case files is nice, but it is even better to get all the information out of the case files in
various perspectives and formats.
In this chapter we take a look at the different methods for outputting information.
We will look at:

The output of the various reports,

How to use the case file overview to generate output,

How to use the quality checks for reporting,

How to use the listview for this,

And how to use the diagram and the diagram barrier color legend.

13.2. Reporting
You can report information in a case file in various ways using BowTieXP’s built-in reporting engine. Depending on
the chosen report, the format will either be Microsoft Word (rtf) or Microsoft Excel.

13.2.1. Generating a report
Follow these steps to generate a report:
1.
2.
3.

Select Tools  Reports from the drop-down menu.
Click on the desired report.
When you select a report, it’s automatically opened in Word or Excel.

You can then save the report under a name of your choosing.
Some reports are also available from the context menu. Notable ones include the barrier overview report, which
can be accessed by right clicking a barrier, the job title overview report on a job title and the document links
overview on a document link.

13.2.2. BowTieXP reports
In this section we present an overview of all the reports available to you. Depending on the report you choose, you
may be asked to provide additional information before the report can be generated.
Actions





Actions in XL
Actions in BowTie context
Actions in BowTie context, condensed version
Actions of a selection of Hazards
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All Actions
Actions by Action party
Actions by Priority and Action party
Actions of a specific Action party

Activities















List of Activities with Barrier context
Activities grouped by Activity Responsible
Activities grouped by Activities.Responsible of a single Hazard (Alt Format)
Activities grouped by Activities.Responsible of a single Hazard
Activities grouped by Hazard and Activities.Responsible (Alt Format)
Activities grouped by Hazard and Activities.Responsible
Activities by single Activity Responsible
All Activities
(Advanced Only) Activities linked to Barriers as hierarchical list
(Advanced Only) Activities linked to Barriers as hierarchical list - Filtered
Activities linked to Barriers ordered by Activity tree order.
(Advanced Only) Activities of a specific Operation grouped by Activity.Responsible (Short version)
(Advanced Only) Activities of a specific Operation grouped by Activity.Responsible (Long version)
Activities Responsible context overview

Audits








(AuditXP Only) Create empty Survey fill out forms
(AuditXP Only) Individual Fill Outs
(AuditXP Only) Question Overview
(AuditXP Only) Questions linked to specific Hazards
(AuditXP Only) Survey results
(AuditXP Only) Survey results as follow up, quantitative version
(AuditXP Only) Survey results shown on Barriers

Barrier Types

Barrier Type count of a Bowtie Group
Barriers









Barrier Organizational Unit Performance
Barrier overview report
Flat Barrier register with customizable columns
Barriers register with Activities
Barriers by Hazard summary sheets
Barrier register
Barrier Accountable context overview
Barrier Accountable context overview of a specific Hazard

Competencies

(Advanced Only) Required Competencies for a specific Operation, grouped by Activity.Responsible
Document Links

List of Document Links with Barrier context

Traditional Hazard register showing Document Links
Escalation Factors

Escalation Factors sorted by Barrier Type

Escalation Factors with Barriers of type...

Escalation Factors without Barriers
Hazards






BowTie Chaining
BowTie Diagrams
Register
Report of all Hazards – Work sheet
Cut-out Diagrams

Page 114 of 263








Register with Activities, Document Links and Systems
(Advanced Only) Traditional Hazard register
Report of a specific Hazard, long version
Report of all Hazards
Short summary list of Hazards
Report of a specific Hazard

IADC HSE Case Guidelines

(Advanced Only) Hazard register complete

(Advanced Only) Hazard register without Activities
Incident Diagram

(IncidentXP Only) Incident Timeline Event grid

(IncidentXP Only) Incident from template

(IncidentXP Only) Timeline Events

(IncidentXP Only) Report on all Incident Barriers
Incident Diagrams Bscat

(IncidentXP BSCAT Only) Barriers linked to Incidents
Incident Diagrams RCA

(IncidentXP RCA Only) RCA Event Category profile
Incident Diagrams Tripod

(IncidentXP Tripod Beta Only) BRF Code profile
Job Titles

Job Title count per Hazard

Job Title Overview
Lists













(IncidentXP RCA Only) RCA Event Categories
(IncidentXP BFA Only) BFA Lists
(IncidentXP Tripod Beta Only) Tripod category lists
(IncidentXP BSCAT Only) BSCAT lists
(Advanced Only) BowTie register report for data export
Barriers
Document Links
Activities
Competencies
Job Titles
Systems
Threats and Consequences

Operations

(Advanced Only) Operations overview
Other





(Advanced Only) BowTie report from template
Color Legends
Report on Barrier BRF Codes
Contents of Case File overview

Risk Assessment

Aggregated Top event Risk Assessments

Aggregated Risk Assessments

Aggregated Consequence Risk Assessments

Consequences ordered by Risk Assessment

Report Risk Assessment Matrices
Systems

Page 115 of 263





(Advanced Only) Systems linked to Barriers
Barrier Systems Register
Systems linked to Barriers Ordered by System lookup table order

13.2.3. Report from template
It is possible to define a company template report, complete with logos, fonts and other styling and fill that with
information from a bowtie file, using tags that are inserted into the template.
To create a custom template, follow these steps:
1. Open Word (for this example, we’ll use Word 2013).
2. Go to File > Options > Customize Ribbon.
3. Make sure the “Developer” option is ticked in the Main Tabs section.

Figure 129 - Microsoft Word - Customize Ribbon
4.

Open the Developer tab. You can add fields with the “Aa” icon. The tooltip describes it as a “Plain Text
Content Control”.

Figure 130 - Microsoft Word - Plain Text Content Control
5.

The field will look like this:
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Figure 131 - Microsoft Word - Plain Text Content Control (2)
6.

To make sure the field gets filled with the right data, select the field and click “Properties” in the ribbon.

Figure 132 - Microsoft Word – Content Control Properties
7.

In the “Tag” field you can insert one of the tags that are available (see Table below). If you want to see
these tags in the document, you have to turn on the “Design Mode”.
Available tags:

BowTie.HazardRegister

BowTie.BarrierRegister

BowTie.AllDiagrams

BowTie.Actions

BowTie.JobTitles

BowTie.Activities

BowTie.DocumentLinks

BowTie.Systems

BowTie.ThreatsAndConsequences

BowTie.ActivitySummaries

BowTie.BarrierSummaries
Add the tags to the Content Control Properties:

Figure 133 - Microsoft Word – Content Control Properties (2)
8.
9.

Save your template and close Word. You cannot run the report while it’s opened in Word.
In BowTieXP, go to Tools > Reports > Other > BowTie report from template.
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Figure 134 - BowTie report from template

Figure 135 - Selecting reporting template
10. Make sure “Use built-in template” is deselected and click “Browse” to select your template.
11. Click OK to run the report.
You can edit and change the report, then update the tags by selecting the same word file again (step 9). All fields
will then be updated, without changing the information around it.

13.3. Export to Excel button
In various places across the software, there is an excel button that exports that particular view to excel. Here is a list
of all the places where that button is used.

13.3.1. Exporting the treeview
The treeview can be used to export lists of objects to Excel - by clicking the little Excel icon in the top right corner of
the treeview, all contents are exported to Excel. Note that the current expand/collapse state is taken into account.
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13.3.2. Exporting a case file overview
The case file overview, discussed in section 9.2, Case overview on page 89, offers many views on the different
relations in your data. These views can serve as excellent material to create reports on, by exporting the contents to
Excel.

13.3.3. Exporting a quality check list
Similar to the case file overview, the quality checks (discussed in section 9.3, Quality checks on page 92) also offers
various lists which can be exported to Excel and serve as a basis for reports.

13.3.4. Exporting the listview
The listview can be used to export lists of objects to Excel as well – for example, to create a list of all job titles, you
can select the job titles container in the treeview: the listview will show all the job titles contained in it. This list can
be exported to Excel by clicking the Excel button. Please refer to section 7.9.1, Exporting to Excel on page 71 for
more details.

13.3.5. Exporting case file comparison
A case file compare can be exported by using the export to excel button in the middle of the results window. Go to
Files > Compare Case Files and run a comparison to see the button in the middle that will export the compare
results to excel. Results can also be exported in a list format by going to the Script view tab and clicking the export
button there.

13.4. Exporting the diagrams
The main diagram as well as the relationship diagrams can also be exported to various applications. There are three
exports to choose from:

Save diagram as: this will export the diagram as a bitmap, such as .png or .jpg.

Copy diagram to clipboard: this will copy the diagram to the clipboard as an .emf.

Export to Visio: this will output the bowtie diagram as a .vsd Visio drawing. Note that this export will only
export the basic diagram, and does not include any extra info. Also not all of the shapes are supported. A
valid Visio 2002 or higher a requirement to use this export. Internally BowTieXP uses a Visio 2002 stencil
to export its diagram to. Make sure that your Microsoft Office Trust Center settings allow accepting and
opening Visio 2002 stencil types.
Copy diagram to clipboard is available from the toolbar as a clipboard icon
going to the diagram menu.

. All three options are available by

The size of the export can be controlled by going to Tools > Options > Miscellaneous and adjusting the Size increase
factor. The factor can be between 1 and 4.
Note that you can customize the view of the diagram for exporting by means of the selective visibility filter. See
section 7.5.4.1, Selective visibility filter on page 66 for details.

13.5. Exporting the color legend
If you are using colors on the diagram shapes, you can also copy the diagram color legend to the clipboard. Make
sure you can see the legend. If it isn’t showing, you can display it by means of View  Windows  Color Legend.
When the legend is visible, click on the copy to clipboard button

.
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Figure 136 – Exporting the color legend

13.6. Printing
There are two main ways of printing a bowtie diagram with BowTieXP. In this chapter, we’ll discuss both methods,
along with the advantages and disadvantages of each.
The standard printing functionality in BowTieXP can be found in the File menu. It is good to use for quickly printing a
diagram. For more printing options, see Chapter 13.6.2, Printing with Copy to clipboard on page 122. Copy to
clipboard has several advantages over the basic printing functionality.

13.6.1. Printing from File menu
To print a BowTie diagram, go to File > Print. This will print the diagram you have currently selected.

Figure 137- Print in the File menu
The print dialog is basic and should look familiar to other application. It allows you to select a printer, the print
range, the number of copies and printer specific properties before clicking OK to print.
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13.6.1.1. Print setup
There are several options for printing the diagrams in Print Setup. It is possible to shrink the diagrams to a single
page, center the diagrams and set a zoom level.

Figure 138 - Print setup

13.6.1.2. Page setup
It can be convenient to control the size and orientation of the paper to print on, so BowTieXP can optimize the size
of the BowTies. This can be controlled in the Page setup window.

Figure 139 - Page setup

13.6.1.3. Print preview
The print preview allows you to see what will be printed. Clicking 1,2,4,6,9 or 12 Print preview When ‘shrink to fit
page’ has not been selected in the print setup, will arrange all pages so it is possible to see the end result when
printing across multiple pages.
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Figure 140 - Print preview

13.6.2. Printing with Copy to clipboard
You can find the Copy to clipboard button in the toolbar:

Figure 141 - Copy to clipboard button in toolbar
If higher quality export is required, it is possible to increase the resolution of the diagram that is copied to the
clipboard. Go to Tools > Options > Miscellaneous. There is an option to increase the size of exported diagrams (see
Figure 142 - Change size of diagram for copy to clipboard). The default value is 1, but it can be increased to a
maximum of 4.

Figure 142 - Change size of diagram for copy to clipboard
Paste in PowerPoint, Word or any graphical program of your choice.
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14

Working with templates
BowTieXP contains a file template mechanism which
allows you to distribute templates for new case files.
This chapter explores this functionality.

14.1. Introduction
Basically every file you create using BowTieXP can be used as a template to create new files from. All that’s needed
is to place your template file in the right directory and the next time you want to create a new file, BowTieXP will
ask you if you want to base it on any of the available templates.

Figure 143 - Choosing a template
In the example above, we see that we can create a new file based on either the built-in “NewCase” template, or
based on our own “Governors Corporate Template”.

14.2. Creating a template
In order to create a template we first have to create a case file containing all the information we want. The most
important things are:

Lookup table values, notably the effectiveness values, barrier types, systems,

The activities hierarchy as defined in our organization, including other important related info such as the
job titles, activity categories,

The risk matrices,

Treeview filter profiles,

Custom terminology.
If you plan on using Soob, you’ll want to set up the operations and related tables located under the “Operations and
Risks” node.
If you plan to use document links, setting those up in the right hierarchy is important.
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Some organizations also work with reference bow-ties or have dedicated lists of hazards and top events. Such
reference information is bet put into a separate bowtie group, named e.g. “Reference Hazards”.

14.3. Installing a template
After creation of the file is complete, you’ll need to get it into the templates directory. The easiest way to do this is
to select FileSave a Copy as a Template.
You can also place files in the template directory manually: Click the HelpGo to Templates directory to open the
directory in Windows Explorer.
Place your file in the templates directory and it will be available next time you want to create a new case file.

14.4. Deploying templates along with the exe
You can also place the btf files in a directory called ”Templates” located next to the executable. They will be
automatically picked up and built-in templates will be automatically hidden.
This is handy for system administrators who want to deploy a template along with the software.

14.5. Downloading templates from a central location/repository
Apart from manually putting files in the template directory, you can also configure BowTieXP to automatically
download them from a central location and place them there for you.
BowTieXP can handle the following location types:

Normal file paths (drive letter, path and filename like Z:\path\to\file.btf)

UNC paths (network paths like \\servername\sharename\path\to\file.btf)

http or https urls (www locations)
Note: BowTieXP supports username and password embedded in the url.
Example: http://user:password@site.com/
Please be aware that these will be stored unencrypted on disk.
Adding and modifying the entries is pretty self-explanatory: Open the template configuration by going to Tools 
Options  System  Templates. Right click the listview and choose the appropriate option such add, edit, remove,
etc.
To test the downloading, click “Update Templates”. To force an update, click “Refetch All Templates”.
Note: normally templates are not removed from the local template folder, except when clicking refetch
all. This will delete manually added templates!
The interval between checking for updated templates is customizable. Granularity is in days.

14.6. Hiding built-in templates
Normally the built-in case file is displayed too. Some companies may want to hide this to ensure the corporate
template is used and the built-in template isn’t accidentally chosen.
This can be accomplished by means of unchecking the “Use built in new case files templates too” checkmark.

14.7. Filtering on language
BowTieXP supports multiple languages, and because of this there’s a new case file template built into BowTieXP for
each supported language. Normally you will only see the one for the current language. If you would like to see them
all, you can uncheck the “Filter out known languages” checkbox. This will show all the available templates.
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This mechanism also works for your template files. If you want to work with templates in multiple languages, you
can use this mechanism. BowTieXP detects in which language a template file is by means of the filename. If you
format your filename correctly BowTieXP will pick up on it.
The format for the filename is:
Filename.LanguageCode.btf
The language code is separated from the filename by a period (‘.’). Language codes supported in BowTieXP at the
current time are:
Language Code
de
en
es
fr
ja
ko
nb-NO
nl
pt-BR
ro
zh-CHS

Language
German
English
Spanish
French
Japanese
Korean
Norwegian (Bokmal)
Dutch
Portuguese (Brazilian)
Romanian
Chinese (simplified)

Figure 144 - All localized templates
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15

Overview of fields and purposes

This chapter highlights some of the commonly used
data fields and their purposes.

15.1. Introduction
BowTieXP contains a large range of functionality and therefore also has a large range of fields. Although most data
fields can be renamed and customized to fit any need, the fields come with default names and are there with an
intended purpose. In this chapter, some of the more commonly used fields are listed and their intended purpose is
described.
The grey background indicates that this field is mainly used or best used with BowTieServer. More
information about those fields can therefore be found in the BowTieServer manual.

15.2. Common fields on most elements
Name of field

Intended purpose

Examples and references

User data

Allows the user to create new
fields. Can be displayed on diagram
but not many reports use this info.

Costs: $10000, Note: Was edited
because…

Document Links

Link documentation to the element
as a hyperlink.

Link procedure.pdf, or link
incident.png. Also see section 10.

Description fields (with popup box)

Describe the element in more
detail. Supports markdown
formatting which is particularly
powerful with BowTieServer.

For more information about
attachments in description fields,
please refer to the BowTieServer
manual

15.3. Fields on BowTie Groups
Name of field

Intended purpose

Examples and references

Acceptance Criteria

Define company criteria on how to
correctly define a bowtie element.
If the element complies with the
criteria, a box can be ticked.

“A threat must not be a barrier
failure. A Threat must lead directly
to the Top Event”.

Organizational Units

Identify a site or department for
which these BowTies are relevant.

Amsterdam, Paris, Drilling Rig A,
Refinery, Maintenance Hangar 12
etc. Also see section 23.2.

Attachments

Used to upload files and pictures so
they can be referred to in long
description fields.

For more information about
attachments in description fields,
please refer to the BowTieServer
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manual

15.4. Fields on Hazards / Top-Events
Name of field

Intended purpose

Examples and references

Affects

Taxonomy for Hazards

Safety, Environmental, Operational
etc.

Accountable

Manager of the BowTie

Pilot, engineering manager, etc.

Sign off

Workflow to indicate that a barrier has been
completed and approved

-

Revision info

Track how often the BowTie has been updated
and room for notes

-

Other

Indicate for which modules and processes the
BowTie is used.

-

Operations

Indicate for which operations the BowTie is
relevant. Used in SOOB matrices functionality.

See section 21.

Fields on Threats
Name of field

Intended purpose

Examples and references

Category

Taxonomy for Threats

Environmental, Mechanical etc.

Type

Taxonomy for Threats

High – low contribution etc.

Frequency

How often the Threat naturally occurs.

Daily, monthly, yearly etc.

Equivalent Top-Event

Used to link a precursor BowTie to the Threat.
Used for BowTie chaining

See section 11

Operations

Indicate for which operations this Threat can be
expected. Used in SOOB matrices.

See section 21.

15.5. Fields on Consequences
Name of field

Intended purpose

Examples and references

Category

Taxonomy for Consequences

Environmental, Assets etc.

Type

Taxonomy for Consequences

Major – Minor concern

Equivalent Top-Event

Used to link a post-BowTie to the Consequence.
Used for BowTie chaining

See section 11

Operations

Indicate for which operations the consequence
may be expected. Used in SOOB matrices

See section 21.

15.6. Fields on barriers
Name of field

Intended purpose

Examples and references

Family

Barriers with the same family name can be
bundled together with the bundling feature.

Fire suppression equipment, ANSP
functions, etc.
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Barrier Category

Taxonomy for barriers

Elimination, control, etc.

Barrier Type

Taxonomy for barriers

Behavioral, social technical etc.

Effectiveness

How effective the barrier is against the Threat /
Consequence

Very poor – Very good

Accountable

The person who manages the barrier and
ensures its effectiveness

Pilot, engineering manager, etc.

BRF Code

From the Tripod-Beta incident analysis
methodology

Design, Maintenance Management,
etc.

Criticality

How critical the barrier is for the operation

High, Standard

Equivalent Top Event

Used for BowTie chaining

See section 11

Performance

Used to set actual effectiveness values per
organizational unit.

London: very good, Amsterdam:
good etc.

Systems / User
Systems

Link collections to indicate that barrier are a
part of a collection or rely on certain systems.

Fire suppression systems,
evacuation plans, relies on
electricity, relies on radio contact.

Activities

More specific detailed tasks that need to be
executed in order for a barrier to be fully
functional

Perform maintenance on valve,
inspect valve, etc.

Questions

Used for AuditXP

See section 24

15.7. Fields on Escalation Factors
Name of field

Intended purpose

Examples and references

Category

Taxonomy for Esc. Factors

High – Low contribution

Type

Taxonomy for Esc. Factors

Environmental, Mechanical etc.
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16

Advanced Functionality:
Barrier Families
In this chapter we will visually bundle together barriers
that share a similar characteristic.

16.1. Introduction
When analyzing highly complex processes within an organization, the resulting BowTies can become quite large and
will have many different barriers on them. One way of keeping the overview is by using the barrier families function,
which visually bundles barriers together based on common characteristic that those barriers have in common. This
can be used to quickly get an overview of (amongst others) the distribution of barrier types and accountabilities
throughout a BowTie.

16.2. Bundling characteristics
When clicking the family grouping button on the toolbar, you can select on which characteristic the barrier will be
grouped. These characteristics can be assigned to barrier via the barrier editor.

Figure 145 - Barriers bundled by the Barrier Type characteristic using the barrier families button.
Most of these characteristics are the dropdown fields. However, the Family field is a free text field that has been
added for bundling purposes. Barriers can be bundled by family name as long as those barriers share the same
family name.
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Figure 146 - Family name bundling

16.3. Display options on groups
Once barriers are bundled, each individual bundle can be expanded by using the plus button that appears on top of
the group when you hover over it. Collapsing them can be done via the minus button that appears when hovering
over one of the expanded shapes.

Figure 147 - Splitting out barrier bundles
All bundles can be expanded or collapsed using the buttons on the toolbar that appear as soon as a bundling
characteristic is selected:

Figure 148 - Expand and collapse all bundles
The small number next to the bundle shape represent the number of barriers contained in that bundle.
A bundle shape does cannot contain any information on itself, it only displays the information of underlying shapes.
For example, when displaying effectiveness values under a barrier bundle, the effectivenesses of all the underlying
barriers will be listed underneath.

Figure 149 - Barrier bundle showing the effectiveness values of its barriers.
For consistency’s sake, barriers that are alone in a group will also be displayed as bundle with the name of
the barrier’s characteristic. By pressing the plus symbol, the original name will be shown as in other
groups.
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17

Advanced functionality: diagram
display profiles
In this chapter we show how to set up diagram display
profiles to quickly switch between modes.

17.1. Introduction
As the number of configurable display options has grown very large over the last years, and setting up the wanted
display can take quite some time, the diagram display profiles were introduced.
Each case file can hold a list of diagram display profiles, and you can easily switch between them using the profile
drop down box above the diagram:

Figure 150 - The diagram display profiles drop-down box
Note: it can be very handy to set up a profile per task – this allows you to progress with your work quickly.

17.2. Creating a profile
Due to the large number of settings, bundling these up into profiles saves a lot of time. To create a profile based on
the current configuration, take the following steps:
1.

Configure your diagram to your liking.

2.

Press the profile button (

) to bring up the profiles dialog box:
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Figure 151 - Diagram display profiles window
3.
4.

Right-click on the Case File, select New and type in a name to add a profile that will be available for all
BowTies in the case file.
Double click the new profile that was added to the list. This will bring up the actual profile:

Add advanced filter to profile

Figure 152 – Edit display profile
5.
6.
7.

Press the “Load settings from current view” button to load the current configuration into the profile.
You can further customize the profile, or optionally add a filter to it (see Figure 152 – Edit display profile).
To know more about how the filters work, see Chapter 7.5.4 - Filtering the diagram on page 66.
Click OK to close the dialog.

The new profile is now available to quickly switch to, and will be saved in your case file.
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An additional feature is to create profiles that are only accessible within a specific bowtie group. To add these,
instead of right-clicking the case file, right-click a bowtie group name to add a new profile. These profiles will only
be available for the bowties within that group. To move profiles around, you can simply use drag and drop.
It is also possible to select a profile that should be loaded automatically when the file is opened. This can be
convenient to make sure someone sees the data you want them to see. To select the profile that should be loaded
on start-up, right-click a profile and select Toggle Auto-load. The second column will indicate which profile is
currently set to auto-load.

17.3. Importing profiles from a different case file
Display profiles can also be imported from other case files using File -> Import entities.

Figure 153 - Importing diagram display profiles
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18

Advanced functionality: the scrap
book
In this chapter we examine the scrap book – use drag
and drop to build bowties, or build a library of
frequently used shapes.

18.1. Introduction
BowTieXP advanced also offers the scrap book. It is a dockable window that allows you to:







Copy entities there to keep them around for a while, and later drag them back into any case file (might be
a different one).
Drop data files (Excel, BowTieXP) and read the info on them into BowTieXP.
Convert items from one type to another.
Items that can't be given a place within the current case file yet can be temporarily stored.
Store frequently used items - e.g. make a short list of frequently assigned activities.

Items on the scrap book such as Bowtie Groups, Hazards and Consequences serve as templates. When you drag an
item from the scrap book onto a bowtie diagram, a copy is made which is placed in the case file.
Because the contents of the scrap book are independent from your case files, you can use it to build a library of
often-used templates.
You can also place reference information on the scrap book, such as activities or document links. When you drag
these items onto a shape in the diagram, you add a link to the corresponding reference item in the case file.

18.2. Displaying the scrap book
To view the scrap book, select View->Windows->Scrap book:

Figure 154 - Displaying the scrap book
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And the scrapbook will appear:

Figure 155 - The scrap book

18.3. Basic scrapbook operations
First open the test case file so we have a file to work with. You can do this by clicking File -> Open Test Case File.
Ensure you can see the barriers on the diagram.

18.3.1. Dragging a regular item onto the scrapbook
Select a barrier on the diagram by clicking it. Now drag it onto the scrap book. Dragging is done as follows: press ALT
on the keyboard, move the mouse over the item, press and hold down the mouse button, and move the mouse
until it is over the scrap book. Now release the mouse button and the ALT button.
Now there will be a copy of the barrier in the scrapbook.

Figure 156 - The scrapbook containing a single barrier
We can now drag the barrier back into the case file. For example, drag it back into the diagram but drop it on top
the first threat in the file labeled “Intoxicated driving”. The barrier gets added to the threat:
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Figure 157 - Duplicated barrier
You could say the scrap book is like the clipboard, except it remembers everything you copied onto it.
The barrier has been copied in its entirety – all properties, children and links have been copied. We can see what
extra information was below the barrier on the scrapbook if we click the little plus sign next to it:

Figure 158 - Barrier on the scrap book showing children
We see that an activity is linked to the barrier, as well as 3 questions (AuditXP feature).

18.3.2. Dragging a reference item onto the scrapbook
We cannot just drag diagram elements onto the scrap book, but also reference information (linkable items).
For this example first ensure we can see the assigned activities on the diagram. Open up the Diagram -> Display
Options dialog:
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Figure 159 - Opening the diagram display options
And then click the “S” radio button under Barrier -> Activities: Note the mouse position.

Figure 160 - Diagram display options dialog
Now we can see all the activities assigned to the barriers.
Open up the activities container in the treeview and drag an activity onto the scrap book. Now the scrap book looks
as follows:
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Figure 161 - Scrap book with a reference item on it
If we drag this item onto a barrier, we will assign the selected activity, just like if we dragged it from the treeview, or
used the links assignment screen.

18.4. Moving items between files
Now open a new file (File->New). The items on the scrapbook remain but their appearance has changed somewhat:

Figure 162 - Scrap book with unresolved links
The links are overlaid with a question mark. This is because the scrap book could not find an appropriate item in the
current case file – actually there are no activities or document links at all in the empty file we just created.
So what happens when we try to drag the barrier onto a diagram? Let’s find out.

18.4.1. Resolving errors and creation of reference information
After we drop the dragged item we are presented with the following dialog:
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Figure 163 - Resolve issues
The barrier is added to the diagram, and we get a popup informing us that:

The linked activity ‘SCA-07’ was created

A criticality “Crit Critical” was created

2 Job titles ‘MM Maintenance Manager’ and ‘VM Vehicle Manager’ were created

3 Questions were created
The scrap book actually also had a copy of all the reference information needed and has been so friendly to add that
as well to our case file.
This behavior might not always be wanted so it can be disabled – there are two toolbar buttons which control it:

The left one is for auto-fixing of lookups, the right one if for auto-fixing links.
You can also create the reference items manually – just drag them into the appropriate place in the treeview.

18.5. Organizing data in the scrapbook
Data in the scrapbook can be reordered by dragging it around. You can drop an item “into” another item so it
becomes a child / sub item.
You can create groups to hold items – press the new group toolbar button (
drop items into it.

) and enter a name. You can then

Nested groups are not supported.

18.5.1. Illegal combinations
When dragging items around you will see the scrapbook does not limit what you can place underneath what – all
kinds of illegal combinations are possible such as barriers under barriers.
The scrapbook will let you know if a combination is illegal by means of overlaying a red exclamation point on the
offending item, and a yellow exclamation point for all the higher levels – so at the top level you can also see
something is not in order:

Figure 164 - Scrapbook with illegal combination
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If an item is in error you cannot drop it anywhere. You must resolve the error first, either by removing or converting
the offending item.

18.6. Converting items
Let’s say we have made the following illegal combination:

Figure 165 - Scrapbook with illegal combination
We can resolve this error by means of conversion too – just right click an item to bring up the conversion menu:

Figure 166 - Scrapbook convert menu
During conversion all matching properties are kept and assigned, and everything else is placed in user data –
nothing is lost.
If we want to see all fields, and if they have been matched, we can right click an item and choose “view fields”. All
the matched items are in bold; the rest will be placed in user data.

18.7. Scrap book file management
When you exit BowTieXP the contents of the scrap book are saved and will be available the next time you start
BowTieXP. However not all scrap books are equally valuable – for instance if you are building a library of elements,
you probably want to make backups regularly.
You can save the contents of the scrap book using the save (

) button and load them using the open button (

). You can also load files by dragging them onto the scrap book.

18.8. Using the scrapbook to import data
You cannot just open bts (BowTieXP Scrap Book) files – you can also get items from Excel files.
They must have the following format:

The first row contains the column headings

Each row after that represents an item to import

The first column must be the item type and its heading must be “Entity”
Here’s an example:
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Figure 167 - Sample Excel sheet for importing into the scrap book
The first row (row 1) contains the column headings / property names. The first one is called “Entity” and describes
the type of each row.
The second and third column describe any hierarchical relationships. Any entity with an Id can be referenced as a
‘parent’ by another entity in the ParentId column. So for instance, a hazard with an Id of H1, can be referenced by a
threat by putting H1 in the ParentId column of the threat. This means that the threat belongs to that hazard. The
same can be done with barriers that belong to a threat.
The other columns are the fields/properties we want to fill. If a column is not applicable for a certain type just leave
it empty – for example, there’s no field called “Top Event” on barriers so we leave it empty.
Lookups such as effectiveness are resolved in the current case file.
So here’s what happens after we drop it onto the scrap book:

Figure 168 - Scrapbook after Excel import
Looks like we forgot to set the type for the fifth row – we can fix this easily, just right click the item and convert it to
a barrier.
We can drag the items onto a diagram to verify all columns have been imported successfully.
The scrap book enables easy graphically-oriented import of various data – it is for example a good method to import
data from LOPA analyses and reconstruct that information into bowties.

18.9. Dropping a BowTieXP case file (btf) onto the scrap book
To facilitate library building, you can also drop a BowTieXP case file onto the scrapbook. When you do so you will be
asked how you want the file to be handled:
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Figure 169 - Scrapbook btf file handling question
You can import the file whilst keeping the hierarchy, which yields the following:

Figure 170 - Scrapbook after hierarchical btf import
You can also split the file into a group for each type, which looks as follows:

Figure 171 - Scrapbook after 'exploded' btf import
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18.10. Toolbar button reference
Icon

Description
Open a scrapbook file, Excel file, CSV file or BowTieXP case file
Save the current scrapbook contents as
Show resolve errors/auto-create messages
Toggle auto-creation of lookups (e.g. effectiveness)
Toggle auto-creation of linkable items (e.g. activities)
Add a new group folder
Add a new item
Expand all
Collapse all
Expand to show illegal items

Search Text

Enter a text to expand by text
Execute expand by text
Delete selected item
Clear all items
Reload from disk

18.11. Icon reference
Overlay

Title

Meaning

Drag and drop behavior

Red exclamation

Item is not allowed in its current
location or it is a linkable that
conflicts with another item on that
level.

Drag and drop is only allowed within the
scrap book pane internally or externally with
the right mouse button (single item drag).

Yellow
exclamation

Item contains one or more items
that are invalid, in conflict or are
non-matched links.

Drag and drop is only allowed within the
scrap book pane internally or externally with
the right mouse button (single item drag).

Link sign

Item represents a valid link to a
linkable item within the current case
file.

Drag and drop works as expected.

Item represents a link, but there's
no matching item within the current

The item is considered as invalid. Drag and
drop is allowed within the scrap book pane

Yellow
mark

question
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case file.

18.12. Miscellaneous
Changes in the scrap book do not support undo-redo.
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internally, also the item can be dragged to
the BowTieXP treeview node that holds all
‘originals’. This will create the ‘original’.

19

Advanced functionality: comparing
files and parts of files
In this chapter we take a detailed look at the
comparison functionality.

19.1. Introduction
BowTieXP Advanced allows you to compare parts of case files or entire case files and analyze the differences
between them.
This is a very powerful tool which is often used in change tracking and compliance checking.
For example, some companies have centrally defined how reference information in case files should look, and have
built template files containing this information. Using the file comparison function it is trivially easy to figure out if a
case file is still in compliance with the template. The same goes for reference bow-ties.
Change tracking is done in the same way. If your company has a document management system, and the case files
are checked in on a regular interval, you can easily track the development of the case files by means of the case file
compare.

19.2. Starting a comparison
There are two different methods of comparing data.

19.2.1. Comparing using the context menu
The first method of comparing is by selecting parts of the currently open case file for comparison by right clicking in
the Treeview. This allows you to only compare data from the currently open case file.

Figure 172 - Marking part of a tree for comparison
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After selecting a branch for comparison, if we right click another place in the tree, and a comparison
makes sense (is possible), we will have the option of comparing against it:

Figure 173 - Comparing parts of a tree
After clicking, the comparison results are shown:

Figure 174 - Comparison results
More on interpreting these comparison results will follow in the next sections.

19.2.2. Comparing from the File menu
The second method of comparing is by means of the File  Compare Case Files menu entry. This allows you to
compare data in different case files.
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This menu option will bring up the comparison wizard.

Figure 175 - Comparing case files menu option
Note that you do not have to have a specific case file open – the comparison allows you to choose two files and will
not touch your current case file. You can also compare different parts of the current file against each other.

Figure 176 - Choosing what to compare
The treeview on the left lists all the bowtie groups and hazards in the currently open case file. We can add files to
this tree by one of the two browse buttons. The first button browses your computer and network; the second
button allows you to browse SharePoint sites.
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After we have loaded the files we want to compare, we have the choice of either comparing the entire files, or just
two bowtie groups or hazards.
Select the first item to compare and click the “->” arrow button. It will get listed on the right in the box titled
'Compare…'.
Select the item to compare it with and click the lower “->” arrow button. It will get listed on the right in the box
titled 'With'.
In the example below we are comparing two revisions of the same file, and comparing the entire case file:

Figure 177 - Two entire files marked for comparison
Note the following:

"Current (open) case file" is selected in the tree and listed on the right.

"version 2.btf" is selected and listed on the right as well.

The Compare button is enabled, signaling we can start the comparison.

19.3. Analyzing the comparison
Here are some of the results of comparing the test case file of BowTieXP 6.2 with a second version.
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Figure 178- File compare results
Items which are different between the two files are color-coded.
Apparently we changed a value in the barrier Emergency response plan and we deleted the barrier Emergency
response plan somewhere else in the bowtie. Also the bowtie group Mining is deleted.
We can also report all the changes in a textual format - see the second tab page called 'script view'. We can also
export the results to Excel (

).

19.4. Comparing Soob matrices
When comparing two full case files, which both contain Soob matrices, we are allowed to compare Soob matrices in
the left hand case file against those in the right hand case file.
First we need to choose a matrix in the left hand file which we want to compare to a matrix in the right hand file:
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Figure 179 - Choosing Soob matrices to compare
In this example the first file only contains one Soob matrix so the choice is easy. After clicking next, the chosen
matrices are compared and the results will be shown as pictured below.

Figure 180 - Soob matrix comparison
Interpreting these takes a bit of work but here we see that Operation D vs. Operation A used to be “Authorized to
Proceed” but has been changed to “Do Not Proceed”. The same applies for D vs. B.
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20

Advanced functionality: type and
property descriptions
In this chapter we take a look at the type and property
descriptions: how to customize your case file
terminology.

20.1. Introduction
Each case file contains a large table containing the names of all object types and their properties present within
BowTieXP. This allows customers to make slight adjustments to various names and allows them to tailor-fit the
software to their company.
To make this a bit clearer let’s take a look at an example: In a bowtie diagram, you have barriers in place to prevent
threats from causing the top event to occur. In some companies and industries, the barriers are referred to as
controls.
Another example is that controls have a property, called a responsible person. This determines the person who is
responsible for managing that the barrier operates as needed. However in some industries or companies, the term
responsible might not have the exact legal meaning that is needed, and the property might be renamed to
accountable.
Note & Warning: Because editing these descriptions can lead to unwanted consequences due to the
semantics of the terms which BowTieXP assumes, it is advisable to discuss your intended changes with
CGE – in this way you can be sure that your changes will have the desired impact.

20.2. Use in localized case files
The mechanism which allows these adjustments to be made also enables us to create a case file in a language other
than English. If you create a new case file in BowTieXP when running under a different language then English, the
terms in that file will be in the language BowTieXP is running in: If for example you are running BowTieXP in
Brazilian Portuguese, the entire case file including terms like Barrier/Control and Top Event will be in Brazilian
(“Controle” and “Evento Principal” respectively).
When you open this Brazilian case file in BowTieXP running in English, all these terms will still be in Brazilian. All the
contents of the case file will presumably also be in Brazilian of course.

20.3. How to modify type and property descriptions
This is done via the property descriptions screen. It is available under Case  Edit Property Descriptions:
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Figure 181 - The case menu
This brings up the following screen:

Figure 182 - Property descriptions screen
In this screen we can change all descriptions, plural descriptions, abbreviations and property names.
The text used to denote when no value has been assigned can also be changed using the Edit Null Value
Descriptions menu option in the Case menu. This brings up the following dialog box:

Figure 183 - The null value descriptions screen
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21

Advanced functionality: Soob
matrices
This chapter describes how to get up and running with
Summary of operation boundaries.

21.1. Introduction
This chapter is to help you get up and running quickly with the Summary of operation boundaries (Soob)
functionality in BowTieXP Advanced.
BowTieXP Advanced is designed to make it easy to quickly set up a Summary of operation boundaries matrix and to
manage large Soob matrices.
The design of this chapter is such that it will

Help you to get your Soob matrix setup quickly,

And will also allow you to find more detailed information in the following sections.

21.2. What are Soob matrices?
The Summary of operation boundaries is a record of operations used to determine under which circumstances extra
caution should be taken or work should no longer be allowed to proceed.
This is to help the decision process of whether to proceed with operations when encountering suboptimal
conditions. Suboptimal conditions can be many things, such as:

Doing several operations at the same time,

Some critical barriers are unavailable due to maintenance or disruption,

Barriers have compromised effectiveness,

Critical equipment is unavailable,

Weather conditions are becoming more extreme and closer to tolerable limits.
When working close to tolerable limits, due to the larger insight into the extra risk exposure, decisions can be made
to supplement the operation with extra barriers or perhaps stop the operations all together.
The Soob consists of three parts, which examine different aspects of operations:
1. Operations versus Operations. This part of the Soob tells us which combinations of operations are within
tolerability limits and technical limitations and if and how they can be combined.
2. Operations versus Barriers under reduced effectiveness. This examines which operations are allowed or
not when certain barriers have been defeated or running under reduced effectiveness.
3. Operations versus Operational Risk Factors. Here we examine if operations are allowed to proceed
depending on other factors which influence the risk of doing these operations, such as weather
conditions, critical equipment, etc.
The Summary of operation boundaries (Soob) is very similar to the Manual of Permitted Operations (MOPO).
MOPOs can easily be made using the Soob functionality in BowTieXP. You will find that the thinking behind Soob is
much more dynamic then the static concept of a manual.
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The entire Soob can be divided over a number of different matrices, although they can also be listed in a single
matrix. This is why in this manual we usually refer to a Soob matrix and not to the whole Soob, which would be all
these matrices combined.
Let us clarify the various parts of a Soob matrix with some examples.

21.2.1. Operations versus operations
As said before, in this section of the matrix we examine which combinations of operations are within tolerability
limits and technical limitations and if and then how they can be combined.
As a sample we will use the following marine operations on board a drilling rig, which should be easy to follow
without prior knowledge about drilling rigs. Please note this description was not written by a drilling expert and
should serve only as an example for explaining the different Soob matrix concepts ;-)
Operation

Description

Anchoring

The anchoring of the rig is the operation where the rig’s anchors are dropped to
maintain the rig’s position for a longer period of time. This is done by bringing
the anchors out using e.g. a support vessel and dropping them a certain
distance from the rig. After dropping the anchors the anchor lines are tightened
to fix the rig’s position.

Ballasting (Change Draft)

Changing the draft of the platform by taking on ballast.

Bulk Transfer

The transfer of bulk products such as drilling mud and cement onto the rig from
a support vessel.

Towing

Changing the location of the rig by means of towing it using tug boats.

Towing

Bulk Transfer

Ballasting (Draft Change)

Anchoring

Below is an example of the Operations versus Operations part of the sample Soob matrix we’re examining.

SM1 Soob Matrix 1
Operations
Op. Anchoring

ATP

Op. Ballasting (Draft Change)

ATP

Op. Bulk Transfer

ATP

ATP

Op. Towing

ATP

ATP

ATP

ATP

ATP

ATP
DNP

DNP

The codes and colors are explained in the table below.
Code
DNP
PWC
ATP

Name
Do Not Proceed
Proceed With Caution
Authorized to Proceed

Color
Red
Yellow or Orange
Green

We see that combining Bulk Transfer with Towing is not allowed, indicated by the red color and the code DNP:
Moving the rig whilst at the same time having a support vessel maintaining the same relative position to the rig is
very dangerous and should not be attempted.
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We also see that all other combinations are allowed to proceed.

21.2.2. Operations versus barriers under reduced effectiveness
This part of the Soob matrix examines which operations are allowed or not when certain barriers have been
defeated or running under reduced effectiveness.
Below is an example of this part of the matrix. In this sample we take a look at the hazards of having liquefied gas in
a storage vessel near a road, creating the possibility of impact with a moving vehicle.

Operation A

Operation B

Operation C

Operation D

For the operations we use the abstract operations A through D – we only want to demonstrate the possibilities of
the Soob.

PWC

NA

ATP

ATP

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

SM1 Soob Matrix 1
Barriers Under Reduced Effectiveness
Loc. Hazardous Site
Haz. 5.4.4.6 Liquefied Gas in Storage Vessels in Production
Facility / Catastrophic failure of storage vessel
Tht. Vehicle Impact
Ctl. Protection provided around vessels against
vehicle impact (bollards and kerbing)
Ctl. Vessels are double skinned providing resistance
to impact
Ctl. Vessel bases set in concrete annulus and bolted
to concrete area
Ctl. Examination carried out in accordance with Written
Scheme of Examination

Here we see that operations A through D have all been deemed relevant to the Threat of Vehicle Impact in the bowtie for the catastrophic failure of a storage vessel containing liquefied gas.
We see that most barriers are not relevant – they have been classified as NA / Not Applicable.
We also see that if the barrier called “Protection provided around vessels against vehicle impact (bollards and
kerbing)” is not functioning or is missing, operation B, C and D can continue but for different reasons: Operation B
can continue because the barrier is deemed not applicable for this operation. Operation C and D can continue
because missing this barrier is applicable, but not essential for the safety of these operations, so we are authorized
to proceed.
Finally we see that operation A can proceed, but with caution, if the road barriers are missing, damaged or
otherwise not up to their usual task. For this operation, not having this barrier apparently adds extra risk but not so
much as to have to stop.

21.2.3. Operations versus operational risk factors
For the last section of the Soob matrix we return to our drilling rig example.
We have defined several operational risk factors having to do with environmental conditions, such as visibility and
sea state. On the horizontal axis we again have our marine operations.
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Anchoring

Ballasting (Draft Change)

Bulk Transfer

Towing

Orf. Night Time

ATP

ATP

PWC

ATP

Orf. Poor Visibility (Fog)

DNP

ATP

DNP

PWC

Orf. Sea State > 8 ft

PWC

ATP

PWC

ATP

Orf. Strong Current > 3 kts

ATP

ATP

ATP

ATP

Orf. Wind Speed > 30 kts

DNP

ATP

DNP

PWC

SM1 Soob Matrix 1
Operational Risk Factors
Orf.: ENV Environmental Conditions

We see that anchoring, ballasting and towing can continue at night, but bulk transfer should proceed with caution.
When visibility is poor we should stop anchoring operations and bulk transfer. Towing should proceed with caution
and ballasting can continue unhindered. In fact, ballasting is not affected by the weather conditions at all.
Notice also that strong currents have no effect on these operations.

21.3. Overview of setting up a Soob matrix
To set up your Soob matrix, you go through the following steps:
1.

Creating Operations, this consists of the following steps:
1. Defining Operation Categories (optional)
2. Defining Operation Types (optional)
3. Defining Operations
4. Linking Operations to Hazards, Threats and Consequences (optional)

2.

Creating and Linking Operational Risk Factors (optional)

3.

Creating Soob matrices, this consists of the following steps:
1. Defining Soob categories
2. Creating Soob matrices
3. Linking operations to Soob matrices

4. Populating / filling in the Soob matrices.
All the things we will be creating are located under the Operations and Risks node in the treeview.

Figure 184 - Treeview showing operations and risks node
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21.4. Creating operations
The first step in making a Soob matrix is defining which operations can be part of your Soob matrix. In order to do
so, we first need to define the reference information we might be using on the operations themselves. Afterwards
we can define the operations.
It is of course possible to modify all the reference information at any time.

21.4.1. Defining operation categories (optional)
Operation categories can be used to categorize your operations. When you add or edit an operation, you can set to
which operation category the operation belongs.
Some operation categories that we have observed are:

Drilling

Marine

General

Administration

Lifting
Assigning operation categories to operations is optional.

21.4.2. Defining operation types (optional)
Operations cannot just be assigned a category; they can also be assigned a type. These can be created in the
operation type container.

21.4.3. Defining operations
Before creating a Soob matrix we need to define which operations will be part of our Soob matrix. Operations are
defined centrally in the operations container in the treeview, and can be assigned to multiple matrices.
Defining operations is done by adding them to the operations container in the treeview. It is located underneath the
operations and risks container.

Figure 185 - The add operation dialog box
The operations are initially organized in the order in which you add them, but you can reorder them if you needed
by right clicking the container and selecting “Reorder” from the menu.
Operations can be defined hierarchical. This allows you to link just the top level operation - all sub-operations will
be available automatically. Note that only the sub-operations can be filled in.
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21.4.4. Linking operations to hazards, threats and consequences (optional)
If we want to examine the impact of missing or ineffective barriers for our operations, we will need to associate
hazards, threats and consequences with those operations.
By creating a link between an operation and a hazard and top event, we are indicating that that operation is
potentially exposed to the hazard and subject to one or more consequences of a top event.
We can link operations to entire bow-ties by linking at the hazard level, or we can link an operation to only a part of
a bow-tie by linking at the threat and/or consequence level.
Only the relevant parts of the bow-tie will be visible and editable in our Soob matrix.
This linking is done is the same manner as all linking in BowTieXP. The easiest way is to go to the hazard, threat or
consequence in the treeview, open it up, and right-click the operations node underneath, and select “Assign Links”
option from the menu.
You can also assign using drag and drop; simply drag the operation out onto the hazard, threat or consequence in
the diagram and drop.

21.5. Creating and linking operational risk factors (optional)
If you want to analyze what other operational risk factors have for impact on your operations, you should define
those factors now.
Operational risk factors are created by adding them into the operational risk factors container in the treeview,
under the operations and risks node.
Note that operational risk factors can be nested so you can create groups. Some common values include:

Figure 186 - Example operational risk factors
After creating the operational risk factors we want to include in our Soob matrix, we need to associate them to their
relevant operations.
This is done similar to all linking in BowTieXP. The easiest way is to go to the operation in the treeview, open it up,
and right-click the operational risk factors node underneath, and select “Assign Links” option from the menu.
The operational risk factors are often used for listing HSE-critical equipment.
If it is used for HSE-critical equipment, the criticality of the equipment can be categorized by populating the
criticalities under the lookup tables in the treeview. When adding new HSE-critical equipment under operational risk
factors, you can assign the criticality rating, or you can do it afterwards in the editor.
An example of an equipment criticality rating scale:


SCE - Safety Critical Equipment/System
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HEE - HSE Essential Equipment/System
OEE - Operations Essential Equipment/System
NEE - Non Essential Equipment/System

21.6. Creating Soob matrices
21.6.1. Defining Soob categories
The Soob categories are the values that can be used in your Soob matrices, values that indicate whether you can
perform certain operations simultaneously or not. They are defined in the treeview under Case  Operations and
Risks  Soob Categories.
A Soob category consists of a code, a description and a color.

Figure 187 - The add Soob category dialog box
Often a categorization similar to this one is used:
Code
DNP
PWC
ATP
NA

Name
Do Not Proceed
Proceed With Caution
Authorized to Proceed
Not Applicable

Color
Red
Yellow or Orange
Green
White or Gray

What’s also commonly seen is that several ‘Proceed with Caution’ categories are defined, for instance:
Code
PWC1
PWC2
PWC3

Name
Proceed with Caution #1 (clarification #1)
Proceed with Caution #2 (clarification #2)
Proceed with Caution #3 (clarification #3)

Color
Yellow
Yellow
Yellow

In this case each category has specific notes on how to proceed.
It can certainly be done this way, but it is not necessary to add clarifications to the proceed with caution category in
this manner: each cell in the matrix can have its own comments, instructions and document links with more
detailed information.
However, if you have many cells in which you want to place the same comments, adding a specific Soob category
for these might be wise.

21.6.2. Creating Soob matrices
After defining your Soob categories, you are ready to define a Soob matrix. You can do so by adding a Soob matrix
to the Soob matrices item in the treeview.
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Figure 188 - The add Soob matrix dialog box
The code and name fields are mandatory, and you should also think about which of the tree different types of Soob
data you want to enter into this matrix:

Operations versus Operations

Operations versus Barriers

Operations versus Operational Risk Factors
After clicking okay, the Soob matrix editor is opened, displaying an empty matrix: There are no operations assigned
to the matrix yet.

Figure 189 - Soob matrix editor with empty matrix

21.6.3. Linking operations to Soob matrices
Assigning operations to the matrix is done by expanding the matrix in the Treeview, and right-clicking the
operations container. Select “Assign links” from the context menu, as described elsewhere in this document.

Figure 190 - Selecting to assign links
After assigning operations to the Soob matrix, we get to see a bit more:
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Figure 191 - Soob matrix showing operations versus operations
Filling in the Soob matrix is explained in the next section.
Note that the order in which the operations appear is determined by the order in which the operations have been
defined in the case file. If you need to change this order, you can reorder them by right clicking the operations
container below the operations and risks node and selecting “Reorder” from the menu.
After applying the new order, the matrix will update to reflect your changes.

Figure 192 - Order of operations

21.7. Populating a Soob matrix
After opening the Soob matrix we can populate the matrix with the values (Soob categories) that we’ve set up.
As mentioned before, the Soob matrix consists of three parts. Let us quickly review:





Operations versus operations. This part of the Soob matrix allows you to define whether operations can
run simultaneously.
Operations versus barriers under reduced effectiveness. In this part of the matrix you can define whether
certain barriers are critical to an operation and must be available and fully functional before the operation
can begin.
Operations versus operational risk factors. The operational risk factors part of the matrix is a part of the
matrix that you can configure yourself with any risk factor that you find to be important for your
operations. Operational risk factors are used for e.g. weather restrictions and conditions and/or critical
equipment.

First we will show how to proceed with the operations versus operations part of the matrix and show you how to
edit the Soob matrix. The other sections of the matrix are edited in a similar manner, and we will discuss specifics of
those below.
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21.7.1. Basic Soob matrix editing
First we need to select the cell of the combination of operations we are to consider. Let’s start by considering
operation A and operation C by clicking on that cell, as seen in the screenshot below.

Figure 193 - Soob matrix with selected empty cell
A drop-down arrow will appear in the right of the cell. If we click this arrow we get a menu, where we can select the
wanted Soob category. This is why we needed to define those first.

Figure 194 - Choosing a Soob category for a cell
After selecting the appropriate value, we see that it is applied to BOTH cells which refer to the combination of
operation A and operation C. The chosen category is displayed by means of the code and the color.
NOTE: The combination of an operation with itself isn’t possible – it makes no sense and therefore the
cells on the diagonal cannot be selected.
If you need to define whether the same operation can be combined with itself, the operation is probably
not specified in enough detail. For example, crane lifting operations could be split out into crane lifting
operations for crane A and for crane B, and their combined operation can then be specified.

Figure 195 - Soob category has been applied
Notice that after applying a Soob category to the cell, the editor allows us to add a description. For instance, when a
cell describes that combining operations A and B should ‘proceed with caution’, you probably want to add
additional information about how exactly to proceed.
NOTE: When a combination of operations has a Soob category assigned to it, we also refer to this
combination of operations as a “Soob value”, a filled place in the matrix.
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Figure 196 - Editor showing details of a Soob value
After completely filling in the matrix it might look like this:

Figure 197 - Filled Soob matrix

21.7.2. Editing the operations versus barriers under reduced effectiveness section
If you have linked an operation to a hazard/top event, and enabled the operations versus barriers section in your
Soob matrix, you will see that this section of the Soob matrix is now expanded with the hazard/top event and all the
threats, consequences, escalation factors and barriers below them.
If a cell is grayed out, that means that the barrier in question is part of a hazard/top event that is linked to at least
one operation but not to the operation for which the cell is grayed out.

Figure 198 - Enabled and disabled cells
In the screenshot shown in Figure 198 - Enabled and disabled cells, we see that:

Operations C and D are probably linked at the hazard level – all cells are enabled for these columns.

Operation A is linked only to the threat of vehicle impact – only those cells are enabled.

Operation B is not linked to this hazard or any of its threats.
Tip: There could be some or even many barriers in your risk model that may not be critical or even relevant for an
operation. Using a Soob category called ‘Not Applicable’ or similar helps you to identify those barriers as ‘Not
Applicable’ to this operation. It is important to think it through though, because your operation is or could be
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exposed to the hazard and subject to one or more consequences of a top event. Using a Soob category called ‘Not
Directly Applicable’ might be a good way to deal with those barriers that the operation indirectly relies on for the
prevention of a release of the hazard, but that are not considered a direct part of the operational activities.
If you unlink operations from hazard/top events, the structure of your Soob matrices will be automatically updated
to reflect this change. Any values that you have assigned to cells (operations vs. barrier) that are no longer linked
are of course lost. If a barrier is part of a bow-tie of a hazard/top event that has been unlinked, those values are lost
because they are part of the link.
BowTieXP will not provide you with a warning when you unlink. It does however allow you to recover from your
mistake by undoing your change with the Undo button. This will also recover all the linked information that you lost
by unlinking.

21.7.3. Editing the operations versus operational risk factors section
The operations versus operational risk factors section is edited in the same manner as the previous two sections.

21.7.4. Exporting to Microsoft Excel
Although it is recommended to provide Soob matrices in BowTieXP format the matrix can also be exported to
Microsoft Excel format.
It is recommended to provide matrices to consumers because BowTieXP has special features for navigating and
searching through the matrices, and is capable of referencing all linked document links easily. The matrices are less
accessible from Excel. Remember that the navigator version of BowTieXP also supports all features for navigating
the matrices.
When you press the Export to Excel button, the matrix will be exported as shown on screen: the way you have
opened and closed the rows in the Soob matrix editor will be reflected in Excel, providing you a lot of flexibility with
how you want to export.
Microsoft Excel provides you with a lot of formatting options, if you want to know more please contact
support@cgerisk.com and we will provide you with some useful Microsoft Excel formatting tips.
Another option is to use the “formatted matrix report” button. This will export the matrix, again to Excel, but with a
layout which is optimized for printed reports. After clicking the button you are presented with a dialog allowing you
to specify different formatting options.

21.7.5. Relationship models of operations
Another useful feature of Soob in BowTieXP is that once the matrix has been populated with values, you can rightclick on an operation in the treeview and select to see its relationship diagram as shown in the screenshot below:
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Figure 199 - Relationship model menu
You will see a mind map showing the Soob relationship that has been defined between this operation and the other
operations.

Figure 200 - Example Soob relationship diagram

Note: For more details on relationship models, see chapter 9.5, Advanced functionality: relationship
models on page 93.

21.7.6. Soob matrix editor toolbar reference

Figure 201 - Expand / collapse toolbar
Icon

Description

Keywords

Enter the keywords to expand by here
Execute expand by keyword operation by means of the keywords entered into the text box
Go to previous keyword match
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Go to next keyword match

Expand All
Collapse All
Go to definition in the treeview

Figure 202 - General toolbar
Icon

Description
Reset/reload
Export to Excel

Figure 203 - Column filter and fill/paint toolbar
Icon

Description

Matrix Filter

Select either the column to display or the named selection of columns to display here:
With the column filter you can show only one operation vertically to allow you to focus on
that one operation versus the other operations. By selecting <no filter> you can show all
operations on the columns again.
You can also create sets of operations to work with. They are called Soob filtered views and
are defined in the treeview underneath the matrix.
Copies one column to another.
Replace one Soob category with another/fill.

Fill By Single Click

Select the Soob category to paint with here to enable this feature. After selecting a category,
each cell you click will be assigned the selected Soob category.

Figure 204 - Hot tracking toolbar
Icon

Description
Enable the display of the row of the currently selected/hovered cell.
Enable the display of the column of the currently selected/hovered cell.
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Enable hot tracking: when this option is enabled, the row and column display will show the
values for the cell currently under the mouse pointer. When it is disabled, they will display
the information for the currently selected cell.
Enable tooltips showing extra information for the cell under the mouse.
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22

Advanced functionality:
Live on/offline system states
This chapter describes how to automatically determine
whether a hardware barrier is on- or offline based on
the barriers individual parts

22.1. Introduction
Many barriers found on modern industrial installations have hardware components in them. These hardware parts
are often managed by maintenance management systems, which keeps track of the states of these parts. If parts
are taken out of commission or isolated for the time being, their status can go from online to offline. If some parts
are considered offline, this can have an impact on the availability of a barrier function of which they are a part.
With the live on/offline system states functionality, the effects of individual parts going on or offline can be shown
on the BowTie. For example, when a part’s status is updated to offline, a barrier can automatically turn red
depending on a configurable logic model. If these parts states are updated regularly, the BowTie can show near
real-time current state of the barriers.

22.2. Overview of the model
In order to automatically determine whether a barrier should be considered online or offline, a decision tree can be
constructed using a hierarchy of systems and a list of parts.
In Figure 205 on the far right we see the parts. Parts are the lowest level of hardware components on which the
organization can retrieve an online/offline state. They are defined the in the parts table and have a code, name and
on/offline status. They do not contain any decision logic.
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Figure 205 - Example model of parts, systems and barriers
Parts can be linked directly to barriers and/or a sublayer of systems. It is on the level of the systems and barriers
where the decision logic is defined. On or offline criteria can be defined with simple rules such as “4 out of 6 of the
directly linked systems/parts must be online in order for this system to be considered online”. With this, a hierarchy
of systems can be created to determine the on/offline status of the top level shape (the barrier).
For example, let’s say that in Figure 205, the online criteria for System 1.2 (Gas detection type B) are set so that only
one part may be offline at any time. In the figure we see however that two of its parts are considered offline,
therefore the whole system is now considered offline.
Another example, let’s say that in Figure 205, the online criteria for System 1 (Detection system) are set so that at
least one of the subsequent systems should be operational. We can see that although system 1.2 is offline, system
1.1 is still offline which is enough to consider system 1 to be online.
The following sections will describe how to set up the system.

22.3. Adding the parts table
The parts table is visible in the treeview. Creating, deleting and editing parts is done in the same manner as for
other lookups. If you click on the parts collection and show the listview, additional details for each part are shown,
such as the online status.
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Figure 206 - Creating parts

22.4. Adding a hierarchy of systems and adding parts
Systems are a hierarchical link collection that can be defined in the treeview. Creating, deleting and editing parts is
done in the same manner as for other lookups. To link parts to systems, double click a system and go to the “parts”
tab. One part can be linked to multiple systems, allowing for re-use and maximum flexibility in the online
calculations.

Figure 207 - Linking parts to systems

22.5. Defining online status criteria for systems
After double clicking a system, you can go to the “online criteria” tab to define the on/offline criteria for the system
based on the direct child elements (i.e. parts and/or systems) linked onto the system. The configuration is done as
follows:
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Figure 208 - Define on / offline criteria
On each system, there are two potential rules which can be enabled:

A minimum availability rule – at least N parts or subsystems must be online for the system to be online

A maximum unavailability rule – no more than N parts or subsystems may be offline if this system is to be
considered online.
Both rules can be configured in absolute numbers or in percentages. To toggle to percentages, use the tick box on
the right of the numerical selector. Both rules can be active at the same time. You will get a choice whether the two
criteria are both to be met or only one is to be met (AND/OR logic). If no rules are active, the part will be in the
offline status.
These rules will run from leaves to root in the systems hierarchy, calculating the status of each element by means of
the part online/offline status. For example, the online status for the following systems hierarchy is visible in the
treeview if we select the “Systems” root node in the treeview:

Page 171 of 263

In the right hand column, we see the status of the system itself. Green means the system is fully online, red means it
is considered offline and amber means that the system has met the online criteria, but not all subsystems are
online. The notation behind the on/offline indicator shows how many of its directly linked systems and/or parts are
online (left) and offline (right).
Note that the “Online Criteria” tab on systems and barriers will only appear in the user interface after a
list of parts has been defined. This was done to reduce the number of tabs for users who do not use this
functionality.

22.6. Linking systems to barriers
When a hierarchy of systems has been defined, the systems can be linked to barriers like any other link collection in
the software. Parts can also be linked directly to a barrier without an intermediate system.
As with the systems, the online criteria for the entire barrier can be defined under the “online criteria” tab on the
barrier editor. These criteria will then be applied to all linked elements that can have an online/offline status:




Systems
User Systems
Parts
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Figure 209 - Define online criteria on the barrier level

22.7. Displaying online status on the diagram
All this results in a visualization underneath each barrier, showing the actual barrier status as well as the make-up –
how many associated systems are online or offline.
The display is configured via the display options by clicking the little eye icon in the bottom right hand corner of the
barrier:

Figure 210 - Set online status info via the barrier's 'eye' icon menu
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Only one system is linked on the barrier, in this case the fire and gas detectors system. The barrier is online, as that
system is online. This can be deduced from the “1 / 0” text – the left number is the number of online systems; the
right number is the number of offline systems.

22.8. Updating parts’ states
In order to do bulk updates of the part online status, we use the “import external data” function, which can be
found in the file menu.

The import external data function allows you to choose to only updating existing parts, as indicated in the
screenshot.
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22.9. Importing a hierarchy from scrapbook
Because the number of parts and systems involved in a plant can easily become very large, it is therefore possible to
automatically import lists of parts and even create a hierarchy of systems using MS Excel. Using the Excel format as
shown below, an Excel sheet can be created listing all parts and systems. Once finished, the Excel sheet can be
imported using the scrapbook functionality (as described in section 18).

Figure 211 - Excel sheet setup for bulk import of systems and parts via Scrapbook
A hierarchy structure can in this case be identified using the Id and ParentId fields.

22.10. Displaying online states in the Case Overview
For an overview other than the BowTie’s graphical representation, a list wise representation can be provided via the
Case Overview. The states are part of the Systems-User Systems overview (for details on the Case Overview, see
section 9.2).

Figure 212 - Case Overview for Systems that shows online/offline states
The Case Overview can be used to drill down and analyze why systems are considered online/offline. The Case
Overview is interactive, so it is possible to directly edit the barriers, systems and parts from this structure if
required. In addition to its calculated online state, it also shows at which time the status has been updated and
what the criteria are per system/barrier.

22.11. Display online status in graphical tree diagram
For more complex barriers, the subsequent hierarchy of systems and parts can also become very complex. To
facilitate the analysis of why a barrier is now considered online or offline, it is possible to draw a relationship tree
which shows all sub systems and their children and highlights whether they are red, green or amber.

Page 175 of 263

The online status relationship tree can be displayed on any level within hierarchy that has child elements.

Figure 213 - Online status overview for a barrier and a system
The diagram that is produced will take the following form:

Interacting with the model is possible by using the right click menu. The diagram can be copy pasted into an email
using the copy-to-clipboard functionality in the top left corner. The Filter button allows the diagram hide all online
systems and only focus on the offline and amber shapes.
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23

BowTieServer oriented features

This chapter lists some of the features in BowTieXP that
work best in combination with BowTieServer.

23.1. Introduction
There are some features in BowTieXP that are especially powerful when used in combination with BowTieServer.
Some can also be used when using BowTieXP standalone, but may not always be practical.
This chapter will only briefly describe the features, but for a more detailed description, please refer to the
BowTieServer manual.

23.2. Organizational units
Most large international organizations have operations on multiple sites, spread out over the globe. All of these
sites may want to make BowTies or in some cases even share BowTies if they are dealing with similar risks. To keep
track of which data is relevant for which location, organizational units can be created and assigned to various forms
of data.
In BowTieXP, these organizational structures are often tied to a geographical location, although it is also possible to
define more abstract departments. The organizational units can be defined in the Treeview under the BowTie
lookup tables similar to any other taxonomy. They are hierarchical in nature, so the following structures could be
possible:
North Sea
Drilling platform A
o Drilling floor
o Crew Quarters
o Helideck
Drilling platform B
o Drilling floor
o Crew Quarters
o Helideck
Various features in BowTieXP and BowTieServer make use of the organizational units:
Barrier performance: Define the actual effectiveness of a barrier per organizational unit
Organizations can have in addition to a geographical location also a more detailed Plot plan
Link organizational units to BowTie Groups to track which BowTies are relevant for them
Link organizational units to Incidents to track which are relevant for them
Use them as filtering parameters in the AuditXP’s audit filter and IncidentXP’s incident filter
Use them as filtering parameters in various BowTieServer overviews

23.3. Plot plans
Because industrial installations can be quite large, merely a geographical location is not always practical. To get a
higher level of detail, the image of a plot plan can be uploaded to achieve a higher level of detail. Even though the
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functionality is called “plot plans”, it can also be used to upload another picture such as an aerial photograph or any
other schematic representation of the site.
Another use of plot plans is to have a stable mapping for locations that themselves are mobile. For example, a
maritime vessel may not always be in the same geographical location but its plot plan will be the same no matter
which geographical location.
Plot plans can be added in the Treeview, under BowTie Lookup tables. They are then used by various features:
Incident reporting: Pinpoint the location where the incident occurred.
Link organizational units to specific points on a plot plan

23.4. Change history logs
When a user has permission to view change histories, a clock symbol will appear on all BowTie elements. Pressing
this button will show the change log for that element, listing all changes that have been made in the past to this
element. The same log is also accessible in the web UI of BowTieServer.

23.5. Barrier Performance data
In organizations which have operations in multiple locations, it is possible that they are dealing with similar risks
regardless of the geographical location. It could therefore be possible that these locations share a BowTie on the
same risk or require to have the same barriers in place. But even though the barriers must be the same, the
effectiveness of the barriers may vary per location. To assess the actual effectiveness of the barriers per
organizational unit, the barrier performance feature can be used.
In this tab in the barrier editor, the effectiveness of the barrier can be determined for every organizational unit that
has been linked to the BowTie Group in which the BowTie diagram resides.

23.6. Markdown formatting
Long description fields support a simple markdown formatting. This means that with simple code, the text in
description boxes can be formatted and clarified with headers, bold text, italics, simple tables, hyperlinks and even
images.
For example, typing a word between “/” symbols will make the word appear in the BowTieServer web UI appear in
italics. To create a header, the “#” symbol can be placed before a line of text. It will then be interpreted as a level 1
header.
While working in the description boxes in BowTieXP, you will only see the code form of the formatting. Currently,
the only way to see the formatted version of the code is to run the Barrier Overview report, which can be found in
the right-click menu on barriers.

23.7. Wiki pages
There may be a lot of documentation available that is related to BowTie elements, in particular to barriers.
Documents such as procedures, more elaborate descriptions and explanations, legal / audit standards could be
relevant to consult. With the wiki pages, this information can be stored in wiki form and uploaded onto
BowTieServer. The information can then be chunked into sections, chapters, paragraphs etc. and these can then be
linked to individual barriers. This way, very specific parts of information can be linked to individual barriers. So,
when information is required, the right bit of information is easily accessible and it is no longer necessary to leave
through a large document.
The wiki pages support the before mentioned markdown formatting, so can include images, tables and other forms
of simple formatting.
This chapter will only briefly describe the features, but for a more detailed description, please refer to the
BowTieServer manual.
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24
AuditXP add-on
24.1. What is the AuditXP add-on?
AuditXP is an add-on for the BowTieXP software package. It is used to generate barrier related audit questionnaires
or surveys. The add-on allows users to easily generate questions concerning barriers and management systems.
These single questions can then be compiled into surveys (a selection of questions), which can be exported (for
example to Excel as a fill-out form). After importing the audit findings, the results can be visualized in the bowtie
diagrams.

Auditing is a valuable way of gaining insight into barrier quality/effectiveness, to get early warnings before incidents
will occur. With the audit add-on, we provide a tool to close the Deming circle. After defining the barriers in your
safety management system (i.e. the plan stage) and implementing them (i.e. the do stage), a check is required to
ensure the quality of the barriers. Relying on barriers that are in reality inadequate can be dangerous. Also, a
thorough examination of the barriers during the check stage facilitates the generation of relevant recommendations
later on (i.e. act stage).

24.2. Three advantages of the audit add-on
Three main advantages of using AuditXP are:
1. Risk based auditing. Create an audit scope by looking at the risk scenario, and also report on results from
a risk based perspective.
2. Analyze dependency effects. Visualize how a poorly performing management system can have large
effects throughout the bowtie.
3. Visualize results. Audit results are directly plotted on the bowtie using intuitive graphs, instantly
highlighting problem areas. The visual representation facilitates expert judgments on overall barrier
quality. It also provides an up-to-date feedback on the current barrier quality status.
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Figure 214: Visualize audit results on barriers

24.3. Create questions on different 'bowtie levels'
With AuditXP, users can generate surveys that directly relate with elements that are defined on the BowTie
diagram. The surveys can be directed at three levels of elements:
1.
2.
3.

Barrier level
Management system level (activities and documents)
General questions (e.g. on organizational structure)

On the barrier level, the auditor is questioning whether the integrity of barrier meets the predefined requirements
(e.g. is it in place? Is it working?).
On management system level, the underlying management system can be assessed. This level covers activities such
as training and maintenance, but also whether documentation is up to par (e.g. manuals, procedure documents).
The third level covers questions that cannot be linked to any specific element in the BowTie, but cover more high
level structural or general questions. Questions typically cover the existence of complete systems (e.g. if there is a
housekeeping system defined) or general subjects (e.g. the way personnel communicates or the state of
housekeeping).

24.4. The general workflow
The general workflow of AuditXP is as follows:
1.
2.
3.
4.
5.
6.

Define or import questions.
Associate the defined questions with barriers and/or activities.
Create a survey, a selection of questions.
Create fill out forms for respondents.
Feed the filled out forms, the answers, back into BowTieXP.
View and interpret the results.

All the audit data is stored within the bowtie case file.

24.5. The audits treeview node
All audit data is stored under the audits node in the BowTieXP treeview. There can be multiple audits within the
audit module. An audit is a collection of questions and a collection of surveys (questionnaires, consisting of a subset
of questions from that audit). To create a new audit, right click the audit node and select new audit.
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Figure 215 - The audits node
When ‘New Audit’ is selected, the add audit window appears. In this window, indicate a name and basic
purpose/usage for the audit. In case you are using AuditXP for risk-based auditing, please select ‘Normal Audit’ as a
basic purpose/usage. The basic purpose/usage ‘SIR Incident Questions’ is for setting up the Incidents module in
BowTieServer.

Figure 216 - The add audit window
Once the new audit has been created, two containers are automatically added: One for the questions and one for
the surveys of that audit.

Figure 217 - The add audit window
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24.6. Defining questions

Figure 218 - Creating questions
Defining questions within BowTieXP is done by right clicking on the questions node of audits container and selecting
“New Question”. The editor will then pop-up:

Figure 219 - Editing a question
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24.6.1. Important notes about Questions within BowTieXP
Questions should be choice questions.
The questions created in BowTieXP should be choice questions. This means that only a limited set of answers can be
defined. The possible answers should be in a logically keyed order – from most positive to most negative or vice
versa. This means that a question like “Which country are you from?” cannot be asked in a question, because the
answers don’t range from positive to negative. A list of countries is a nominal scale, whereas AuditXP only deals
with ordinal scales.
From the set of possible answers only one answer can be selected by the respondent.
Use the ENTER key to go to a new line in the answers field.
The possible answers are each defined on a separate line in the “ordinal answer values list” field. To accomplish this
ENTER must be used to go to a new line in this edit field.
Questions can be defined hierarchically.
Just like activities and document links in BowTieXP, questions can be defined hierarchically (nested). This has been
added for convenience and grouping purposes only. The surveys themselves will only consist of a flat list of selected
questions.
Positive, neutral and negative answers
BowTieXP assumes that the top half of the answers is positive and the bottom half is negative. It is possible to alter
the negative/positive value in the ordinal answer value list, for instance by having negative answers first, by using
the radio button in the ‘Add Question’ window next to ‘Answer Keying’. Ensure that the answer options you add to
a question are in line with this interpretation. See the table in 24.10.2, How to read the positive/negative bar charts
on page 194 for examples.
Use @ to change the center of the answer scale
By default, AuditXP will take the exact middle of all the answers and use that to determine what is positive and
negative. This middle point can be biased by including an @ sign as the first character on a line. Make sure it is the
first character. Placing an @ anywhere else will result in unexpected results.
For example:
Poor

Totally disagree

@

Disagree

Acceptable

Somewhat disagree

Good

@Neutral

Very good

Agree

In the first example, the middle will be between Poor and Acceptable. In the second example, Neutral will be the
middle.

24.6.2. Advanced options for questions
In the advanced section for each question, there are two additional options:
1. Most negative answer will determine overall result
This option will make sure that if there are multiple answers, the most negative answer will be used as the
overall result. This can be convenient if one is not interested in the average result, but only in the outliers.
2. Repeat question for each context or answer it once
This is a powerful option that can be tricky to understand. Normal questions are answered once, and that
answer will be shown everywhere it’s linked. This is good to show for instance how a single activity or
barrier can have a large impact if it is not performing.
Switching to ‘question is repeated for each linked barrier or activity’ will repeat the question to allow a
user to give unique answers, depending on the context of a single barrier or activity. We call these
contextual questions. For instance, if I link a contextual question to each instance of the barrier Defensive
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driving, I will see the same question with all the unique contexts for Defensive driving and can give a
different answer in each context.

24.7. Associating questions with barriers and activities
Now that the questions have been defined we can associate the questions with existing bowtie barriers and/or
activities. This can be done be dragging the question to the target barrier or activity, or by adding the question to
the barrier or activity in the “questions” tab in the edit form. To help you make a selection in the ‘Questions’ tab,
there is a filter box to type text to filter the questions on.

Figure 220 - Assigning questions to a barrier with the editor
Note that this works the same way as linking other items such as document links to BowTie elements.

Figure 221 - Assigning questions using drag and drop
The assigned questions can be displayed beneath the barrier shape as extra information. See the chapter 8,
Configuring the diagram on page 78 for more details on how to configure the diagram.
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Figure 222 - Showing questions as extra info on barriers

24.8. Creating surveys
The set of questions can quickly become very large, and in most instances, you will not be seeking answers to every
defined question – the time needed to gather all the answers will become prohibitive. Also, some questions you will
probably want answered at a different frequency than others.
For this reason, you will select a subset of all available questions, and this subset will be answered. Such a subset is
known as a survey.
To create a new survey we go over to the audits node in the treeview, right click the surveys node and choose “New
Survey”. The editor is popped up:

Figure 223 - Adding a new survey
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Figure 224 - The survey editor
You will need to supply a code and name and can also supply an optional description.
The “View Results” part will initially show “None” because no respondents have contributed yet to this survey.
The questions in this survey can be assigned on the questions tab page.

Figure 225 - Assigning questions to a survey
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To help you make a selection, there is a filter box to type text to filter the questions on. There are also three
dropdowns which will allow you to use the bowtie as the selection mechanism for the questions. For example, in
Figure 225 you see the first column says ‘Assigned to Barrier’, the second says with ‘Accountable’ and the third has
‘Driver’. This means that the list of questions is currently filtered to only display questions that are linked to barriers
where the accountable is Driver. This filter can be used multiple times to make combinations of criteria.
After entering a code and name has been defined for the survey and the questions are assigned, you can press the
apply button. Now the export and import buttons will be enabled. We’ll cover those in the next sections.
When the survey form is saved the survey will be added to the treeview. It will be visible like this:

Figure 226 - Tree view with a new Survey
The questions linked to this survey are visible under the questions node.

24.9. Creating fill out forms for respondents
A set of answers from a respondent is known as a fill out in the software. It consists of a date, a respondent’s name,
and an organizational unit and of course a set of answers and answer remarks. For each question there can be one
answer and a remark.

Figure 227 – Adding a new fill-out
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Figure 228 - Creating a new fill-out
Adding a set of answers into the software is fine if you are the only respondent, but if you might not have your
computer handy or would like to gather answers from many respondents, this will not work. That’s why there are
other ways of getting the data into BowTieXP.
The primary way is by means of Excel sheets – you might have noticed the import/export buttons on the survey
editor. We will discuss those in the next section.
Another way is to couple the audits module to another external system. This can be done by means of the
BowTieXP API, which allows programmers to manipulate btf files directly. This is beyond the scope of this manual,
but contacts us for details on options on how to integrate with your external audit system and use BowTieXP for
visualization of the results.

24.9.1. Exporting and importing fill outs to and from Microsoft Excel
After the surveys have been composed by selecting relevant questions, an Excel sheet can be automatically
generated. This sheet consists of all the questions, criteria and answer keys defined by the user and provides a quick
dropdown menu.
The auditor can simply select the applicable answer key. After that, the sheet can be imported back into BowTieXP
for quick analysis and visualization of the results.
To do this, on the survey editor there are two buttons for exporting to and importing from Excel. The export button
will create a Microsoft Excel workbook in which you can enter answers and remarks to each question. Using the
import button, you can then import the filled out sheet, and the results will be stored in a new fill-out in the
treeview.
This allows you to send the survey to potentially many people, and receive the answers back via e.g. email. You can
then import them all at the press of a button.
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To export and import an Excel sheet, double click a Survey or right-click a survey and select ‘Edit Survey’. In the ‘Edit
Survey’ window, it is possible to select ‘Export Fill Out’ or ‘Import Fill Outs’

Figure 229 – Importing and exporting Excel fill outs
Note: you can also drag the filled out Excel sheet onto the scrapbook and into the treeview from there.
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Figure 230 - Fill out in Microsoft Excel

24.10. Viewing results
The relevant answers returned can be viewed graphically:

On the survey editor form in the results pane.

On the barrier editor form on the audit results tab page (only answers related to that barrier).

On the activity editor form on the audit results tab page (only answers related to that activity).

On the barrier shapes in the diagram (by using the Audit Filter).
On the editor the results of a particular survey are displayed as positive/negative bar graphs, one bar per question.
Right click on a single bar and select ‘View details’ to show the details of all answers given for that question. Also
the number of fill outs received for the Survey is shown. It is also possible to filter on a specific survey,
organizational unit, date, fill outs or the results (for instance to only show negative results).
Note: Throughout this document the bar graphs use the green color on the right hand side to indicate
positively keyed answers, and red on the left hand side to indicate negatively keyed answers. However,
these colors are not optimal for people born with color blindness, that’s why in the application the
positive and negative colors can be configured in the BowTieXP options screen.
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Figure 231 - Viewing survey results in the survey editor

Figure 232 - Detailed overview of question results
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Figure 233 - Viewing audit results in the barrier editor
To see results displayed on the bowtie. The Audit filter needs to be turned on. Go to Filters in the toolbar and select
Audit filter (see Figure 234).

Figure 234 - The audit filter on the bowtie
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Figure 235 - Showing audit results on the diagram
Clicking on a bar of a graph will show the answers given in a separate dialog form. You can also configure the
diagram to show only results from a specific survey and a specific respondent (fill out). There’s also a date filter and
a filter to show a specific section of results. It is also possible to filter the audit results for a specific organization
unit.

24.10.1. Interpretation
In essence BowTieXP is a qualitative tool and so is the question framework. All the different answers get counted
and displayed as clear as possible, but it is up to the BowTieXP user to draw any conclusions and take corrective
measures where needed.
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24.10.2. How to read the positive/negative bar charts
Example question and resulting graph:
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description
Single answer
Somewhat positive answer

meaning
Single answer

Single answer
Most positive answer

Single answer

8 answers (n=8)
Even distribution between negative and
positive answers

Uncertainty

Representing 8 answers (n=8)
Mostly negative answers

Negative tendency

Representing 8 answers (n=8)
Answered all most positively

Fully positive

Representing 8 answers (n=8)
Mostly neutral answers

Neutral tendency

Representing 8 answers (n=8)
All answers are all centered / fully neutral

Fully neutral

No answer data available

Not answered

24.11. Long format surveys (Audit module in BowTieServer only)
The audit module in BowTieServer has extended audit possibilities. Not only in the form of reports, but also by
means of the long format surveys. This enables the user to extend an audit question with sub questions named
‘work instructions’.
The questions created in AuditXP should be choice questions with an ordinal scale. With the long format surveys it’s
possible to extend the audit questions with work instructions to also ask for instance open ended questions and
questions with a nominal answering scale.
For instance, an audit question might be: “Is lane departure waning hardware installed on all company vehicles?”.
An ordinal choice based AuditXP audit answer possibilities could be ‘Yes’ and ‘No’. From the set of possible answers
only one answer can be selected by the respondent and remarks can be added.
With work instructions, we can add a set of sub questions which can have different answering inputs. The work
instructions for this audit question might be:





“Which type of LDWS is installed?”
“Is the LDWS calibrated?”
“What is the certification type of the LDWS?”
“What is the expiration date of the certification of the LDWS?”

In BowTieServer, the main audit question (in the example above: “Is lane departure waning hardware installed on
all company vehicles?”) will be posed first. After which the work instructions are presented. Once the work
instructions are filled in, a judgement can be given by the user on the main audit question. Attachments can be
inserted as well, for instance to provide additional information or evidence.

24.11.1. Adding work instructions
To set up the long format survey with work instructions on an audit questions, double click the question to which
you would like to add work instructions to. Subsequently select the tab ‘Work instructions’ and select the icon
‘Add.’ to extend the audit question with a work instruction.

Figure 236 - Adding a work instruction in the ‘Work instructions’ tab
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When ‘Add’ is selected, you will be prompted with an ‘Edit work instruction’ window. There are multiple ways of
presenting work instructions answering inputs for an audit questions by selecting ‘Input type’.
When input type ‘Text’ is selected, the respondent is able to insert text. Check the box ‘Allow multiple lines’ to
provide the user with an opportunity to extend the text answer input in the box over multiple lines.

Figure 237 - Input type 'Text'
When input type ‘Choice’ is selected, the user can create choice based answer values. Check the box ‘Allow multiple
lines’ to allow for checking multiple boxes. If the box is unchecked, the respondent can only insert one answer using
a radio button.

Figure 238 - Input type 'Choice'
When input type ‘List’ is selected, multiple work instruction columns can be added with a ‘Text’ or ‘Choice’ based
input by selecting ‘Add’.
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Figure 239 - Input type 'List'
When ‘Add’ is selected, you will be prompted with the ‘Edit work instruction column’ window. It is possible to add
‘Text’ or ‘Choice’ based answer values for the work instruction column in the ‘Edit work instruction column’
window.

Figure 240 - Input type 'Text' for the work instruction column
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Figure 241 - Input type 'Choice' for the work instruction column
Select ‘OK’ to add the work instruction or work instruction column to the audit question.

24.11.2. Enabling the long format survey
Once work instructions have been added to an audit question, and the audit questions have been added to a
survey, the long format survey with the work instructions need to be enabled. To enable the long format survey,
check the box ‘Use long question format’ in the ‘Edit Survey’ window. The ‘Edit Survey’ window can be opened by
double clicking a survey.

Figure 242 - Enabling the long format survey
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25

Compliance frameworks
This section covers how to set up the compliance
frameworks and how to link them to barriers.

The compliance frameworks are part of the audit module. BowTieServer also supports the compliance functionality
with some additional dashboards.

25.1. Concept introduction
To use the compliance frameworks functionality effectively, it is important to understand the underlying idea and
concept that was used during the design of this feature. This will be explained in the following section.

Figure 243 - Compliance framework concept with example
The feature was introduced to bridge the gap between BowTies (i.e. barrier-based risk management) and the world
of compliance assurance. There are many standards, covering wide subjects ranging from quality control to safety
management. Some of these are considered best practices, where others even have legal implications. However,
compliance standards are usually not foolproof plans for the
In this module, we assume that most of standards (if not all) can in essence be broken down into a collection of
‘control objectives’. These control objectives can be seen as statements that describe a requirement which the
organization’s management system needs to be capable of. To check whether the control objective is met by the
company, it must first be determined which part of the management system takes care of this objective. Once it is
clear which part of the system is responsible, it must also be verified whether that system is effectively
implemented and functional.
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In the example shown in Figure 243, the aviation related BARS standard (http://flightsafety.org/bars/) has a control
objective that describes the requirements for a bird control unit. This objective is realized in the barrier “bird
control program” and perhaps in additional activities such as “cut hedges and tall grass” which can be associated
with a different barrier. In turn, barrier-based audits can be linked to the barrier. This then shows us the
performance of that barrier, which in turn helps us to make a decision on whether this objective has been
effectively implemented or not.
So, by looking at which barriers and activities within the organization take care of a control objective, and by looking
at the performance of those activities and barriers we can draw a conclusion on whether the objective has been
effectively met.
This concept has various advantages. First, the feature visualizes how the control objectives of one (or multiple)
compliance standards are intended to be realized through the barriers and related activities. If a control objective
can be mapped on a BowTie, it demonstrates that a barrier system has been defined that takes care of that
objective. If an objective cannot be mapped, this means that either no system has been defined that takes care of
that objective or that this objective cannot be directly mapped onto the barrier-based model. This process can
visualize how standards and legislative requirements map on BowTie diagrams and increase the understanding of
why certain barriers are important.
Secondly, it can help to reduce the audit workload. In this model it is possible to link multiple standards onto the
same set of BowTies. It is very likely that one barrier realizes requirements from multiple different standards.
Traditionally, compliance with standards is checked with a specific audit for that standard. If a barrier represents
multiple objectives from multiple standards, this often means that the barrier has to be audited for every standard
in which it is mentioned. This can lead to repetitive audits that add little additional insight into the barrier yet create
additional audit workload. Instead, with this model multiple standards can be linked to a barrier, but the quality of
the implementation of that barrier is done by a single set of questions. So, by auditing the quality of the barrier, we
can derive through the barrier whether the standard is complied with.

25.2. Setting up compliance frameworks
In general, compliance frameworks can be set up and used in the following two steps:
1.
2.

Create / import the control objectives
Link the control objectives to the barriers

These will be explained in the following sections.

25.2.1. Creating / importing control objectives
A new compliance framework can be added to the BowTieXP casefile under the “Compliance Frameworks” node.
This can be done by right-clicking the node and defining a new name for the framework.
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Figure 244 - Add compliance framework
A compliance framework contains two collections which can be defined as shown in Figure 245:
-

Maturity levels: Many standards come with their own set of maturity levels. These are used to indicate
how well an objective is realized (i.e. complied with) within the organization.
Objectives: These are the actual statements that are described in the standard which the organization
must comply with.

Figure 245 - Defining objectives and maturity levels
Objectives can also be imported from Excel sheets using the Import External Data option in the File menu.

25.2.2. Linking Objectives to Barriers
Once the Objectives are defined in the file, they can be linked to their relevant barriers. This can be done like any
link collection by dragging and dropping the objectives from the treeview to the barriers. Alternatively, the
Objectives tab on the barrier editor can be used (similar to other link collections). Or the Assigned to Barriers tab on
the Objective.

Page 201 of 263

Figure 246 – E.g. drag/drop objectives to assign (1 of 3 assignment methods)

25.3. Interpreting Compliance Frameworks
An overview of all objectives and related barriers can be found in the Case Overview. This overview shows all
objectives and whether they have been assigned to barriers. By double clicking on an objective, the audit results of
all linked barriers can be displayed.

Figure 247 - Case Overview for compliance frameworks
In the objective editor, the tab “audit results” shows all audit results of all barrier and activities onto which this
objective has been linked. This information can then be used to decide which to which maturity level this objective
has been established. Once assigned, the maturity level will also be displayed in the corresponding column in the
case overview.
Another overview of states can be seen on BowTieServer which is described in the BowTieServer manual.
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26

SharePoint add-on

This chapter describes how BowTieXP integrates with
Microsoft SharePoint.

26.1. Introduction
Microsoft SharePoint is a set of web-based software elements for on-line collaboration, offering elements such as
process management, search functions and document management.
For more information on Microsoft SharePoint, please refer to the Microsoft SharePoint web site located at
http://sharepoint.microsoft.com.
This chapter assumes basic familiarity with SharePoint.
SharePoint integration in BowTieXP consists of two sets of functionality:
1. The ability to use the SharePoint document libraries,
2. The ability to take SharePoint custom lists offline, edit them and sync changes.
BowTieXP supports SharePoint Document Libraries as a place to store documents. The SharePoint document
libraries can be used by BowTieXP to save, load and version BowTieXP case files, taking full advantage of all the
features offered, such as:

User and group security,

Checking out and in of files,

Automatic file versioning,

Storing of metadata with the files,

Customizing workflows.
Once your case files are in SharePoint, you can also license our SharePoint Web Part viewer for bowtie diagrams,
allowing the bowtie diagrams to be shown inside SharePoint web pages in an interactive manner (zooming,
panning, changing display options).
BowTieXP allows you to:
1. Check out,
2. Check in,
3. Determine version numbers,
4. Get previous versions and
5. Compare versions.
BowTieXP also allows you to store a copy of SharePoint custom lists within a BowTieXP case file. You can store as
many lists as you want. In addition to just making a copy, BowTieXP also allows you to create, modify and delete
items from the list and sync any changes made with the online version.
In this chapter we will walk through all this functionality and take a close look at how to use these features to the
fullest.

26.2. Supported SharePoint versions
BowTieXP supports all flavors of SharePoint, as long as they are built on WSS 3.0 SP1 or newer.
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Examples of different flavors are:
1. Plain Windows SharePoint Services (WSS) 3.0 SP1 or newer, a component of the Windows Server OS.
Please ensure you update WSS to the latest service pack, which at the time of writing is SP2.
2. Microsoft Office SharePoint Services (MOSS) 2007. MOSS runs on top of WSS and adds components to
integrate with Office 2007.
If you want to use the SharePoint add-on, there are also requirements on your SharePoint server configuration.
Please see section 30.13 for details.

26.3. Note about SharePoint Explorer and authentication
BowTieXP’s SharePoint explorer makes use of the Windows system cached credentials stored by the Windows
Credential Manager. (Control Panel\User Accounts and Family Safety\Credential Manager)
In rare cases it has been reported that a user cannot login to the remote SharePoint site with the BowTieXP
SharePoint Explorer while having no problems accessing the site with a normal web browser. In this case we
recommend clearing all cached credentials of the target location in the Windows credential manager first. Usually
after this has been done the user is able to login using the BowTieXP SharePoint Explorer with no problems.

26.4. The BowTieXP SharePoint explorer / document libraries
To work with SharePoint Document Libraries in BowTieXP the following menu entries are available:

Figure 248 - SharePoint options in the file menu
Menu entry

Description

SharePoint Explorer...

Opens the SharePoint Explorer, which allows you to open files from a SharePoint
document library.

Save to SharePoint as...

Saves the current file to SharePoint, allowing you to choose the location and
filename.

When you select the SharePoint explorer from the file menu, you will be presented with an empty explorer screen:
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Figure 249 - SharePoint Explorer's connect button
We will need to connect to a SharePoint server first. When you press the connect button, you can enter an url to
the SharePoint site and enter your credentials:

Figure 250 - Connecting to a SharePoint server
BowTieXP will keep track of your recently used sites and accompanying credentials for you.
After entering our site URL and credentials, BowTieXP will contact the server and get all information. The first time
this might take a little while, but that will get faster as data is cached.

Figure 251 - Connected SharePoint explorer
This explorer is pretty similar to the Windows explorer, showing a tree of folders on the left hand side, and the
contents of what we select there on the right hand side.
When we click a document library, BowTieXP will load the contents of the library for us and show it in the righthand side. BowTieXP will also determine relevant document library settings and show those too:

Figure 252 - SharePoint explorer showing files
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In this example, the document library required check out/in in order to edit files, versioning is enabled. There are
two files in the library. We can see all the file details in the columns, including custom data for this document
library.
If we select a file, the toolbar buttons are enabled. The buttons are also available via the context menu:

Figure 253 - SharePoint explorer's file context menu
Here we can open the file and check it out if we want to edit it, just open it if we want to view it, change metadata
properties, show the version history, etc.
As you can see, we can almost everything we can do with regular files too such as comparing the file against the
currently open file or importing entities from it.
Menu Option

Description

Open in BowTieXP and
Check Out

Checks the file out, and opens it in BowTieXP for editing

Open in BowTieXP

Opens the file in BowTieXP, without marking it as checked out

Edit/View Properties

View the custom properties

Check Out

Checks out the file

Show Version History

Shows the version history

Download

Downloads the file to a location of your choosing

Compare with currently
open case file

Compares the selected file against the currently open file

Mark for comparison

Marks this file for comparison against another file in SharePoint

Import Entities

Imports entities from the selected file

Copy Link Location

Copied the url to the selected file to the clipboard

Refresh

Refreshes the view so it is up to date with the SharePoint server

Delete

Deletes the selected file from the document library

There are also context menus available on the left hand side of the explorer, which allow you to create, delete and
rename sub folders and disconnect from the server:
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Figure 254 - Folder operations
Menu Option

Description

Rename Folder

Renames the selected folder

Create Subfolder

Creates a new subfolder below the selection

Delete Folder (Subfolder)

Deletes the selected subfolder and all documents and subfolders contained in
it

Refresh

Refreshes the view

Copy Link Location

Copies an url to the selected location to the clipboard

Figure 255 - Server operations
Menu Option

Description

Refresh

Refreshes the view

Copy link location

Copies a url to the selected location to the clipboard

26.4.1. Check in and check out
Please note that it is possible to view a file in BowTieXP from a document library which has check in/out required,
without checking it out.
To remind you that if you want to modify the file, you really should check it out, the following reminder is displayed:
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Figure 256 - Checkout reminder

26.4.2. Metadata
Whenever a BowTieXP Case File is saved to the SharePoint Server, such as by saving, checking in, publishing as new
major version, the SharePoint metadata belonging to the file must be updated or confirmed.

Figure 257 - Filling in metadata
This metadata can be shown and updated by clicking the "Edit/View Properties" toolbar button or context menu
item in the explorer.
The fields that can be edited in the dialog that pops up are the columns of defined on the SharePoint document
library and/or the SharePoint content type. The dialog is created dynamically based on the fields/columns defined
on the SharePoint Server.

Figure 258 - Metadata on the web
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Figure 259 - Metadata in BowTieXP

26.4.3. Metadata – supported field types
BowTieXP supports the following SharePoint field types:
Field Type

Description

Supported in
BowTieXP

Boolean

Used to store a TRUE/FALSE value.

Yes

Choice

Allows the user to specify a predetermined set of values that can be
used to enter data into the field.

Yes, except fill-in
choices

Currency

Allows for a currency value to be entered. Each currency field is tied
to a specific locale’s currency. In all other respects, it is treated like
the Number field type.

Yes

DateTime

Allows for storage of a fully qualified date or time of day. Use the
Format attribute to specify date formatting.

Yes

Integer

Allows for positive or negative integer values.

Yes

Lookup

Behaves very similarly to a Choice field, except that the available
options come from another list rather than being a hard-coded
selection of values.

Yes

LookupMulti

A Lookup field that can contain more than one value.

Yes

MultiChoice

Specifies a Choice field that implements check boxes and allows the
user to select multiple values.

Yes, except fill-in
choices

Note

Allows users to enter multiple lines of text. This field is not sortable
or groupable.

Yes

Number

Allows for a floating point number to be entered.

Yes

Text

A single line of text entered in an edit box.

Yes

User

Lookup field that references a user.

Yes

UserMulti

A User field that can contain more than one value.

Yes

26.4.4. Comparing versions of a case file
If versioning is enabled on the document library you are using, then one of the great benefits you get is that you can
compare the revisions to see what has changed. In BowTieXP you can do this with these steps:
1.
2.
3.

On a SharePoint explorer case file entry select "Mark for Compare" from the context menu.
On a second explorer case file entry select the "Compare with '<first file name>'..." from the context
menu.
The file comparison is shown.
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26.4.5. SharePoint versioning
Instead of overwriting and discarding the old file when a newer version is saved, SharePoint can keep a version
history of that file. Every time you save your document, you will create a new version of the document - no file will
be lost because you can go back and view/open the older versions.
SharePoint versioning settings are managed by the SharePoint administrator on the SharePoint document library
level.
See http://technet.microsoft.com/en-us/library/cc288279.aspx for details on how to turn on versioning in
SharePoint.
If SharePoint versioning is turned on for a document library, the BowTieXP client will indicate this in the explorer
and you will be able to load the version history of all case files stored that library.

Figure 260 - How to display version history

Figure 261 - Opening an older version

26.4.6. Versioning - major and minor versions
By default, when versioning is enabled on a document library, versions are numbered 1.0, 2.0, 3.0, 4.0, etc. These
version numbers are what are known as major versions.
Major versions are considered published and everyone with the proper access rights can see them.
In addition to major versioning the document library can also be set to enable minor versions, e.g. 0.1, 0.2, 0.3, etc.
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Minor versions are not considered published; they are more or less like a working draft. Only users who have been
granted access can see and open the minor versions.
Minor versions can be published as a new major version. Publishing a minor version as new major version can be
done from the SharePoint explorer:

Figure 262 - Publishing a new major version

26.4.7. Check in/out required
The SharePoint administrator can decide that in a particular document library the files must be checked out before
saving any changes in:

data

meta-data

minor/major version
BowTieXP will indicate this if this is the case.

26.4.8. Require approval
The SharePoint administrator can set the document library to require approval before anything can be saved to it.
When you save anything to such a document library, you start a content approval process in which content is first
saved as a draft. After approval this draft can be promoted to a normal version. Approving content cannot be done
from BowTieXP; it must be done using the regular SharePoint method, i.e. a web browser.
The approval status of a case file can be seen in the SharePoint explorer.

26.4.9. Email notification
SharePoint allows users to be notified of changes to specific files, or to entire document libraries. You can do so via
the SharePoint web interface:
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Figure 263 - Subscribing to chance notifications
Whenever a case file is changed, also when it is saved through the BowTieXP SharePoint explorer, all subscribers
receive an e-mail notification.

26.5. BowTieXP web viewer for SharePoint
26.5.1. Introduction
The BowTieXP Web Viewer for SharePoint 2010 is a web part for displaying BowTieXP case files in a browser. The
viewer is capable of showing files stored in document libraries on SharePoint.
Note: the web viewer is a separately licensed product.
The web viewer for SharePoint is built on Microsoft’s Silverlight technology. This technology is slowly
being phased out by all major web browser vendors. Currently (Jan 2016), Chrome no longer supports
Silverlight, Firefox is intending to drop support soon, Microsoft’s own Edge browser also does not support
Silverlight. Internet Explorer 11 still supports Silverlight fine.
A more future-proof solution for viewing BowTies on the web is the BowTieServer web viewer
component, which is built on html5. This is a future proof solution which also works on tablets and
phones.

26.5.2. The BowTie browser
Depending on the configuration of the web part, you will initially see one of the following things: the library
selector, the case file selector, the hazard selector or the diagram viewer.
The library selector (Figure 264) can be used to either select a library, or to open a BowTieXP case file directly.
Document libraries can be expanded using the + and – icons next to the library name. The document library only
shows document libraries that actually contain one or more BowTieXP files.
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Figure 264: The library selector
The case file selector (Figure 265) shows all case files in the selected document library. From here you can click to
the case file overview.

Figure 265: The case file selector
The case file overview (Figure 266) shows the bowtie groups in the case file, grouping the hazards below it. Clicking
on a hazard opens the diagram viewer.

Figure 266: The case file overview
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26.5.3. Diagram viewer
Figure 267 shows the BowTieXP diagram. At any time, as long as you’re not in full screen mode, you can go back to
the hazard browser by clicking “Back to hazards”.

Figure 267: The BowTieXP diagram viewer
Figure 268 shows the tool bar, which offers diagram navigation and customization options. Table 1 gives an
overview of the buttons on this toolbar.

Figure 268: Web viewer tool bar
Icon

Function
Zoom in
Zoom out
Set zoom to 100%
Full screen mode
Center diagram on selected shape. If no hazard is selected, the diagram centers on the hazard.
Expand level 1: Show hazard & top event.
Expand level 2: Show hazard, top event, threats, and consequences.
Expand level 3: Show hazard, top event, threats, consequences, and barriers.
Expand level 4: Show hazard, top event, threats, consequences, barriers, and escalation factors.
Expand level 5: Show hazard, top event, threats, consequences, barriers, escalation factors, and barriers on
escalation factors.
Expand level 6: Show everything
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Display options. See section 26.5.4.

Table 1: Tool bar buttons

26.5.4. Display options
Using the display options, you can show extra information on BowTie elements and color them. You can open the
display options by clicking on the Display Options icon, as shown in Table 1. Figure 269 shows the display settings
dialog, with the “Extra Info” tab selected.

Figure 269: The display settings dialog
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By checking the “Show” checkbox next to the properties, you can show extra information on elements on the
diagram. Color mode determines the color type of the extra information shown on the diagram.
Under the colors tab, as shown in Figure 270, you can select the properties by which the diagram elements are
colored. For example, you can color barriers by effectiveness, as shown in the screenshot.

Figure 270: Assigning colors in the display settings
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27

Introducing BowTieXL

This chapter introduces BowTieXL and discusses the
general architecture.

27.1. Introduction
To meet customer demand of having the possibility to create quantitative and semi-quantitative analyses, built on
the bowtie model, BowTieXL has been developed.
BowTieXL introduces a Microsoft Excel compatible spreadsheet into BowTieXP, which exposes the majority of the
information in the case file as tabular data in this spreadsheet. This allows you to use that data to do spreadsheet
calculations based on that data, and feed the results back into your bowtie model.

Figure 271 - Screenshot of BowTieXL
Apart from being able to do calculations based on the bowtie model data, you can also use BowTieXL to:

Store reference information in spreadsheets, which are stored in the case file,

Add notes and calculations which serve as underpinning of the analysis in the case file,

Add general reference information into the case file,

Use the tabular representation of the bowtie model data to quickly edit data in bulk,

Use Excel formulas to create custom aggregated displays of data on the diagram,

And much more…
Note: If you intend to use BowTieXL in combination with BowTieServer, please be aware that
BowTieServer does not store the spreadsheets but does store user data. BowTieServer also does not
recalculate any formula. Please contact CGE support for details on what this means for your specific case.
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27.2. Assumed knowledge
This chapter assumes the reader has a basic knowledge of working with Microsoft Excel. The following topics are
assumed to be known:





Basic formulas, working with single cells and ranges
=A1+B2
=SUM(A1:A5)
Absolute and relative cell references
A1, $A1, $A$1 and Sheetname!A1
what the $ modifier does and how Excel treats it when copying your formulas
Named ranges
The Excel IF function

Bonus points if you are already familiar with:

Hiding and unhiding sheets

Sheet and cell protection

27.3. Displaying the spreadsheet
To view the spreadsheet, select View  Windows  Spreadsheets from the menu. The spreadsheets will be
displayed.

Figure 272 - How to display the spreadsheets
You can also bring them up using the keyboard combination of Control-W, Control-X, pressed after each other.
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Figure 273 - The spreadsheets
This spreadsheet should be pretty familiar - it is Microsoft Excel compatible in most regards - most keyboard
shortcuts are there, the mouse actions are the same, formulas are identical. The formula bar and cell reference bar
also work the same.
Some of the toolbar buttons will also be familiar, but some will not. We will describe them here.
Button
and

Function
Disable and enable entire spreadsheet - this is used to speed up BowTieXP if the spreadsheet is
not needed.
Save the built-in workbook as an xls or xlsx file.
Save and open the built-in workbook in Microsoft Excel.
Open and replace the built-in workbook.
Add or remove escalation factors from spreadsheet.
Add a new sheet.
Delete the current sheet.
Rename the current sheet.

Button

100%

Button
Calibri
11

Function
Print
Print Preview
Cut
Copy
Paste
Sort Ascending
Sort Descending
Zoom
Show Managed Sheets
Refresh
Function
Font
Font Size
Bold
Italic
Underline
Align left
Align center
Align right
Borders
Font color
Background color
Set hex color definition
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Note that the number of options is much smaller than in Microsoft Excel - BowTieXP only offers a basic set of editing
functions.
We recommend exporting the sheet to Excel and editing it from there if you are working on a big complicated
spreadsheet. You can do this with these two buttons:
Saves the built-in spreadsheet to disk under a name of your choosing and open it in Excel.
Replace the built-in spreadsheet with a file on disk (usually the one you exported and edited in Excel).
When saving the sheet to disk, note that all the managed sheets (see below) containing almost ALL data in your
entire BowTieXP btf case file is present in those sheets!
This data is not immediately visible as the sheets are hidden and protected by default, to prevent you accidentally
editing them and cluttering up your display with all these sheets.

27.4. Tabular representation of case file data
By default, all you see when displaying the spreadsheets, is a single empty sheet. All the case file data is hidden.
To show it, you need to press the following toolbar button:
and hide the sheets managed by BowTieXP:

. A drop down will appear which allows you to show

Clicking a checkmark will display the corresponding sheet. Note that your sheets, the so-called user sheets are
always visible.
Note: Some information is currently unavailable as tabular data but might be added in the future. If you
are missing data, please contact support@cgerisk.com.
Let's open the test case file and unhide the effectiveness sheet:

Figure 274 - Tabular representation of effectiveness values
Please note that these sheets are controlled by BowTieXL - you cannot modify them, except for the light-yellow
cells. Editing these will actually change the definition of the item, and you will see the item update where it is
visible, such as in the Treeview or the diagram.
Color
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Meaning

Yellow
Gray
Pale Yellow
Orange

Heading
Not editable
Editable
Not yet editable, will be implemented in a future version

Let's take a look at the threats spreadsheet, in the hazard/diagram sheets:

Figure 275 - Tabular representation of threats
Please see how the parent hazard is filled in: Those cells contain the sheet and cell reference of where to find the
parent hazard of each threat.
You can see the parent hazard for the first threat is "Hazard!$B$2". If we take a look at the hazard sheet:

Figure 276 - Part of the hazards sheet
We see that "Hazard!$B$2" refers to 5.4.4.1, "Heating chemicals in the Catalyser Heater". How we can use these
sheet and cell references in calculations, we will show later on.

27.5. Editing via the spreadsheet
Editing items is as easy as modifying cells in Excel. You can copy, paste, type, and do any of the normal cell
modifications you can do in Excel, except now you are directly editing your bowtie data.
Bulk adding of data from external data sources such as e.g. Excel is a breeze - simply copy and paste.
Note that you cannot remove or add items to a sheet directly - you cannot add and delete rows. There's a simple
workaround for that: add a whole bunch of items in the Treeview by using copy and paste, then paste over those in
the spreadsheet, and delete the excess items.

27.6. User defined data
In order to leverage the usefulness of the bowtie model data, BowTieXL introduces the addition of user-defined
data fields to all objects in the case file. For example, we can add numerical frequency fields to barrier effectiveness,
allowing us to calculate with this value via barriers.
Custom data is defined per object type. If we define a field called 'Frequency' on any effectiveness value, that field is
immediately available on all effectiveness values.
Adding custom data is done by means of the editor. It now has a tab, called 'User Data", which allows us to add, edit
and delete these extra fields.
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Figure 277 - User data editor
The "Add Key" button allows us to define an extra field on a type. Once we define a new key name on a type, e.g.
barriers, each barrier will now have this field.
The delete key removes a field. Note that this will remove whatever is filled in on any object of the same type!
The rename key allows you to change a key name.
The Key default value allows you to add a standard value that is added to each new item. This is useful if each new
element should automatically get certain formulas.
Another way of looking at what we are doing when we add user data, is that we are adding columns to the
spreadsheet. Take a look at the effectiveness spreadsheet:

Figure 278 - Tabular representation of effectiveness values with custom data
As you can see in the user data editor, we have defined a key called "Frequency" on effectiveness values, and you
see that column in the sheet all the way to the right.

27.7. Showing user data on the diagram
User data fields can be shown on the diagram by selecting the field to show in the DiagramDiagram Options. Here
you can choose which user data field to show on which type. This is limited to the elements in the bowtie. For
instance, user data that’s added to an effectiveness value cannot be displayed on the bowtie, whereas user data on
a barrier can be displayed.

27.8. Formulas in user data
When showing user data on the diagram, and if a user data value contains a formula (starts with an '=' equals sign),
the formula is interpreted and the results are displayed. This allows you to bring calculation results from the
spreadsheets back into the bowtie diagram.
The formulas are evaluated in context of the managed sheet for the type - formulas on barriers are evaluated in the
BowTieControl sheet, formulas on threats on the Threat sheet.
In the next chapter we will take a deeper look into what we can use this for.
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27.9. Coloring using user data
If a user data contains a html color code, it can be applied to the shape it is on. Html colors are color definitions look
as follows:
#rrggbb
Where rr is the amount of red, gg is the amount of green, and bb is the amount of blue. These numbers are in
hexadecimal.
If you are not familiar with hexadecimal notation, you can use the built-in color picker to choose and apply a color:

Figure 279 - Selecting an html color code for a cell
After selection, the color is applied, and the code is put into the cell:

Figure 280 - Applied html color code
There are many references on the internet about html color codes, such as http://html-color-codes.info/.
In the next chapter we will show how to use this in depth, such as creating color lookup tables.
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28

Calculating with BowTieXL
Now that we have a basic understanding of what
BowTieXL comprises, we delve into best practices for
calculating with the bowtie data.

28.1. Introduction
Calculating with BowTieXL is not hard if you have a good working knowledge of Microsoft Excel formulas.
Assuming you are familiar with concepts such as cell references, relative (e.g. D14) and absolute (e.g. $D$14),
summing and adding of ranges, and the IF function you should have little trouble getting started quickly.
One important concept we will work a lot with is the concept of indirect cell references, which we will explain next.
Note: If you intend to use BowTieXL in combination with BowTieServer, please be aware that
BowTieServer does not store the spreadsheets but does store user data. BowTieServer also does not
recalculate any formula. Please contact CGE support for details on what this means for your specific case.

28.2. Indirect cell references
In order to do calculations in Excel, it is preferable to have all the information we need in a single table. However,
the information in BowTieXL is spread out over many tables in many sheets, linked together by means of cell
references.
Take a look at the barriers sheet:

Figure 281 - Barriers sheet (some columns left out)
In order to do meaningful calculations, we need to bring information together. We need to be able to use
"Effectiveness!$B$4" cell references, and bring properties of that effectiveness value into our own worksheet.
Conceptually, what we want to do is as follows:
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Figure 282 - Following cell references to the wanted information
Step 1, blue arrow: From a cell reference in our worksheet, we need to go to the barriers sheet to the specified cell,
and get the name of the barrier.
Step 2, green arrow: We need to get a cell from a different column in the barriers sheet, to bring the barrier's
effectiveness into our sheet.
Step 3, red arrow: We need to go to the effectiveness sheet, and bring the effectiveness code into our sheet.
Step 4, turquoise arrow: We need to get a cell from a different column in the effectiveness sheet, and bring it into
our sheet.
Now we should end up with our sheet looking like this:

Figure 283 - Sheet with reference info brought in
Column B is the cell reference to the wanted barrier.
Column C is the result of step 1, the blue arrow: the barrier name.
Column D is the result of step 2, the green arrow: the barrier's effectiveness cell reference.
Column E is the result of step 3, the red arrow: the effectiveness code.
Column F is the result of step 4, the turquoise arrow: the effectiveness frequency.
With this sheet it's pretty straight-forward to e.g. calculate the average effectiveness frequency.
Now onto the formulas on how to accomplish this: Microsoft Excel, and therefore also BowTieXL, offers a couple of
functions designed to do exactly what we set out in this section.

28.2.1. The INDIRECT function
The INDIRECT function allows us to treat a textual cell reference as an actual cell reference.
Take a look at this demonstration:

Page 225 of 263

Figure 284 - Workings of the INDIRECT function
In Cell B2 we have the location of interest, in this case the text value D4. By means of the INDIRECT function, we can
get at the value in the cell we specified - we turn the text value into a reference.
This is can be seen in cell B3. The formula in B3 is =INDIRECT(B2), and the value displayed is "Mike", the value
present in cell D4.
This works for all possible cell references, such as:

just a cell coordinate, e.g. B3

sheet + cell reference, e.g. Sheet2!D24

filename + sheet + cell reference, e.g. [D:\test.xlsx]Sheet1!E5
Note that for the last reference to work, the target file has to be open, or you'll get a #REF error.

28.2.2. The OFFSET function
Getting the contents of the cell we specified is nice, but gets us only half-way - we would only get the indicated
column, so we need a way to shift to the right from the reference. The OFFSET function comes to the rescue.
The offset function allows us to step away from a reference in either direction. Usually we want to move to the right
to get at the different properties of e.g. an effectiveness value.

Figure 285 - Workings of the OFFSET function
As you can see in the above screenshot, we stepped one column to the right to get the age of the person we
selected.

28.3. Setting up the test case file for an example
As an example, we'll add a value called 'Frequency' to each effectiveness value, and calculate the average barrier
effectiveness frequency for each threat.
Note: This sample does not carry any real-world meaning, but only serves as an example on how to do
calculations.
1.
2.
3.
4.
5.
6.

Open the test case file (File  Open test case).
Select the 'Very Poor' effectiveness value.
Select the User Data tab in the editor.
Click Add Key. Enter 'Frequency' as the key name. Press Enter.
Double click the newly added line to edit it. Enter '2' as the value. Press enter to commit.
Edit the rest of the user values and apply the following values:

Effectiveness
Very Poor
Poor
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Frequency
2
4

Good
Very Good

6
8

If you go to the spreadsheets, show the diagram reference sheets, and take a look at the effectiveness sheet it
should look as follows:

Figure 286 - Desired effectiveness frequencies
The test case file is now set up for the examples in this chapter.

28.4. One-off calculations
The easiest method of doing calculations, is by copying and pasting or referencing the relevant data from the
different sheets, and calculating what is needed.
As an example we'll calculate the average effectiveness frequency of the barriers of the first threat in the test case
file we prepared earlier.
By taking a peek at the barriers worksheet, we see that there are four barriers on the first threat, and we are
interested in their names and effectiveness values, which reside in columns C and J. So we reference those:
Note: Be sure to notice the formula displayed in the top of the screenshots.

Figure 287 - Effectiveness values brought in
In the next column, we want to fetch the frequency field we defined for each effectiveness value, and for that we
need to INDIRECT the cell reference and OFFSET it by 7 columns (counted by hand in the effectiveness sheet):

Figure 288 - Effectiveness frequency brought in
Take note of the formula of C2 which you can see in the formula bar, just as we discussed.
Now we can calculate the average, and some nice colors and borders, and end up with:
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Figure 289 - Average effectiveness frequency calculated

28.5. Building dynamic sheets
In the previous sections we discussed the basics of building a sheet. They were easy to set up, but also fragile
because changes in the sheets can break your formulas. For example, with different versions of BowTieXP some
columns might shift, or users can reorder user data field columns themselves. If you do not anticipate this, it can
mean broken formulas or worse, undetected references to the wrong data. To avoid this, we will dive into making
sheets dynamic so they are less fragile.

28.5.1. The MATCH function to find columns
One of the main reasons why sheets break is shifting columns. To avoid this, we can find column by name instead of
by direct reference.
Let’s assume we want to find the effectiveness value that belongs to a barrier.
1.

OFFSET NUMBERS: we create a table where we list the horizontal coordinate for each column. We do this
by using MATCH to find a User data key in a range using three columns:

The first two columns are put in manually. In the third column we use this formula:
=MATCH(A2,INDIRECT(B2),0)
What this formula does is look for A2 in a range. A2 is Effectiveness in this case.
We get the range by using INDIRECT on B2. This translates the text that is in B2 into an actual range.
The last addition is 0, which makes sure that MATCH searches in the correct way (search for match_type
to find out more).
This makes sure that even if the Effectiveness column shifts, all of the formulas that reference
Effectiveness shift with it.
2.

Now that we have the dynamic offset, we can build a formula to create a reference that will keep working:

In the rest of the spreadsheet, column E just lists the barriers for easy reference using =BowTieControl!C2
In column F we manually put a reference to the first column of the BowTieControl sheet.
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Column G looks up the effectiveness value reference for each barrier using:
=OFFSET(INDIRECT(F2),0,$C$2-1)
We’ll break it down into steps.

First, OFFSET is used to move to the Effectiveness column and return the Effectiveness reference.

To do this, we first use INDIRECT(F2) to start us of in the first column of the BowTieControl sheet.

Then we don’t want a vertical offset, so the second parameter is 0.

The third is our dynamic horizontal offset $C$2. The dollar signs are there because we don’t want
the reference to that cell to change when we copy it down.

Lastly, you see we decrease the reference by 1. This is because if the effectiveness is in column 12,
and we offset it by 12 starting from the first column, we’ll actually end up in column 13. So we
decrease it by one to make sure everything is correct.
There were a couple of things shown in this section, but remember that the most important point is how to make
an offset that will keep working even when columns change position.

28.5.2. Calculating using the current row in user data
Because user data can get moved around due to reordering, inserting and deleting of barriers and other items, you
cannot just reference B2, B3, B4, as those will no longer point to the current row.
To fix this, there's a simple trick: We can return the current row number using the ROW() function. Using that we
can build an address which we can use with INDIRECT().
For example, on the Threats sheet we can use either of the following:
="Threat!"&ADDRESS(ROW(), 2)
="Threat!$B$"+ROW()

returns e.g. Threat!$B$2
returns the same :)

28.5.3. Detecting change in a column of values
It can be valuable to do a calculation across all the barriers on a threat or consequence. This section will explain how
to do that.
First, we make a list with all the barriers and include a column with threat and consequence references. Then we
have a column with in this case a barrier criticality value for each barrier (we won’t go into how to do this here, look
at the other sections for more details). The magic happens in the last two columns.

In column E, we want to have a counter that increases until the next threat or consequence line. Essentially, the
formula says: if the current cell is equal to the previous cell, increment the count by 1, else reset it to 1:
=IF(AND(B2=B1, C2=C1),E1+1,1)
The AND statement is to make it work for both the threat and consequence lines. If either a threat or consequence
is not the same, we reset the counter.
In column F, we use that counter to tell us when a new line starts, and how many barriers were on that line. Column
F essentially says: if the next cell is larger, do nothing, else, perform some action. This will result in the cell
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remaining empty as long as the counter is increasing. But as soon as the counter is reset, we perform some action.
In this example, we do a sum of all the criticality values.
In F4, we see the formula actually displaying something:
=IF(E3>E2," ",SUM(OFFSET(D2,0,0,-E2)))
The logic goes like this:
If E5 is greater than E4:
Do nothing.
Else:
Sum a range.
We get this range by using OFFSET. In this case, OFFSET starts at D4 and does not change its start position (hence
the two zero parameters). The next parameter indicates how high the selection needs to be, since we can specify
multiple cells to be selected by OFFSET. In this case, we say -E4, because we want to go up by the number of
barriers on the line, which can be found in E4.

28.5.4. Removing #N/A values
Sometimes values have not been filled in, which can cause formulas to give a #N/A value. This is ugly and likely not
what we want to show. We can catch it by including another column which tests for #N/A values.

In this example, we have column A with results, but some of the results result in an error #N/A. To deal with this
gracefully, we add another column B called Tested result, where we put the following formula:
=IF(ISERROR(A2),"No data",A2)
This tests if A2 contains an error, and if that is the case, it will put “No data” in the cell. If the cell does not contain
an error, it will just put in the value for A2.

28.5.5. Compacting a column of values
After following section 28.5.3 where we calculate across all the barriers on a line, we get a list of values with spaces
in between them. This is a pattern we see a lot, and users often want to remove the whitespace and get a single list
of values. This section describes a way to compact a list of values with blank cells. See this example:
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This sheet calculated whether each threat and consequence was sufficiently controlled. This leads to columns I, J
and K. There is a lot of whitespace, so we want to compact it. The core formula is VLOOKUP in columns M and O.
The formula is quite straightforward:
=VLOOKUP(Threat!B2,I:K,3,FALSE)
We search for the first threat name (Threat!B2) in columns I to K (I:K), and return the value in the third column.
FALSE indicates that it should look for an exact match.

28.6. Excel reference
These are some commonly used functions that we use in BowTieXL. Descriptions taken from techonthenet.com.
Formula

Description

IF( condition, [value_if_true], [value_if_false] )

Normal If statement. Can be used for all kinds of
conditional statements.

ISERROR( value )

Returns True if the value is an error value.

ISNUMBER

Returns True if the value is a number

INDIRECT( string_reference, [ref_style])

Returns the reference to a cell based on its string
representation.

ADDRESS( row, column, [ref_type], [ref_style],
[sheet_name] )

Returns a text representation of a cell address.

OFFSET( range, rows, columns, [height], [width] )

Returns a reference to a range that is offset a
number of rows and columns from another range or
cell.

ROW( [reference] )

Returns the row number of a cell reference.

COLUMN( [reference] )

Returns the column number of a cell reference.

VLOOKUP( value, table_array, index_number,
[not_exact_match] )

Performs a vertical lookup by searching for a value
in the left-most column of table_array and returning
the value in the same row in the index_number
position.

MATCH( value, array, [match_type] )

Searches for a value in an array and returns the
relative position of that item.

TEXT( value, format )

Returns a value converted to text with a specified
format.

CONCATENATE( text1, text2, ... text_n )

Allows you to join 2 or more strings together.
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28.7. FAQs
Q: Excel's auto fit row height is not working.
Q: Excel's wrap text not working.
A: Ensure the cell's formatting is set to "general", not to "text".
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29

IncidentXP and BowTieXP together
29.1. Introduction
After an incident of large enough impact, incident investigation and analysis is done. These investigations lead to
recommendations on how to adjust our management system so they will be prevented in the future.

Similar to audits, incident analysis is a valuable way of gaining insight into barrier quality/effectiveness. It is a
lagging indicator, but a useful one nonetheless. Information about real world failure of barriers is difficult to gain
and very valuable.
By relating the barriers in incident analysis with the barriers in the proactive risk assessments, we are offering
another tool for helping close the Deming circle. After defining the barriers in your safety management system (i.e.
the plan stage) and implementing them (i.e. the do stage), a check is required to ensure the quality of the barriers.
Relying on barriers that are in reality inadequate can be dangerous. Also, a thorough examination of the barriers
during the check stage facilitates the generation of relevant recommendations later on (i.e. act stage).
The coupling of incident analysis with risk analysis also works in the other direction. By having the proactive risk
assessments on hand during the investigation, identification of the involved barriers is made simpler and
recommendations will probably be more compatible with the safety management system, allowing quicker and
more effective adoption.
Note: Please refer to the IncidentXP software manual for more details on how to enter incidents into the
software. Please also refer to our theory guide on more details on how incident analysis, but also audits
tie into bowties.
In practice this translates to the following software options:
1. Relating of bowtie barriers to incident barriers.
2. Allowing you to visualize incidents on bowtie diagrams (including some reports).
3. Allowing re-use of bowtie barriers and events on your incident analysis diagrams.
4. Offering case file overviews to explore the relation between incidents and bowties.

Page 233 of 263

29.2. Relating of bowtie barriers with incident barriers
To relate barriers between bowties and incident diagrams, you must first ensure you have both in the same file. Use
the import function or the scrapbook to get all diagrams into a single file.
The next step is to position the two diagrams we are going to relate side by side, or on top of each other.
Note: a large monitor will help a lot on this process.
We open both diagrams, and then grab the tab and drag the window to the right position. Reorganizing the
windows is described in chapter 6.7, How to configure your main window on page 52.
See the screenshots below for two ways to organize your windows:

Figure 290 - Incident diagram and bowtie diagram side-by-side

Figure 291 - Incident diagram and bowtie diagram on top of each other
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Once we have this window arrangement, associating the barriers is done by means of drag and drop. Simply drag
the barrier from the bowtie diagram onto the barrier you want to relate it to on the incident diagram and the
association is made.
Note: if the barrier you are trying to drag starts repositioning, try holding down the ALT key.
The ALT key switches from dragging to reorder to dragging to drag an item out of the diagram.
If you need to remove an association between two barriers, double click the incident barrier. On the barriers tab
you can remove the offending bowtie barrier:

Figure 292 - Linking incident barriers to bowtie barriers
Note: if you used bowtie elements while building your incident diagram, associations will already be
present. When you copy and paste a barrier from a bowtie into an incident, BowTieXP automatically
associates them for you. Likewise if using the “from bowtie” drop down button when building
“templated” incident diagrams.

29.3. Visualizing incidents on bowtie diagrams
Once the links between the bowtie barriers and the incident barriers have been made, we can show the barriers
failure statistics and failure details in the bowtie diagram. Failure details include the barrier failure state, the Tripod
causation paths and the BSCAT causations.
These diagrams are known as incident bowties.
To enable this view, you select the incident filter from the filters drop down on the bowtie diagram toolbar:

Figure 293 - Enabling Incident Filter
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Once selected, the incident filter toolbar will be displayed, allowing you to fine-tune what will be shown. You can
choose to show data from all incidents or from a specific incident.

Here is a sample of a Tripod Beta diagram linked onto a bowtie diagram:

Figure 294 - An incident bowtie with Tripod causation paths

Here is a sample diagram showing a BSCAT incident on a bowtie diagram:

Figure 295 - An incident bowtie with BSCAT causations
You can choose which incident diagram you would like to display.

Figure 296 - Incident filter (incident selection)
You can choose to show all bowtie elements, or limit the bowtie to only the paths involved in the incident(s). This is
arranged in the filter strength:

Figure 297 - Filter strength
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You can change various general settings, applicable to all kinds of incident data:

Whether to show the number of incidents the barrier was linked to.

Whether to show the number of incident barriers the barrier was linked to. As incidents tend to be more
specific (where bowties are more general/abstract), it will happen that a single bowtie barrier will be
linked to multiple incident barriers. This count reflects that.

Show the different counts of how (and if) the barrier has failed, such as broken, missing, unreliable.

Show the actions defined in incidents on the bowtie diagram.

Figure 298 - Incident filter (general settings)
Some settings are not applicable to all incident diagram types. For example, certain aggregated lists are not
available in Tripod Beta.
Some settings are only applicable to BSCAT and BFA:

Whether or not to show the free text description for failure reasons

Whether or not to show the assigned items from the SCAT lists (show links option)
o If we want to see the actual item, or only the main category (show top level links only)
o If we want to see the full description, or just the code
o If we want to see how often an item was linked in total or not

Figure 299 - Incident filter (BSCAT / BFA setting)
Some settings are only applicable to Tripod Beta:

Whether to show Tripod Causation paths.
o If we want to see the whole causation path or only the BRF code

Figure 300 - Incident filter (Tripod settings)
It is also possible to filter on a specific date/time frame or on an organizational unit. The latter is mainly relevant in
combination with BowTieServer. For date ranges, a number of presets can be selected, or a specific time frame can
be specified using the custom date range setting.
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Figure 301 - date range filter

29.4. Re-using bowtie barriers on incident analysis diagrams
It is possible to copy a bowtie barrier and paste it into your incident diagram. It will be automatically converted for
you. At the same time, BowTieXP will make an association between the original bowtie barrier and the incident
barriers, so you do not have to do that later on manually.
In the same way, if you are creating your incident diagram using either templated BSCAT or templated Tripod Beta,
you are re-using your bowties. Also in this instance will a link be automatically made for you.

29.5. Case file overview
There one case file overview dedicated to how bowties are related to incidents. It is the “bowtie linked elements in
incidents” overview. It shows how elements between the diagrams are related, where they are located and also
what the various failure states are.
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Figure 302 - Case file overview (Bowtie linked elements in incidents)
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30

Installation reference
In this chapter we walk you through the steps to install
BowTieXP.

30.1. Technical specifications
BowTieXP is a regular desktop application, which runs on the hardware of the end user. It adheres to all Microsoft
specifications and only requires domain user rights to be run. It has been validated by Microsoft as Windows 7
Platform Ready.
BowTieXP runs on Windows Vista, Windows 7, Windows 8.0, Windows 8.1 and Windows 10.
Please note that BowTieXP should work correctly on Windows XP, but as Microsoft no longer supports Windows XP,
we also cannot officially support Windows XP.
BowTieXP adheres to all Microsoft specifications and only requires regular user rights to be run - important for
corporate network environments.
BowTieXP can be provided as an msi installer for deployment with network tools like Microsoft Systems
Management Server.
BowTieXP stores information in a file-based compressed XML database. It does NOT require database software to
be installed. Even large BowTieXP databases typically stay under 1 Megabyte of size. Even if hundreds of BowTieXP
database versions are stored, storage requirements on a network file share should stay well under 1 Gigabyte.
Configuration information is stored on disk in the user’s profile, in both the local and the roaming part. Some
system-wide data is stored in the all users profile (Program Data on Windows 7 and above). The registry is used for
file extension association and protocol handler association. If possible, these are made system wide in HKLM. If
access to HKLM is denied, the HKCU hive is used. Citrix and Terminal Server environments are supported, but do
place constraints on the allowed software activation type.

30.1.1. Supported operating systems






Windows Vista (32 and 64 bit)
Windows 7 (32 and 64 bit)
Windows 8.0 (32 and 64 bit)
Windows 8.1 (32 and 64 bit)
Windows 10 (32 and 64 bit)

Please note that BowTieXP should work correctly on Windows XP, but as Microsoft no longer supports Windows XP,
we also cannot list it as supported.

30.2. Operating system requirements
Note that if your system is kept up to date using Windows Update it will most probably meet all of these
requirements except the .NET framework, but they are listed here for completeness.
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The Microsoft .NET Framework 3.5 SP1 or higher must be installed on the OS. Vista and higher always have the
framework preinstalled, and also cannot be removed – this prerequisite is thus always fulfilled on these operating
systems. Windows 8.0 and above will automatically detect the need for version 3.5 and offer to install it.
Supported operating systems are Windows Vista, Windows 7, Windows 8.0, Windows 8.1 and Windows 10.
MDAC 2.71 or higher should be installed; this is required for importing Thesis files. It is very likely that you already
have a more recent version of MDAC installed on your pc.
You must have at least 1024 Mb of physical memory; 2048 Mb is needed to run BowTieXP comfortably. You must
have one drive with 200 Mb of free disk space. In general, if your computer meets the Windows recommended
system requirements, BowTieXP will work. For intensive use more RAM and CPU speed is recommended.
You must have a minimum screen resolution of 1024x768 and a color depth of 16 bits, but considering the graphical
nature of BowTieXP – the bigger your screen the better.
BowTieXP can interoperate with all Microsoft Word and Excel versions. The supported Visio versions are 2000,
2002, XP (2003) and 2007.
In order to run, BowTieXP needs to have the .NET Framework 3.5 SP1 installed on your PC. This is discussed in the
next section.
If you want to use the SharePoint add-on, there are also requirements on your SharePoint server. Please see section
30.13 for details.

30.3. The Microsoft .NET Framework
Windows 7 and later come with the .NET Framework version 3.5 SP1 already installed out of the box or
will detect the need and install automatically

30.3.1. What is Microsoft .NET?
Microsoft .NET is the Microsoft strategy for connecting systems, information, and devices through Web services so
people can collaborate and communicate more effectively. .NET technology is integrated throughout Microsoft
products, providing the capability to quickly build, deploy, manage, and use connected, security-enhanced solutions
through the use of Web services.
Before you can run BowTieXP, your computer must have the Microsoft .NET framework version 3.5 SP1 installed.
Microsoft advises Windows users to install its .NET Framework because of the growing number of frameworkconnected applications on the market. Chances are it is already installed, as it is also delivered by Microsoft using
Windows Update.
Windows 7 and later come with the .NET Framework version 3.5 SP1 already installed out of the box, or will detect
the need and install automatically. On Windows Vista, you need to do this manually.

30.3.2. Is the framework already installed?
You can simply install BowTieXP and try to run it. If the framework is missing, you will be notified and can install it
then.

30.3.3. Install the framework from the MS downloads site
Browse to:
http://www.microsoft.com/en-us/download/details.aspx?id=22
And download and run the installer.
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30.3.4. Install the framework through Microsoft Windows Update
Browse to: http://windowsupdate.microsoft.com and choose to update your computer.
Select the .NET Framework 3.5, if it is listed. You will probably find it under recommended updates.

30.4. Install BowTieXP
Browse to:
http://www.cgerisk.com/downloads/bowtiexp/
Download and run the BowTieXP installer (.msi).
Click through the wizard using the next button until the installation is finished. Note that you will need to check the
checkbox to indicate you agree with the end-user license agreement in order to continue the wizard.
If you don't want to install BowTieXP through the Microsoft Installer (.msi), you can also choose manual installation:
1.
2.
3.

Browse the downloads page to find the BowTieXP executable (.exe).
Unzip the zip file you just downloaded.
Copy the executable in any location you want and run BowTieXP from there.

Note: You will need to extract the software from the .zip archive before it will run correctly! If you receive
an error message, please check to see if you have done this.

30.5. Activating the software
When you start BowTieXP for the first time, you are asked for either a trial code or an activation code in the
following dialog box:

Figure 303 - Activation dialog
If you have a valid trial code, you can enter that in the Activation or Trial Code text box, and BowTieXP will run. After
the trial code expires this dialog box will reappear. Until then, BowTieXP can be used normally without restrictions.
If you have purchased BowTieXP, you will need to obtain a customer activation code to activate BowTieXP. Once
you install BowTieXP, copy the code displayed in the Current Host ID text box and paste it into an email. We will
then send you an activation code. After entering this code in the Activation or Trial Code text box BowTieXP will run.
The Current host ID must be emailed to the following email address:
support@cgerisk.com
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30.6. EULA and release notes
After activating BowTieXP and starting for the first time, you will have to agree to the end-user license agreement.
Please read this legally binding document carefully, as you cannot use BowTieXP without full agreement. If you
agree to the terms and conditions in the license agreement, click the ‘I Do Agree’ button to start using BowTieXP. If
you do not agree, BowTieXP will exit.
Next, the release notes will be displayed. They contain the latest information about BowTieXP, which may have not
made it into the official documentation. By selecting HelpRelease Notes they can be redisplayed.

30.7. File extension registration

Figure 304 - File association prompt
BowTieXP automatically tries to keep the file association to .btf files in order. If BowTieXP detects something wrong
with it, you are prompted if you’d like to restore it. Note that you can check to never be asked again. In that case
BowTieXP remembers your choice and automatically applies it the next time.

30.8. BowTieXP site activation
BowTieXP can be configured to activate all members of a global or universal domain user group. This is known as
site activation.
This has the following advantages:
1. Only one code for all users – can be installed along with the application by IT.
2. IT can reassign licenses by add/removing users from the group.
Site activation has the following disadvantages:
1. Only activates computers/users which are members of the domain.
2. IT needs to create and maintain the group of licensed users.
The group must be a global or universal security group. Distribution groups cannot be activated.
The site activation process is as follows:

Choose group to
activate

Send site id to
CGE Risk
Management
Solutions

Receive activation
code

Activate
BowTieXP

Figure 305 - Site activation process
First, choose the user group to activate. BowTieXP creates a site id for this group, which must be sent to CGE so they
can create an activation code for you. After entering this activation code into BowTieXP, it is activated and will run.
Note that the site id can also be retrieved in a different manner, and the codes can also be entered in a different
manner. These alternate methods for site activation are described below the sections which show you the process
to follow in the user interface – just keep on reading.
Now we proceed with the steps to take using the user interface:
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30.8.1. Showing site activation options
BowTieXP can be configured to activate all members of a global or universal domain user group. This is known as
site activation. Click the blue link label to show site activation options.

Figure 306 - The product activation codes dialog box

30.8.1.1. When starting BowTieXP
Double-click the BowTieXP icon on the desktop. When the activation dialog is shown, click the blue label marked
“Click here to show site licensing options also”.

30.8.1.2. When BowTieXP has already been started
Go to the Help menu and click the “product activation codes” option. When the activation dialog is shown, click the
blue label marked “Click here to show site licensing options also”.

30.8.2. Choosing a group to activate
The computer administration department must create a dedicated group to hold all the users which are licensed to
use BowTieXP. By doing this it is easy to reassign licenses between users.
Choose this group from the drop-down:

Figure 307 - Choosing the group to activate

30.8.3. Sending the site id to CGE
After selecting the user group to activate, the site id for the selected group is shown.

Figure 308 - The group to activate has been chosen
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The “selected site id” should be sent to CGE so an activation code can be generated.

30.8.4. Entering the activation code
After receiving the activation code, it can be entered into the dialog to activate BowTieXP.

Figure 309 - BowTieXP with a valid site activation code
Note that you must be a member of the intended group for this to function; otherwise access to the software will
be denied and the newly entered activation code will not be saved.
Also note that after changing group memberships, users will need to log off and on again for these membership
changes to take effect. Also, changes made on the server can take several hours to take effect. This is because
active directory servers synchronize their changes on a schedule. The default schedule for synchronization is two
hours.

30.8.5. Getting the site id in an alternate manner
Sometimes the user interface can be a bit of a bothersome manner to retrieve the site id and enter the activation
code. This will especially be the case when a very large number of groups exist in your network. In this case it can be
easier to use a different way to retrieve the necessary information.
Internally, BowTieXP uses the SID (Security Identifier) of the group you want to activate to lock itself to. Using the
GUI, all that is happening is you are presented with a nice manner in which to choose a group and send us the SID.
Another way to give CGE the group security identifier to generate an activation code for is by means of the
command line, by using the wmic tool, which is built into windows:

Open a command prompt and issue the following command:
wmic group where name='BowTieXPUsers' get sid
Where you replace BowTieXPUsers with your own group name. Please mail the output to CGE Risk.
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30.8.6. Saving activation information in an alternate manner
30.8.6.1. Old style activation.dat
After successfully starting BowTieXP with a valid key, a file called activation.dat is saved in the user’s profile. This file
can be copied next to the bowtie.exe executable and BowTieXP will also find it and use it.
If you are deploying BowTieXP on a network, the easiest way to activate it for all users is to place this file next to the
executable.
When sending the site code / SID to CGE for key generation, you can always request us to supply you with such a
file.
You can also make then yourself; it is a simple xml file with the following contents:
<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<ActivationSettings>
<ActivationConfigFileFormatVersion>1.0.0.0</ActivationConfigFileFormatVersion>
<HostID> </HostID>
<ActivationCode>12345678 ABCDEFGH </ActivationCode>
</ActivationSettings>

Between the tags, you can see “12346578 ABCDEFGH” – this is where the activation code goes.
NOTE: Please read section 30.8.7, How to manage multiple editions of BowTieXP on page 246 about managing
multiple codes and the behavior BowTieXP has when multiple codes are encountered.

30.8.6.2. New style activation.dat
For convenience at large site installations, we have added another file format for activation.dat files which allows
multiple codes per file and allows you to add comments as well.
Here’s an example file:
; BowTieXP activation codes for our site:
12345678 ABCDEFGH
; Advanced BowTieXP License for DOMAIN
12345678 ABCDEFGH
‘ Another license
; Now some licenses:
12345678 ABCDEFGH

Each line can be blank or contain an activation code and/or a comment. Activation codes and comments are
separated by a semicolon character.

30.8.7. How to manage multiple editions of BowTieXP
There are multiple editions of BowTieXP:

BowTieXP Standard Edition (for regular users)

BowTieXP Advanced Edition (contains many advanced features)

BowTieXP [Advanced] Navigator Edition (used by data consumers)

BowTieXP and IncidentXP (Allows Incident Analysis)

SharePoint add-on

Spreadsheets add-on

Etc.
All editions are run using the same executable. The activation code signals what edition will be started.
Each edition of BowTieXP can be activated for a specific Domain User Group. It is often easiest to create a specific
Domain User Group for each BowTieXP edition that will be used.
For example:

‘BowTieXPUsers’
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‘BowTieXPAdvancedUsers’

After creating a new user group, an activation.dat file can be generated based on the group SID.
Multiple activation files can be placed next to the executable. Each activation file’s filename should start with the
string “activation” should have a “.dat” file extension. For example:
CORRECT

Activation-Std.dat

Activation-Adv.dat

Activation-Nav.dat
INCORRECT

Activation-Std.txt

Std-Activation.dat
Note that the first file found which activates BowTieXP will be the file that gets used – BowTieXP will not keep
searching for a “better” license, so it is up to you to ensure that the “best” license is tried first by giving it a filename
which is alphabetically earlier than the other license files.
When using the new style activation.dat files you should place the “best” license codes first in the file – they are
tried first.

30.9. Large scale deployment
BowTieXP/IncidentXP has been regularly deployed on large world wide scale (hundreds of installs) without
problems.
Deployment of the software consists of two parts:

Installation

Activation

30.9.1. Installation
The installation of the software is very simple – it consists of a single executable file (.exe) without external
dependencies apart from the .NET framework.
During training sessions, we distribute the software on USB stick. This works as admin rights are not required to run
the software. It runs straight of the USB stick. If the user so prefers, he can copy the software onto his desktop and
it will run from there.
For actual installation we also offer an msi which does a minimal set of actions:

Copy the exe to the program files folder

Add a start menu entry

Add a desktop shortcut

Registers itself in the “add & remove programs” control panel applet.
File extension registration is done on start of the software.
This msi is easily scripted by means of msiexec or by capturing the changes to the system. A sample script is
included below.

30.9.2. Activation
After getting the exe onto the system, the software has to be activated.
For large scale deployments, group activation is advised. All the licensed users are made members of a dedicated
AD global or universal group. The SID (globally unique numerical group ID) of the group is the basis for an activation
key which allows everybody who is a member of that group to run the software.
This key can be deployed along with the software in the scripted installation. If placed within a text file called
“activation.dat”, and placed besides the exe, it will be automatically picked up.
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Group activation also has the advantage of allowing the customer to do license reassignment without our
intervention – just substitute the user in the group.

30.9.3. Sample installation script
Below is a sample installation script (usable in software such as SCCM / SMS), which also copies the activation key
into the correct directory:

msiexec.exe /i "%~dp0BowTieXP-6.0.7.msi" /qb
REM Detect OS version
if exist "C:\Windows\SysWOW64" (
goto 32_64bit
) else (
goto 32bitonly
)
:32_64bit
Echo.
copy "%~dp0activation.dat" "C:\Program Files (x86)\BowTieXP\activation.dat" /y
goto End
:32bitonly
Echo.
copy "%~dp0activation.dat" "C:\Program Files\BowTieXP\activation.dat" /y
goto End
:End

30.10. Plugin installation
BowTieXP has support for plugins. Plugins are small pieces of computer code which extend BowTieXP with custom
functionality, allowing CGE to add customer functionality (as long as it falls within the possibilities offered by the
plugin architecture / interface.
One example of a plugin is our LOPA plugin, which extends BowTieXP with on-the-fly LOPA calculations on the
bowties. See our LOPA plugin manual for more details.
Plugins are delivered in files with a “.btpp” extension (short for BowTieXP Plugin Package).
To install a plugin we take the following steps:

Download the plugin package from our web site.

Double click the btpp file. This will install the plugin. You will get a confirmation window like this:

Figure 310: Plugin installation confirmation


You can now check everything went ok by going to Help -> Manage Plugins:
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Figure 311: Manage Plugins

30.11. Plugin activation
Some plugins require an activation code, just like BowTieXP. The process is the same, except that you can have
multiple activation codes for multiple plugins. Please note that plugins have the same host and site ids as BowTieXP.
Make sure to send it along when you request your plugin activation code.
To add a new plugin activation code:
1. Navigate in the menu bar to Help -> Manage Plugins.
2. The Lopa plugin still needs to be activated with an activation key. To do this, I can select the plugin and
click ‘Add an activation code’. This will give a popup where a valid activation key can be entered.

Figure 312: Plugin requiring activation
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3.

Once the activation key is added, it will be displayed in a dropdown. Right clicking a key will allow you to
delete it if necessary.

Figure 313: Managing plugin activation keys
4.

A restart of the software might be required before the plugin can be used.

30.11.1. Plugin activation for group locked codes
If you are doing a group locked activation, and want to deploy codes by means of a dat file, you can do the same for
plugins. Please request your plugin activation code in a dat file from us, and we’ll supply one. This dat file will be
picked up when placed next to the bowtie.exe executable, just like for regular activation codes. The name of this dat
file must match the “pluginactivation*.dat” pattern.

30.12. Activation file search locations
BowTieXP searches for activation files in the following locations:
Program data:
User profile local app data:
Next to the executable:

%PROGRAMDATA%\Governors\BowTieXP\activation.dat
%LOCALAPPDATA%\Governors\BowTieXP\activation.dat
Wildcard pattern activation*.dat

30.13. SharePoint Server Requirements
If you want to use the SharePoint integration in BowTieXP, there are requirements on your SharePoint server. They
are described here.

30.13.1. Basic settings
BowTieXP files in SharePoint document libraries are the primary means of integration between BowTieXP-related
products and SharePoint.
The “Team Collaboration Lists” and “Remote Interfaces” settings described below apply to all forms of integration
between BowTieXP solutions and SharePoint.

Page 250 of 263

30.13.1.1. Team Collaboration Lists
As BowTieXP and related products make heavy use of SharePoint document libraries, make sure that the “Team
Collaborations Lists” feature is activated on site level.

Figure 314: Activating the Team Collaboration Lists feature

30.13.1.2. Remote Interfaces
The BowTieXP SharePoint solutions use either the SOAP web services. These can be configured per Permission Level
in the Site Settings, by following these steps:
1. Go to Site settings
2. Click Site Permissions
3. Click Permission Levels
4. For each of the levels you want to give access, make sure the “Use Remote interfaces” checkbox is
checked (see the figure, under the Site Permissions header).
BowTieXP supports SharePoint versions 2007 and higher. It uses the SharePoint web services listed in the table
below to communicate with SharePoint. Furthermore, it requires FrontPage Server Extensions to be running on the
server.
All of these are enabled by default on a SharePoint Foundation (and higher) installation.
Web service
Authentication
Document workspace
Lists
People
SiteData
Users and Groups
Versions
Webs

Path
…/_vti_bin/Authentication.asmx
…/_vti_bin/Dws.asmx
…/_vti_bin/Lists.asmx
…/_vti_bin/People.asmx
…/_vti_bin/SiteData.asmx
…/_vti_bin/UserGroup.asmx
…/_vti_bin/Versions.asmx
…/_vti_bin/Webs.asmx
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31

Keyboard Shortcuts
31.1. General
Keyboard shortcut
Alt + 1
Alt + 2
Alt + 4
Alt + A
Alt + B
Alt + C
Alt + D
Alt + E
Alt + F
Alt + F1
Alt + H
Alt + O
Alt + T
Alt + V
Ctrl + 1,2,3,4,5,6
Ctrl + Alt + C
Ctrl + D
Ctrl + F1
Ctrl + H
Ctrl + I
Ctrl + L
Ctrl + N
Ctrl + O
Ctrl + S
Ctrl + Shift + 1,2,3,4,5,6
Ctrl + Shift + A
Ctrl + T
Ctrl + Y
Ctrl + Z
F1
F11
F5
F9

Description
Navigate Back
Navigate Forward
Reports
Apply changes without closing the Edit window
Open from BowTieServer
Case menu
Diagram menu
Edit menu
File menu
Release notes
Help menu
Cancel BowTieServer checkout
Tools menu
View menu
Expand levels for current diagram
Copy BowTie diagram to clipboard
Import from external file
About
Text replace
Import from BowTie file
Open most recent file
New file
Open file
Save
Expand levels for all diagrams
Display options
Open Test File
Redo
Undo
Online help
Full screen
Refresh diagram
Choose UI language

31.2. Windows
Keyboard shortcut
Ctrl + Shift + B
Ctrl + Shift + C
Ctrl + Shift + E
Ctrl + Shift + F
Ctrl + Shift + F12
Ctrl + Shift + I
Ctrl + Shift + L
Ctrl + Shift + M
Ctrl + Shift + N
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Description
BowTie Diagram
Case Overview
Editor (Deprecated)
Find results
Default window layout
Incident Diagram
Listview
Relationship Diagram
Incident Timeline Diagram

Ctrl + Shift + O
Ctrl + Shift + Q
Ctrl + Shift + S
Ctrl + Shift + T
Ctrl + Shift + X
Ctrl + Shift + Z
F12

Overview
Quality Checks
Scrapbook
Treeview
Spreadsheets
Color Legend
Switch to layout B

31.3. Selection actions
Keyboard shortcut
Ctrl + B
Ctrl + C
Ctrl + Shift + R
Ctrl + Shift + V
Ctrl + V
Ctrl + X
Delete
F2
Insert

Description
Show usage references
Copy selection
Repeat paste special
Paste special
Paste on selection
Cut selection
Delete selection
Edit selection
Add new item

31.4. Treeview
Keyboard shortcut
* (on numeric keypad)
/ (on numeric keypad)
Left arrow
Right arrow

Description
Expands the selected node and all children recursively.
Collapses the selected node and all children recursively.
Collapse the currently selected node.
Expand the currently selected node.
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32

Frequently asked questions
32.1. General questions
32.1.1. Q: Can I be kept up to date about new releases?
Yes, just send an email to bowtiexp-releases-join@governorsmansion.nl to subscribe to the mailing list.

32.2. Installation questions
32.2.1. Q: Can I Install and run BowTieXP on Apple Mac (OSX)?
The BowTieXP software is built for the Microsoft Windows operating system. Unfortunately, BowTieXP is not Apple
Mac (OSX) compatible. Macs nowadays do have the ability to run Windows software on them. There are two main
ways to go about that:
1.

Actually install Microsoft Windows on your Mac using Boot Camp. You can switch between Windows and
OSX, but it requires rebooting.
(https://www.apple.com/support/bootcamp/)

2.

Emulate Microsoft Windows via a program such as Parallels.
(https://www.parallels.com/eu/products/desktop/).

Our advice is to run BowTieXP on the Microsoft Windows operating system (not emulated) as we support this
option and it works best, but we have seen clients successfully use BowTieXP on their Mac by emulating Windows
using products such as parallels.
If cross platform support and device support is of interest to you, you might want to make your bowties easily
accessible for viewing by (all) the employees in your organization by using our web viewer – a part of BowTieServer.
The web viewer (for viewing only, not editing) is independent of operating system, as it is a web solution which runs
on your browser. Therefore, it runs on Microsoft Windows, Apple Mac OSX, but also your iPads

32.2.2. Can I install BowTieXP on a server?
That depend Q: s on what is meant exactly – see the questions below regarding network shares and Terminal Server
/ Citrix.

32.2.3. Q: Can BowTieXP run off a network share?
Yes, provided the client computers are running Windows Vista or Higher. If the clients are running Windows XP, a
change has to be made to the .NET security configuration.

32.2.4. Q: Can BowTieXP run under Terminal Server or Citrix Server?
Yes, BowTieXP is fully compatible with Terminal Server and we have reports from customers it runs flawlessly on
Citrix. You will need a group locked activation – host locked activation is not supported in this scenario.

32.2.5. Q: Does BowTieXP support virtualization?
This depends on what is meant with virtualization:
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If with virtualization you mean running the software on a remote server and showing the app via the
network (also known as desktop virtualization/VDI), then the answer is yes –for Microsoft Terminal
Server. See the questions about Terminal Server and Citrix.



If virtualization refers to portable application generators like Spoon studio or VMware ThinApp, the
answer is no, but this does not mean it will not work – just that we cannot support that scenario. Should
any issues present, we will of course try to resolve those but we cannot guarantee we can – some of
those applications do some very complex things to the software. We know, we used some of those tools
for previous BowTieXP versions.

32.2.6. Q: What rights/access does BowTieXP need on the computer to run / can
BowTieXP be used in a no-touch deployment situation / is a portable version
available?
BowTieXP requires only regular user rights to function. BowTieXP adheres to the Microsoft standards about where
to store data. In practice this means:
Configuration files are stored in the user’s application profile (in %APPDATA%\Governors\BowTieXP).
Activation data is stored in the local part of the profile (%LOCALAPPDATA%\Governors\BowTieXP).
If BowTieXP has admin rights it will store activation data in the all users profile / application data path
(%ALLUSERSPROFILE%\Governors\BowTieXP).
If allowed, a registry entry will be added to HKCR for the file association and protocol handler. The association is
stored in HKLM if allowed, else in HKCU.

32.2.7. Q: How can I deploy activation keys along with the application / when
scripting the application?
You can place the codes in a text file names activationcodes.dat and place that next to the exe. They will be picked
up automatically. Note that all files which start with activation and end with .dat are considered
(activation*.dat). The first working code which is found is used.
Activation codes for plugins can also be placed next to the exe. The files must conform to the
pluginactivation*.dat search pattern.
You can copy the plugin activation codes file (“pluginactivation.dat”) from one of the below folders and copy it next
to the exe:

%PROGRAMDATA%\Governors\BowTieXP\pluginactivation.dat or

%APPDATA%\Governors\BowTieXP\pluginactivation.dat
That ensures the correct format.

32.2.8. Q: Activating all the licenses we bought one computer at a time is too much
work. Is there an alternative?
Yes – if your computers are domain computers you can activate the software by making the users members of a
dedicated active directory group.
The group has to be a global or universal security group. A code is generated for this group. The code works for all
members of that group.
The code contains a maximum number of users. If there are more users in the group than the maximum, the
software will not run.
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32.2.9. Q: Group locked - if I change the number of licensed users or the type of
license, do I need to update each computer?
Yes - if you purchase additional licenses, you will be issued a new activation code. This code has to be deployed to
each computer where BowTieXP is installed. This can be done by IT updating the scripted installation package or by
mailing the users so they can enter the new code manually.
This is a result of having a licensing mechanism without a central server. Not having a central licensing server has
advantages and disadvantages. Having to deploy new codes is a disadvantage as it takes more work. Not having to
install a license server, adjusting firewalls, and having trouble with people going off the network is an advantage.

32.2.10. Q: What are the steps to create this group-locked activation code?
This is also covered in-depth in our software manual.
Short list of steps:
1. Create group in AD
2. Make all licensed users members of this group
3. Send group SID or site id to us
4. We respond with an activation key
Here are the detailed instructions for doing so:
1.

Create a user group in Active Directory to hold the licensed accounts: e.g. "BowTieXPUsers". This can be
done on a domain controller using the “Active Directory Users and Computers” MMC applet.

2.

Add all the user accounts which will be licensed into the group.

3.

We will need the group SID/site id (internal numerical group code) in order to calculate an activation code
for this group. We will store this code into a small text file called activation.dat, which must be placed next
to the BowTieXP executable so it can be found.
The next step is retrieving this SID/site id. This can be done via BowTieXP, unless the number of groups on
the server is very large. Then we recommend using the command line.

A.

Via BowTieXP: Start BowTieXP. The activation dialog will appear. If not, go to Help->Activation Codes. Click
the blue link to show site licensing options also. Select the BowTieXPUsers group from the drop down.
Send the site id to us.

B.

Via the command line. Open up the command line and issue the following command for your own
BowTieXP users group:
wmic group where name='BowTieXPUsers' get sid
and mail the SID (S-1-5-21-....) back to us.

4.

After receiving the code, we will create an unlock code for you and send this back in a small text file,
called activation.dat, which must be placed next to the BowTieXP executable. After this, all members in
the group should be able to run BowTieXP.

Tips for testing:

Make sure the test user is actually a member of the group (this is often forgotten),

Group membership changes take effect after log-off and log-on.

32.2.11. Q: Will group activation still function if my computer is without network
access for a long period of time?
Yes.
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32.2.12. Q: I am testing BowTieXP group activation but I get the following error:
“Activation code does not match any of the current user’s group
memberships”.
Ensure the current user is a member of the activated group. You can verify this by letting BowTieXP show you the
current user’s group membership.

32.2.13. Q: The user is added to the group in active directory, but BowTieXP does not
pick up this change.
There are several reasons why the change might not have taken effect yet:

Active directory servers need to sync before changes are applied. The default schedule is two hours. Wait
at least this long and try again, or ask the AD admins to force a sync.

The group membership info for the current user is only updated when logging on. Please log off and back
on again to update the user’s group memberships (the security ‘token’).

If the activated group is a distribution group BowTieXP will not see it. Ensure it is a security group. You can
double check this in AD users and computers by viewing the group properties. Security groups are the
default group type.

32.2.14. Q: Activation error: Activation code does not match the activated or current
host id.
Before you entered the activation key, the hardware was changed. Perhaps a laptop docking station was attached
or detached.
Solutions:
1. Restore the original hardware situation. You need to close and open BowTieXP after changing this.
a. If the docking station is connected, unplug the docking station and try again.
b. If it is disconnected, try connecting it.
2. If that does not work: Select “lock to this computer with an old host id”.
a. If the box is empty: enter the original host id sent to us in the activated host id box.
b. If it is not empty: Try clearing it.
3. If both fail: Contact us for a new key.

32.2.15. Q: How can I script the installation?
The msi can be with the regular command line options:
msiexec.exe /i <msifile> /qb
If you want to also deploy the dat license file you might need to capture changes to create a deployment script, or
manually make sure the dat file is placed next to the exe. Another option is for end-users to enter it manually. Note
that BowTieXP has no dependencies other than having the framework 3.5 SP1 or higher installed. Deployment is
xcopy deployment; all the msi does is:
1.
Copy the bowtie.exe file to C:\Program Files\BowTieXP\
2.
Add a shortcut to the start menu and the desktop.
A sample script could look like this:
msiexec.exe /i "%~dp0bowtiexp-5.0.8.msi" /qb
copy "%~dp0activation.dat" "C:\Program Files\BowTieXP\activation.dat" /y
The variable %0 in a batch script is set to the name of the executing batch file. The ~dp special syntax between the %
and the 0 basically says to expand the variable %0 to show the drive letter and path, which gives you the current
directory containing the batch file.
Note: This sample does not know the difference between 32 bit and 64 bit systems so you might want to take that
into account (i.e. copy file to the ”Program Files (x86)” folder instead of to the regular ”Program Files”
folder).
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32.2.16. Q: What prerequisites / dependencies does BowTieXP have?
BowTieXP requires the .NET Framework 3.5 SP1 or higher to be installed. Windows 7 and later come with the .NET
Framework version 3.5 SP1 already installed out of the box, or will detect the need and install automatically. On
Windows Vista, you need to do this manually.
In Windows XP and Vista you will need to install the framework if not yet installed.
See here for an overview:
http://blogs.msdn.com/b/pmarcu/archive/2010/02/05/which-version-of-net-is-built-into-windows.aspx
If you want to use the import from Thesis function you will need MDAC 2.71 or higher. If you are running Vista or
higher this should already be present on your system.
In Windows XP there’s a tiny chance you might have to update the component.
Microsoft MDAC FAQ:
http://msdn.microsoft.com/en-us/library/windows/desktop/ms692877%28v=vs.85%29.aspx

32.2.17. Q: Can I deploy templates along with the software?
Yes, just place the btf files in a directory called ”Templates” located next to the executable. They will be
automatically picked up and built-in templates will be automatically hidden.

32.2.18. Q: Can I install multiple versions side by side? I need to support files which
must stay in an old file format.
Some people, for example consultants, need to run different versions of BowTieXP side by side in order to keep files
in the file format their clients use. We have made sure that you can run different versions side by side, and from
version 3.6.4 and onwards, we have added some more support in the software for this scenario: you can view the
version in which a file was last saved.
To view in which version a file was last saved, open it in BowTieXP and choose File->Properties.
For example, assume we see that the file was written using a 3.6 version. Since all 3.6 versions share the same file
format, we can edit this file using the latest 3.6 version and send it back to the person we got it from, and they will
be able to read it without having to upgrade to the latest version.
In order to run different versions of BowTieXP side by side, all we have to do is to download the different versions
we want and make sure to grab the versions for manual installation (the zip files).
All BowTieXP versions needed to support every file format version ever released, are available on the download
page located at http://www.cgerisk.com/downloads/bowtiexp/index-all.php.
Let’s show by means of an example (the 2.3.0 file) how to install the correct version. We need BowTieXP 2.3.0 to
edit this file without upgrading the file format. Go to the download page and locate 2.3.0.
Download the executable (“in a zip file, for manual installation”). This zip file contains the bowtie.exe version 2.3.0.
Unzip it to a suitable location, such as your desktop. You probably want to rename it to reflect the version number.
After starting the older BowTieXP version, you might be confronted with an activation dialog. Contact us for an
older key – we can put this into a small file called activation.dat which is automatically picked up by BowTieXP, so
you do not need to enter the key manually. Just make sure the file is located next to the executable.

32.2.19. Q: How does the auto update work?
The behavior of the auto-update depends on the way in which BowTieXP was installed.
BowTieXP can be installed in two ways:
1. Via the msi
2. By placing the exe somewhere on the system
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If an update is available, the following will happen if the user requests it / clicks the notification:
In the first case (msi installed), BowTieXP will download the msi and ask windows to install it, upgrading the old
installation. Windows will ask for admin credentials if the current user is not an administrator.
In the second case (installed from zip file), BowTieXP will download the new exe and replace the current one. If the
user has no write access to the exe no attempt will be made (i.e. the update check is notification only, auto-upgrade
is not possible).

32.2.20. Q: How can I disable the auto-update?
To disable the auto-update, the read-only bit on the file can be set. This will disable all upgrade functionality. In this
case the software will still check for updates (if requested or if the periodic check is enabled), but it will only be a
notification, no attempt at auto-upgrading is done.

32.2.21. Q: How often are updates and upgrades released? What is your release
schedule?
BowTieXP has regular updates, addressing bugs. These versions are recognizable by having the same first two
numbers but a new third number. E.g. if you have 5.2.2, then version 5.2.3 will have the exact same functionality
but less bugs. The same goes for versions 5.2.4, 5.2.5 etc.
Once or twice per year we also bring out a new version with new functionality. The version with new functionality
will have a new file format to accommodate the new features. To indicate this, we change the first and/or second
version numbers. E.g. we go from 5.0 to 5.2.
If keeping up with the new versions is a challenge, it is advisable to pick a version to stay with for a longer time. Only
when users are running into bugs or if critical bugs are discovered and fixed, should a new version with fixes be
deployed. To prevent this, it is advisable to wait a while when a new version with new functionality is released
before deploying it, allowing more time for bugs to be fixed before that version is deployed.

32.2.22. Q: I get an exception about “no more files” on startup when trying to run
BowTieXP deployed/virtualized with App-V
We have seen this problem when during scripting, one of the directories used by BowTieXP was monitored and
should have been excluded. In that case the directory which should have been excluded was:
%APPDATA%\Governors\BowTieXP\Backups
After excluding this directory, the software worked correctly. See here for someone with a similar problem, but for
a different software product (not related to us):
http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-launch-after-thefirst-attempt/

32.2.23. Q: Plugins do not seem to load, but are placed in the right location.
Please check to see if you are running BowTieXP from a network location. Plugins can only be loaded from the local
hard disk, not from a network drive.

32.3. Q: Software questions
32.3.1. Q: Can I convert diagrams to pdf?
Yes – either copy the diagram to the clipboard, paste in Word/Excel/Visio 2007 or higher. You can save the file as a
pdf from Office.
Another option is to print to a pdf printer, but in our experience the Office route offers better image quality.
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32.3.2. Q: Which Office versions does BowTieXP support?
We support all office versions higher than Office 2000.

32.3.3. Q: Which Visio versions does BowTieXP support?
We support Visio 2002 and higher. See paragraph 13.4 for Visio diagram exporting details.

32.3.4. Q: Can I save files to an older file format?
This is unfortunately not possible. You might be able to convert a file back to an older version by means of the scrap
book – the scrap book has somewhat better forward compatibility due to the fact that the scrapbook exchange file
format is being kept as constant as possible.
Unfortunately, after the introduction of BowTieServer some scrapbook file format changes had to be made.
Introducing a new file format always leads to the situation where “old” versions of the software will not be able to
read the “new” scrap book file format. The “old” scrap book format is supported up to versions 6.2.6 of BowTieXP.
The new scrap book exchange format was introduced in version 6.2.7 of BowTieXP.
Note: be sure to use the latest version of the target version (i.e. if you need to convert to file format 4.2,
be sure to use the latest 4.2 version in this case 4.2.9).
For example, here are the steps to take to down-convert a file from v5.2 to v5.0
1. Open 5.2 and 5.0 side by side and ensure you are running BowTieXP Advanced. Ensure the scrapbook is
visible in both. Open 5.2 on the left, 5.0 on the right.
2. Open the file to convert in 5.2. Create a new file in 5.0 on the right. Empty ALL the lookup table entries in
the destination file.
How to move items from 5.2 on the left to 5.0 on the right:
a. Drag items from the tree view onto the scrapbook in 5.2 (left) onto the scrapbook. Save the
scrapbook. In 5.0 on the right, click the load scrapbook button and open the file.
b. Drag the items in 5.0 (right) to the correct bowtie group in the tree view.
Note: this mini guide is not verified for completeness / i.e. it might not be an exhaustive list!
3.
4.

5.

6.
7.
8.
9.

Transfer the contents of all lookup tables, starting from the top and working your way down. Include
activities, document links, etc.
Manually recreate the risk matrices. This has to be done by hand.
a. Recreate the categories.
b. Recreate the matrices themselves.
c. Use the copy matrix function where possible.
Terminology. Export the terminology from 5.2 to Excel. Try to import in 5.0. Errors will be given, fix each
by hand and try until it succeeds. Fixing involves removing lines of terminology which 5.0 does not
understand.
Transfer all incidents and bowtie groups using the scrapbook. This is done in the same manner as the
lookups.
Save the spreadsheet if any. Load into 5.0. Check for moved columns and adjust accordingly until the
calculations are in order again.
Verify completeness using the case file compare function.
Check the following and transfer manually if needed:
a. Null value descriptions and colors.
b. File property fields (File->Properties).
c. Treeview filter profiles.
d. Treeview tooltips.
e. Diagram display profiles.
f. Verify font settings.
g. Header and footer layout.
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Now most items should be transferred.

32.4. Q: Software problems
32.4.1. Q: Printing does not work/crashes.
There are some incompatibilities between .NET and some printer drivers, which unfortunately we can do nothing
about. If printing does not work for you, please copy the diagram to the clipboard and paste in Word, Excel or Visio
and print for there. Excel has very good multi-page printing support.

32.4.2. Q: Startup of the software takes very long.
We have reports from Sophos users that starting the software the first time takes quite long – apparently Sophos
wants to take a detailed look. This problem goes away by itself. Otherwise you can whitelist the application in
Sophos.
Note: BowTieXP normally starts in a couple of seconds.

32.4.3. Q: When opening BowTieXP, I get an error message about fonts.
Please install the Microsoft European Union Expansion Font Update:
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=16083

32.4.4. Q: I can no longer save documents as pdf if they have bowtie images in it
(Office 2007)
This is a known incompatibility with Office 2007 – the images generated by BowTieXP version 5.0 or earlier cannot
be converted to pdf by the Office 2007 pdf add-in.
This used to work okay but stopped working due to a change in Office, by means of Windows Update, and started in
April 2012. Office was changed and now no longer can make pdfs of those documents.
There are several resolutions, listed in order of preference:

Upgrade to Office 2010. Office 2010 does not have this problem.

Use an external PDF printer - free ones exist such as http://www.bullzip.com/.

Upgrade to BowTieXP v5.2 and redo the graphics.
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33

Support
33.1. BowTieXP helpdesk
For users that have bought BowTieXP with support and maintenance a helpdesk is available. This helpdesk assists
people that have technical and user-related questions regarding BowTieXP, how to install it and how to use it to its
fullest extent.
You can reach the BowTieXP helpdesk by e-mail at support@cgerisk.com or by telephone on +31 (0) 88 1001 350.
Please refer to www.cgerisk.com for our BowTieXP Support & Maintenance Brochure. It explains what customers
receive when purchasing support & maintenance.
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